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1. Licensing
With OfficeMaster Suite 6 license keys will be provided for the first time. They have to be imported and activated 
through the configuration interface (OfficeMaster Suite configuration). During that process a unique (virtual) 
hardware ID for the system is calculated. This ID in connection with the license key, will be communicated 
to the activation servers of the Ferrari electronic AG. From those two sets of information license files will be 
generated. This key will then be imported through the configuration program.

User Account

Activating a license key requires a user account to log in to the web portal of the Ferrari electronic. With this 
account you can check the contents of your licenses, activate them for your system, and request test licenses. 
You will only need a valid e-mail address to receive the confirmation e-mail for the activation of the account.

Automatic Activation

If the system that runs the OfficeMaster Suite is connected to the Internet, activation and subsequent submis-
sion of the license file(s) is carried out immediately after importing the license key, in direct communication 
between OfficeMaster Suite and the activation server. 

Manual Activation

If the system is not connected to the Internet, you can save the license information on a data storage medium. 
Afterwards you open the Ferrari electronic AG‘s service center: https://service.ferrari-electronic.de. 

If you don‘t have a user account to log in to the web-portal yet, create one now. Copy the requested information 
from the data medium to the corresponding fields of the web-portal and download the now activated licenses 
for your system. You can input them through the activation dialog of the OfficeMaster Suite server. 

Test Licenses

You can request test licenses at any time using the licensing wizard mentioned above.

◊Note! Either activation process can be carried out without regard to our business hours.

https://www.ferrari-electronic.com/home.html
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1.1. License key Activation
Open License Dialog

Image 1.1: Open license dialog window via Tools > License Management

Image 1.2: Overview of imported licenses

To add a new license key, select Activate Key.

Activate License key

To import a new license key, click this button. Different dialog windows will follow for successful and unsuc-
cessful connection to the activation servers of Ferrari electronic.

https://www.ferrari-electronic.com/home.html
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1.1.1. Offline Activation
There is no direct connection to the activation servers. The opening dialog shows you the hardware ID (you 
can always view this in Help > About) of this OfficeMaster Suite. Please jot down this information and open the 
service center (https://service.ferrari-electronic.de) from a computer with Internet access.

Service Center Login

Image 1.3: Registration and login at the service center

If you have no user account, please register and wait for the automated e-mail to activate the account.

Use Hardware ID to set up a System

After login, you can activate new license keys. You will need your license key and the previously noted hardware ID.

First, you will need the license key of the basic version of your OfficeMaster solution. Acquired extensions (e.g.  
lines) can be activated later on.

Image 1.4: Activate license key of basic license

https://www.ferrari-electronic.com/home.html
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Activate License Key

Because of the flexible licensing concept of OfficeMaster Suite you have to enter additional data for some 
license keys to receive the correct, activated, license. Currently, additional information is necessary for the 
following products.

The information you enter here has direct impact on the actual license! 

Image 1.5: Activating license key

 ► Basic Licenses

 ► OfficeMaster Suite (all types)

You will be prompted to enter a hardware ID, you can find this hardware ID at the OfficeMaster Suite 
configuration program in Help > About

Image 1.6: Hardware ID

You will then be asked which connector (Exchange, Notes, ...) and which service (Fax or Voice) you are 
using. This decision is final for the particular license.

https://www.ferrari-electronic.com/home.html
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 ► Extension Licenses

 ► Connector

You will be prompted to enter the connector you are using.

 ► Second Service

You will be prompted to specify which additional service you want to activate.

After completing this short wizard the necessary licenses will be available for download at the overview page 
of the service center. Save the license on a data device that you can access with the OfficeMaster Suite server 
and log out of the service center.

◊Note! In case you have accidentally entered the wrong connector or service, you can correct 
that free of charge within a grace period.

Import License Files

Open the license management in the configuration program of the OfficeMaster Suite again (Extras > License 
Management) and click Add File.

Image 1.7: Add activated license files

Afterwards, you see the new license file(s) in the overview. The system can now use this license.

1.1.2. Online Activation (follows)

https://www.ferrari-electronic.com/home.html
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1.2. Verify License Keys
If you want to verify your license keys before launching the solution, you can do so at https://service.ferra-
ri-electronic.de/PubService/VerifyProductKey. Enter the license key to review its contents and its validity. You 
will need an active user account, which you can create through the web portal or the configuration program.

1.3. Test Licenses
Test licenses for OfficeMaster Suite allow for the operation of OfficeMaster Suite with its full functional range.

With the test license imported you can use all connectors and interfaces of OfficeMaster Suite for a limited 
time. Excluded are 3rd party products like OfficeMaster Sign and OfficeMaster OCR.

Test licenses are perfect to test new functions, configurations, or the complete solution. 

To test OfficeMaster Suite, open Help > Test License ... in the configuration program after basic installation.

You will be lead to the service center of Ferrari electronic and download a key for temporary use. (https://service.
ferrari-electronic.de/PubService/Evaluate) 

1.4. Register and Request Support
If you want to enter into a support contract for your OfficeMaster installation, or benefit from our free first-in-
stallation support, you have to register the products you use.

Please fill in the corresponding registration request through the configuration program. 

Choose Help > Register OfficeMaster...

After that, your data will be verified by Ferrari electronic and, if available, added to your existing user account.

https://www.ferrari-electronic.com/home.html
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2. Basic Configuration
The Messaging Server Configuration is used to start up the OfficeMaster Messaging Server. It is a program that 
can be installed and used on the server itself as well as on administrative work spaces.

To open up the Messaging Server Configuration, follow this path:

Start > Programs > OfficeMaster > Messaging Server Configuration

The Messaging Server Configuration can be managed by using the program menu or the quick start tab. All 
entries that have been added to the quick start tab are found on the program menu as well.

In order to ensure a swift start-up, the Messaging Server Configuration incorporates an ‘Expert Mode’. This 
mode is turned off by default and only allows access to basic configurations and settings. Turn the Expert Mode 
on to gain access to more complex configurations/ settings (Tools > Expert Mode).

We recommend to set a configuration password after the initial start-up as every user, regardless on prefigured 
windows user permissions, may edit all settings of the Messaging Server Configuration. This password request 
can be set up at Tools > System Settings.

Table 2.1 provides an overview on the necessary (X) and optional configuration steps. Configuration steps for 
Exchange, Lotus Notes and SAP are covered in separate chapters. 

2.1. Network Settings

2.1.1. Windows Firewall

The Messaging Server is a multi-server installation that maintains communication over TCP/IP. However, 
Windows Firewall, if left at default settings, blocks data communication of network program via TCP/IP. 

Individual OfficeMaster components and programs need to be added to an exception list in order to run the 
Windows Firewall and OfficeMaster Messaging Server on a single system. Add them by following this path: Start 
> Control Panel > Network settings > Windows Firewall settings.

Executable files of components can be selected and added as exception to the list. An overview of OfficeMaster 
programs that open TCP/IP ports, and thus require to be enclosed in the Windows Firewall list of exceptions, can 
be found in Table 2.1. On a default setup, find these files in the directory %Program-Files%\FFUMS\FMSRV\bin.

Table 2.1: List of components that open TCP/IP ports and thus need to be added the Windows Firewall exception list

Desired Functionality

Program
Regular 

Operation
(TCP/UDP

Restricted Remote  
Configuration(1)

(TCP)

Full Remote 
Configuration

(TCP)

Client  Access
(TCP)

fmsx2kgate X/- X

fmsxbcsgate X/- X

fnotesvoice X/-

fnotesconn X/- X

fmailgw X

fsmtprx(2) X/-
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Desired Functionality

Program
Regular 

Operation
(TCP/UDP

Restricted Remote  
Configuration(1)

(TCP)

Full Remote 
Configuration

(TCP)

Client  Access
(TCP)

fsmtptx

funivoice X/-

ffilegw X/-

fclientgw X/- X

fstore X/- X

fvoice X/X X

flpd X/-

fomcums X/-

fjcisdn X/-

fucprx X/-

fprovidersms X/-

fsmpp X/-

fcfg X X X

fctrl X X X

fsnfs X X

fuid

fsip X/X

fipmedia X/X

(1) Restricted remote configuration: Log files and letter paper cannot be displayed.

(2) SMTPRX: Only if the Messaging Server receives E-mails, e.g. reception of mails within SAP or operation of the mail gateway. OfficeMaster Messaging Server 

needs to be restarted after the program has been successfully added the Windows Firewall exception list.

2.1.2. Distributed/Deposited Installation

The OfficeMaster Messaging Server software allows components to be distributed within an IP sub network. 
The distributed components are either software (file interface or digital signature components) or hardware 
(OfficeMaster Gate).

You may set up a main server, sub server or use the configuration tools for setup.

Routing

A distributed Messaging Server system is distinguished between a main server and one (or more) sub servers. 
Basic system components run on a main server while “deposited” components run on a sub server. Network 
connections are established in the direction main server -> sub server and vice versa. Additionally, connections 
are established between Messaging Server and Messaging Server Configuration as well as between Messaging 
Server and OfficeMaster Gate. 
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If Messaging Server components are contained in different IP sub networks, the bidirectional connection 
establishment requires the IP routing to be correctly configured by all involved sub networks  … If the Office-
Master Gate is to be taken as an example, this would mean that a ping requires to be sent and received from 
the Messaging Server’s main server to OfficeMaster Gate as well as from OfficeMaster Gate to the main server.

◊Note! To test the connection establishment of OfficeMaster Gate, use telnet as root. 

Gateways, Tunnel and VPN

Gateways are commonly used to transfer messages between networks that use different communication 
protocols. The relevant components, that communicate over a gateway, won’t notice the existence of it. 
However, as for network connections that are led through a gate are managed in internal tables, it may not be 
clear whether a connection is still running or has been terminated not according to protocol, once network 
packages cease to transfer. Hence all connections that haven’t shown any signs of activity are cleared from 
the internal management of the gateways.

◊Note! A gateway may treat a connection as interrupted if the Messaging Server’s components 
are connected to each other via the gateway but communication has been absent for 
a prolonged period of time. Also, if the Messaging Server components fail to properly 
break up a connection the gateway may treat these connections as still open.

These problems occur due to the manner of operation of each gateway. There is no certain solution available. 
A gateway configuration may however ease the side effects.

Firewalls

Firewalls are required to manage information about open connections just as gateways do, hence all infor-
mation that was given about gateways further up top are relevant for firewalls as well A general problem with 
firewalls is that the communication between the Messaging Server and its components may not be correctly 
configured and thus cause them to be blocked. In order to prepare the firewall for a distributive operation of 
the Messaging Server, insight information about the used IP-Port numbers is inevitable.

The numbers 0 – 65535 are reserved for port numeration. If every programme would self-assign their ports, 
conflicts would quickly arise between two ports of the same number as one number can be assigned to one 
port only (same time). So called Well Known Ports are reserved for services such as HTTP and SMTP. These 
ports are specifically designed to be accessed by unknown users and span from 0 to 1023. Registered Ports 
span from 1024 to 49151. 

If neither a Well Known Port nor a Registered Port can be assigned to a programme, the port that has been 
dynamically assigned by the operation system is used. As these ports don’t possess a fixed number and thus 
any vacant ports can be assigned, conflicts can effectively be averted. The number area used for these ports 
is dependent on the operational system and spans from 1024 to 65535. 
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◊Note! Ferrari electronic has been assigned to the port number 3216 by IANA (Internet As-
signed Numbers Authority). To change the port, open the system settings within the 
OfficeMaster Suite at Tools > System Settings (see image below)

Image 2.1: Change the Controller Port in the system settings 

The Messaging Server’s controller component uses the port 3216. Any other components use dynamically 
assigned ports, except for the OfficeMaster Gate. This is due to the fixed and unchanging amount of programs 
that run on the gate. The table 2.2 lists ports that need to be enabled in order to guarantee communication 
between the Messaging Server components.

The range of ports necessary for enablement may seem long, but they don’t include any Well Known Ports 
which are particularly targeted by malicious attackers. However, we recommend to configure the firewall to 
only allow port communication between computers where Messaging Server components are running on.

Table 2.2: Messaging Server ports

Component A Component B Ports from A to B Ports from B to A

Software component of 
the Messaging Servers

Software component of the 
Messaging Servers

1024-65535 1024-65535

Software component of 
the Messaging Servers

OfficeMaster Gate 3216-3220 1024-65535

Broadcasts

Broadcast messages are sent by the Messaging Server Configuration as well as from the gates solely for the 
purpose of autonomous search. The search is not executable if the broadcast messages are filtered out by 
either a router, a gateway or a firewall. In this case we recommend to manually install the OfficeMaster Gate.
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2.1.3. Enable Port Restriction for Used Ports

It is recommended to restrict ports that are used by the Messaging Server on distributed installations. In order 
to achieve it, the character string FMS_PORT_RANGE in the OfficeMaster registry (which can be found under 
HKLM/Software/Ferrari/fmsrv/BaseCfg) is filled with the respective value. Enter the value using numerical 
keys separated by dashes.

Example 2.1. 10600-10700

»End  of  examp »

◊Note! The registry path differs if the installation has been carried out on a 64-Bit operation 
system. Find the actual path in the character string “CAUTION!” (German: “ACHTUNG!”) 
at HKLM/Software/Ferrari. 

The ports listed in Table 2.3 are required for communication to the Messaging Server.

Port Restriction Towards OfficeMaster Gate (not Changeable With the Registry Entry!)

Table 2.3: Ports for Messaging Server

Port Service

22 SSH

23 Telnet firmware version 1 and 2

3215 snfs

3217 Job control for 1. D-channel

… One additional port (from 3217) per configured D-channel

9999 Update of firmware version 1 and 2

Port Restriction Towards Messaging Server (Based on the Indicated Port Range)

As the ports are dynamically obtained, any amount of ports per component is used. These ports are selected 
within the given port range.
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2.2. How to use the Configuration Programme

2.2.1. User Interface

Image 2.2: The segments within the Messaging Server configuration

The user interface of the Messaging Server configuration programme is separated into three segments: 

• Menu bar (top): Selection of options or components

• Tool bar (left): Selection of options or components

• Main panel: Choose/edit settings

 ► Menu Bar

The menu bar serves as main control panel for the Messaging Server configuration. Each sub item is static 
and thus fully independent on the OfficeMaster licence used. By restricting the user rights and deactivating 
the Expert Mode (Tools > Expert Mode), some boxes may be disabled or hidden.

 ► Tool Bar

Quick links for accessing the MessagingServer, user administration, common settings, and creating new 
components are embedded in the tool bar. A separate field allows for running various actions, dependent 
on the selected content in the menu bar.
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 ► Component Status:

• Start, terminate and restart the selected component

• Hide component of particular type 

• Sort component in the overview

• Adapt the refresh rate 

 ► Job Status:

• Abort or delete the selected job

 ► Quick Launch Area

The layout in the upper segment of the quick start area varies, dependent on the licence used. Thus, if a 
Notes installation of OfficeMaster was selected upon first installation, a Notes folder and not an Exchange 
folder is displayed.

All components listed here may be accessed in the menu bar by selecting Edit.

 ► Component Status

If the component status is selected, the main window will display an overview of information about all 
components connected to the Messaging Server.

 stopped

 running

 paused

 processing a job

 Error

 can‘t run/unknown status

 not configured

 ► Job Status

Select this tab to get an overview on each component and the respective job that currently runs on it. Ad-
ditional information, such as a fixed time for processing a fax message can be accessed here.

 ► License Status 

An overview on used and actually activated licenses on the system is displayed in this tab.

 ► Log Data 

Select this tab to view all log data created for every component on the system. The key F5 will trigger the 
selected file or the entire folder to reload.
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 ► Job Routing

Here, the job processing queue of inbound and outbound messages of the type fax, SMS, mail and voice 
is visualised.

◊Note! Selecting Rebuild will adopt the routing of the currently saved configuration. If a new 
job queue for these messages is required, either this button need to be clicked or the 
OfficeMaster service need to be restarted whenever the routing shall be refreshed.

2.2.2. Create/ Delete Component

Creating new components can be variously achieved: 

1. Menu bar: New

2. Tool bar: Edit > Component Table... > Create a component

Image 2.3: Messaging Server component table

3. Quick launch area: COMPONENT TYPE

4. Toolbar: Edit > COMPONENT TYPE 
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A wizard pops up if step 1 or 2 for creating a component has been selected. Use this wizard to install the de-
sired component.

Image 2.4: Installing a component

If step 3. or 4. has been chosen, you will be prompted to either select a default installation or a common instal-
lation. Choose the default installation if the component is supposed to run on a distributed system.

The following dialogue concludes the installation.

Image 2.5: Applying the basic settings

2.2.3. Configure a Component

The Messaging Server components are divided into two categories: Configuration and Properties.

Properties

Properties are non- functional settings that are critical for the proper execution of the respective component. 
Edit these settings by either:

• Selecting the component and right- click on Properties

• Selecting the component from the component table and click on Edit 
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Image 2.6: General component settings

Once the porperties window has opened up, the tab Common becomes visible.

 ► Status

Here, the component itself can be controlled simply by clicking Start, Stop, Pause and Continue. 

 ► Parameters

Additional initiation parameters can be supplemented in the Parameter box.

Please note that it may become necessary to start components with an account other than the system 
account. You may add the respective account in the tab Log On.

If you need to evaluate log entries, you can adjust the logging pattern in the Advanced tab.

 ► Level

In this box, you can adjust the logging level according to your needs.

 ► Stop Delay

Select how quick the Messaging Server component reacts once the starting or stopping boxes have been 
clicked.

Image 2.7: Debug settings for the selected component

- 27 -

Basic Configuration

https://www.ferrari-electronic.com/home.html
https://www.ferrari-electronic.com/home.html


 ► Start Attempts

Define the amount of restart attempts once the initial start-up failed.

 ► Error Time

Set the time interval between individual restart attempts.

Configuration

Access the configuration settings of each component by

• Selecting the component type in the menu bar or

• Selecting the component in the component table, right clicking it and choosing Show configuration

◊Note! If multiple components of the same type have been selected, the configuration settings 
of the component on top is displayed.

Image 2.8: Selecting the component for configuration

All configuration steps that are necessary to conduct are clarified in the following chapters.
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2.3. DirectSIP
The component SIP is available for linking the Messaging Server to SIP Trunks and IP PBX’s. To configure SIP, 
open the OfficeMaster Suite Configuration and select DirectSIP from the quick start tab.

2.3.1. Create a new Component

You won’t find a pre-configured SIP component on a new system. Select Create component to set it up. An 
installation wizard will follow shortly afterwards.

After confirming or editing the default settings such as Name, Displayname and Server, the installation wizard 
for SIP will pop up automatically.

Image 2.9: Choose connection type

Firstly, choose the connection type. Predefined remote stations will help to maintain a good overview in the 
following dialogue.

Image 2.10: List of SIP Trunks with preconfigured templates
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The templates are constantly enhanced and an update to the latest version of OfficeMaster Suite is recom-
mended to ensure they always remain up to date. If the requested remote station is not listed, please select 
common profile and continue following the wizard.

Image 2.11: Connection information

Enter connection information, such as IP address and port of remote station, here.

Image 2.12: Line configuration

You may configure available lines in this checkbox, however, the amount of listed lines depend on the settings 
you selected for desired prioritization and available licenses.
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To complete installation, enter the basic settings for fax communications in the respective boxes.

Image 2.13: Fax settings

After successfully running through the wizard, you’ll see an overview of possible settings for the chosen con-
nection. You may still edit or enhance the configuration settings if needed.

Image 2.14: Overview of general settings

◊Note! If you had to adjust your existing profile or used a connection type that is not yet listed,we 
would highly appreciate if you provide us with your feedback. We will try to incorporate 
it in a future release. 
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2.3.2. General

 ► Trunk Settings

If the desired SIP Trunk was selectable during installation, all necessary parameters are already prefilled. 

Image 2.15: Overview of settings with information filled in

 ► Domain (IP-Address/Hostname)

Provide the IP address/ Host name of the PBX, Session Border Controller or the IP-Provider. 

 ► Port

Define a port to allow communication to the remote station.

 ► Transport Protocol

Choose between UDP, TCP and TLS.

 ► Register

If a registration on the remote station is necessary, choose On or, if not, choose Off.

 ► Proxy

If a proxy is used, please enter it here.

 ► Username

Enter a username for identification purposes of the remote station.
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 ► Authentication Username

Enter the username that is required for authentication. If no username is entered, the SIP- username 
will be used. 

 ► Password

A password request can be triggered here.

 ► Registration Expires

Choose how often the remote station expects a register input

 ► Certificate (FriendlyName)

If the transport protocol TLS has been selected, please provide the respective name for the certificate. 
OfficeMaster Suite searches for the certificate within the certification administration using the value 
entered in Display name

 ► Options

 ► Local Port

Enter the local port for the SIP communication of the SIP component. 

◊Caution! If multiple SIP components are going to be used, a port has to be defined for each com-
ponent individually. 

 ► Codecs

To allow the transfer of data streams, select a codec that is supported by the counterpart station.

 ► Send SIP Options

Activate this checkbox only if the SIP counterpart station supports SIP OPTIONS. 

The configured SIP component will not be able to accept outbound jobs if the counterpart station fails 
to process SIP OPTIONS (timeout).

 ► SIP Options Interval

Specify the interval between the individual SIP OPTIONS.
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 ► Number of Lines to use

Enter the amount of lines that are going to be used into the checkbox Total, separated by Send and Receive. 
The desired amount of lines need to be supported by the respective line extension license. Particularly in 
solutions that consist of multiple transmission components, such as SIP/OMCUMS, each configuration 
settings should be adjusted to ensure support by the line extension licenses.

If spare lines are yet available, they will be requested and distributed dynamically until the maximum amount 
entered here, is reached.

2.3.3. SIP-Header (Expert Mode Only)

According to SIP RFC, various settings are available on how to transfer forwarded calls. Furthermore, it is not 
always clear which job parameter is ought to be applied to the SIP- Header and when. You may define these 
parameters in the Expert Mode. You won’t have to adjust these settings if an appropriate profile has been 
selected upon creating the component as the installation wizard has done that already.

Image 2.16: Extended settings for the SIP- Header

 ► Outbound Header

If outbound calls are performed, the SIP- Header is occupied by a fax/voice job within OfficeMaster Suite. 
Depending on the remote station, up to six boxes have to be filled in. By clicking the edit icon-       ,these 
values can be set up in the dialogue.

The setup applies to the following SIP- Header attributes

FROM - User

FROM - Display Name

P-Asserted Identity (PAI)

P-Preferred-Identity (PPI)

TO-User

TO- Display Name
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Depending on the entry in Type of value, the options available may differ. 

 ► Type of Value: Fixed Value 

Image 2.17: Fixed value selection

 ► Attribute

You can select a fixed value here, such as a central calling number. 

 ► Type of value: Attribute

Attributes for this box can be configured here. You may choose between OfficeMaster’s job paramters or 
a fixed value out of the general settings to apply them to. 

Image 2.18: List of available attributes
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 ► Attribute 

Choose the attribute that the value in the SIP header should be applied to. Available attributes are listed 
above.

 ► Prefix, Suffix

If you wish to assign a fixed prefix or suffix to the attribute, you may do it here.

 ► Default

In case the job is either not available or empty and thus reading the job is impossible, a default setting 
can be set here.

◊Note! If you want to configure an OAD that is based on the sender, use a default value such as the 
SIP user name and an attribute such as Calling Number.

 ► Type of Value: Regular Expression

 ► Regex Match

Define a rule for matching numbers. The following rule matches three consecutive numbers that follow 
…455

(\+493328455)(...)

By using brackets, the number can be subdivided into individual sections (two sections in the upper 
example)

 ► Regex Replace

Define a target value here. Use \1, \2 and so on to address the respective sections.

If the example that is given further up top is to be used, the expression \191 initiates the value 
+49332845591 to reach all calls that have been defined by the Regex Matching Rule.

 ► Default

+49332845590

If it is not possible to deposit a value by using the source and regular expression, the default value is used.

◊Note! As of now, this example is currently not very useful. However, if you want to set the display 
name based on direct dial numbers, it may be achieved here. At the time this document 
was created, this functionality couldn’t be properly tested.
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 ► Inbound Source Data

You can enter source files for Called number, Calling number and Redirect information that are used by in-
coming calls here. The settings are equal to those for outgoing calls.

The Process of Calling Number Manipulation

Calling numbers can be manipulated using rules and regular expressions that replace certain characters with 
others. The sequence is as follows:

For inbound calls

1. The calling number of an inbound call is first routed through the SIP Header and checked against rules 
configured in the Inbound Source Data section (SIP Header > Inbound Source Data). 

Image 2.19: Calling Number Manipulation inbound: Step 1 

2. The Messaging Server then checks whether replacement rules have been populated to the replacement 
table (can be found at Advanced > Adjust Phone Numbers > Edit Rules...).

Image 2.20: Calling Number Manipulation Inbound: Step 2

3. Rules configured in the tab Inbound Routing further manipulate the calling number.

Image 2.21: Calling Number Manipulation Inbound: Step 3
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4. Shortly before the call can be forwarded to the recipient, the Messaging Servers checks the number 
against a Black-/Whitelist (can be configured at Tools > Black-/Whitelist).

Image 2.22: Calling Number Manipulation Inbound: Step 4

For outbound calls

1. The calling number of an outbound call first passes through the rules configured in the Outbound Routing 
tab. Here,the Messaging Server also checks whether the component has been configured for trans-
mission.

Image 2.23: Calling Number Manipulation Outbound: Step 1

2. Next, the replacement table is checked for existent outbound replacement rules (equivalent to the 
inbound replacement rules, see previous page, Step 2).

3. The calling number is then further manipulated by adjusting the number format  
(Advanced > Internationalization).

Image 2.24: Calling Number Manipulation Outbound: Step 2
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4. The process of calling number manipulation is concluded once the rules configured in SIP Header > 
Inbound Source Data have been applied (see Image 2.19 on page 37). 

◊Note! The phone number passes through the entire process, regardless of whether rules have 
been configured or not.

2.3.4. Fax Settings

Parameters for fax communication can be entered in the Fax tab. Some settings have already been requested 
by the installation wizard and are therefore prefilled. You may edit these settings if needed.

Image 2.25: Global fax settings

 ► CSID, Headline

A default textbox for the headline (e.g. company name) that is used for outgoing fax messages can be con-
figured in the Headline box. This text box also accommodates the CSID (fax identifier). The CSID is based 
on the ITU rule T.30 for international calling numbers, thus the area code, national access code and the 
actual number are included. You may only use numeric numbers, addition key (+) and spaces in the CSID 
section. The country code should not contain leading zeros.

Example 2.2. 

Given the Ferrari electronic fax address 03328/455-316, the input would be +49 3328 455 316. 

»End  of  examp »

The CSID is transmitted to the fax protocol with every fax session (inbound and outbound). It is shown on the 
display and in the transfer protocol of the remote station.

Parameters that were configured for the CSID and Headline of outgoing faxes only apply if no job specific 
settings (e.g. for Exchange-, Notes/SAP users) exist.
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 ► Headline Mode

• Off

No header information is transmitted

• Merge

Headline information is integrated into the document. This may suppress the documents information. 

• Extend

Headline information is preceding the document. To ensure the fax document won’t exceed the 
maximum paper format, it is scaled down if necessary.

• Auto (default setting)

OfficeMaster attempts to detect whether the first lines of the document are empty and thus tries to 
merge or if an extension has to be applied.

 ► Resolution

• Standard - 100 dpi

• Fine - 200 dpi

 ► Compression

• MH; Modified Huffman, based on RLE

• MR; Modified Read, Fax Group 3

• MMR; Modified Modified Read, Fax Group 4

 ► Disable Error Correction Mode (ECM)

You can deactivate automatic error correction here. We recommend not to use this setting unless the 
remote station does not support ECM and the training session (TCF) shall be shortened.

 ► Transfer Rate

We recommend leaving the settings to its default value. In cases where the line quality is poor, you may 
however want to reduce the speed.

 ► T.38 ReInvite

Depending on the remote station, the individual T.38 modes are configured by the installation wizard. 
If necessary, the behavior may be adjusted to match that of the PBX.
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2.3.5. SMS Settings

In this tab, specify the calling number of the landline SMS Center that will be addressed. In case your provider 
supports Flash SMS, activate this feature by adding the syntax into the Flash-SMS marker box.

Image 2.26: SMS settings for adjusting the SIP component

2.3.6. Inbound Routing

Incoming calls are either blocked or received as fax or voicemail. Depending on the transferred number, you can 
determine how the OfficeMaster Suite handles a call. These settings are editable in the register Inbound Routing. 
The following telephony features are available for this setting: Calling Number, Redirecting Number and 
Called Number.

◊Note! The SIP header boxes that are used to set these telephony features are determined de-
pending on the provider and type of the SIP trunk. If it becomes necessary to perform 
changes to the assignment, change the view to Expert Mode or open the tab SIP Header.

Image 2.27: Create/edit address filters for inbound routing

 ► Address Filter

The Address Filter is created with predefined content.  

The number of the diverting extension (Redirecting Number) can be used to correctly identify voicemails. 
All diverted calls are processed as voicemails if this rule has been enabled.

All calls, that could not be identified as voicemails are processed as fax.

◊Caution! To guarantee a parallel use of fax and voicemail, OfficeMaster Suite requires an additional 
license. Please ensure the desired Second Service (fax or voice) has been licensed. Calls 
are rejected if routing to a not licensed service is attempted.

- 41 -

Basic Configuration

https://www.ferrari-electronic.com/home.html
https://www.ferrari-electronic.com/home.html


This allocation may vary between each SIP component or SIP remote station used. Thus, each component 
can be configured individually.

◊Note! Right click on an element to open up the context menu. Here you can reset the service 
choice back to the default settings.

 ► Add

The service selection is done by using a list of filters that are applied one by one to the calling information. 
The simplest element that a filter contains is a complete calling number. It is not necessary, however, to 
enter a complete calling number as the filter designation can as well be applied by using regular expressions.

The set filters are applied one after another to each calling number that has been received, starting with 
the first filter. Incoming calls are treated according to the first filter (First match). A filter hierarchy can be 
set using the up or down arrow keys.

Detecting Voicemails

Image 2.28: Configuration of inbound calls for the voice service

 ► Information Element; Filter; Service; Voice Server; Voice Connector

The Redirecting Number, Calling number or Called Number can be used as Information element to detect 
voicemails. If the selected Information element matches the configured filter, the filter will be applied.

For example, if all calls with a three-digit Redirecting Number (=Internal calling number of the redirected 
substation) are to be received as voicemail, three dots (…) shall be set as filter.
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If, however the Redirecting Number is not supported by an end to end port, a separate direct-dial number 
range needs to be provided for the voice service.

Image 2.29: Selecting the project: Voicebox over Pilot-ID

Click Advanced and select the project Voicebox über Pilot-ID (German for Voicebox over Pilot-ID). This will 
enable the transferred Redirecting Number to be used as target (Called Number). By selecting this project, 
all calling numbers are adjusted respectively and the voicemail project that was deposited on the user is 
opened up.

 ► Language, PIN, Additional Parameters

In some (rather unlikely) events it may become necessary to fill in these boxes. We recommend leaving 
them in the default settings.

◊Caution! An automatism previously caused the hardware controller (OMCUMS) to use the Redirect-
ing Number exclusively for all jobs once this attribute had been chosen for call processing. 
In addition, this number would have replaced the Called Party Number for all succeeding 
jobs. Due to its complex nature, this automatism has been removed.

Detecting Faxes

You should create a filter for the Called Number at the end of the address filter (except for voicemail). This will 
ensure that all remaining calls are received as fax.

◊Note! No additional measures need to be undertaken to receive fax messages. An incoming fax 
can be forwarded to all connectors that registered for this process. A common scenario 
is a parallel use of a file interface with an exchange connector. The same fax is delivered 
to both recipients.
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2.3.7. Outbound Routing

During installation with multiple telephony interfaces (various ISDN channels, multiple SIP-Trunks, etc.) the 
transmission jobs are distributed to any available interfaces, depending on the system’s occupancy.

Common installations that use a multitude of interfaces require the routing not to randomly distribute calls 
via the interfaces. By using regular expressions, appropriate routing rules can be created that are based on 
the target and the sender.

If SIP and OMCUMS components are created and configured to not be bound to any limitations, outbound calls 
are randomly distributed to vacant channels. An effective load distribution paired with an automatic selection of 
available transmission forms is achieved by using multiple SIP remote stations (e.g. redundantly laid out PBXs).

The service types fax and voice are differentiated during routing. Both need to have a clear distinction be-
tween sender and receiver. Ticking the checkbox next to each service (Fax, voice, SMS and MWI) enables the 
external transmission.

The basics:

• -.* prevents a match of all calling numbers

• .* matches all calling numbers

Here, a Least Cost Routing rule or Location Based Routing rule can be defined for outbound routing services 
such as fax, voice, SMS or MWI.

 

Image 2.30: Default settings for outbound routing
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◊Note! Open the Fallback tab to configure a fallback behavior for the SIP component.

Least Cost Routing

Transfer jobs are transferred to a receiver via ISDN. This ensures a cost-effective transportation method.

Location Based Routing

Location Based Routing is handled using the sender information which, in the plainest environment, consists 
of a fax or voice number only. 

Because of the liberalization of the German telephone market, the use of Least Cost Routing is only reasonable 
for international transmissions. Location based routing is commonly applied to a variety of IP connections 
within one country, thus fees only apply where it was made use of. Location based routing is continuously used 
internationally.

◊Note! Examples for these settings can be found in the section „ISDN- Controller“ on page 48 
further down.

2.3.8. Advanced (Expert Mode Only)

The selectable options on the tab Advanced generally support two scenarios:

• Automatic number correction for autonomous correction and diversion of a receiver’s calling number

• Setting log-levels that are requested by our support team to provide adequate support.

Image 2.31: Advanced settings
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 ► Network

Enter the network interface that is intended for use. If all interfaces shall be used, leave the value to its 
defaults (0.0.0.0).

 ► Logging 

The SIP component conveys SIP logging information to a syslog server via UDP. The OfficeMaster syslog 
server is installed as service during the OfficeMaster Suite installation. If currently a different syslog server 
than those listed is used, enter it here.

◊Note! If the syslog server is set up by default during the OfficeMaster Suite installation (which 
generally is done if no syslog server is present upon installation), the following file path 
is used: c:\ProgramData\ffums\syslogs. If the file path needs to be changed, do so by 
opening up the OfficeMaster syslog configuration program and edit the path according 
to your demand.

 ► T.38

Editing settings for the fax transmission protocol T.38 should only be carried out by T.38 professionals or 
in consultation with our Ferrari electronic support team.

 ► Debug Level

The logging sensitivity can be set to different levels depending on the internal processes. The selection of 
the checkbox Network Trace allows for the evaluation of Pcaps with Wireshark. Please ensure to have Pcap 
installed. Find a setup file for WinPcap at C://ProgramData/FFUMS/FMSRV/... .

 ► Internationalization

 ► Country

Automatic correction adds or deletes national and international calling codes depending on the SIP 
component’s location and/or the calling numbers used for transferral. Faulty calling numbers are cor-
rected and calling codes are regulated.

 ► Time Zone

The time zone set is used as time stamp on faxes. Should you intend to use a time zone other than that 
on your operational system, change it here.

For users on different time zones that have access to one centralized solution, the correct time zone 
can be set here as well (based on the SIP trunk).

◊Note! The Exchange connector provides a functionality for setting up the time for users and 
connectors individually if the need arises.

Configuration of the time zone can be carried out easily, as each region (including the respective cities) 
is separately displayed.
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 ► Replacement Rules

Since the OfficeMaster Suite release version 6.2. 2, you may add replacement rules that modify the 
original calling number and essentially replace one character with another or even deletes them.

This may be necessary for:

• Routing calls internally even if the entire number length was provided (03328455><none>)

• A provider selection for calls to selected countries (0081> 010780081)

• Call by Call scenarios (3U> 01078; if supported by the gateway)

• Closing gaps and possible failures of the automatic number correction

Select Adjust Phone Numbers  , then Edit Rules... to open up the configuration panel. Then select 
Add... in the respective tab to add a new rule.

Image 2.32: Adding a replacement rule for SIP
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2.4. ISDN- Controller
The ISDN interface is accessed and controlled by the OMCUMS component. This component is configured 
in the OfficeMaster Suite Configuration. Open the program and select Edit > OfficeMaster Gate... . All ISDN 
interfaces, virtual interfaces and the OfficeMaster Gate (if already added) that had been found by OMCUMS 
upon start up, are displayed in the box Name.

Image 2.33: Hardware settings

If the Messaging Server installation is distributed to several server machines that also run an OMCUMS com-
ponent, the available ISDN hardware on the computer is listed as well. On top right, select the desired controller 
that the listed gates and interfaces had been assigned to. 

◊Note! An additional JCISDN component is required if the listed interfaces are either CAPI or 
XCAPI cards.

These components can be added to the Messaging Server if the OfficeMaster Gate is directly connected to the 
network. Available ISDN hardware are displayed in the dialogue box on the left and are labeled with the prefix 
capi if they have been identified as CAPI cards. OfficeMaster Gates are labeled with the prefix omg, followed by 
their individual serial number. All labels are editable and may be adjusted as desired. We recommend editing 
the label for distributed installations. Do so by selecting the hardware and pressing F2 . A configuration that 
is visible in the right box always refers to the selected hardware on the left.

The tabs displayed in the screenshot are only available if Use the ISDN interface has been checked. After 
successfully configuring the interface, confirm by clicking OK. This will save the settings and apply them to 
the running OMCUMS component.

◊Note! We recommend stopping the OMCUMS component and restart it after the configuration 
has been set up.
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2.4.1. ISDN Settings

Settings and value input for fax, voice and landline text messages are editable in the tab ISDN.

 ► Originator Address Digit (OAD)

Some PBX’s require an OAD from ISDN hardware for identification. The OAD is commonly requested for 
authorization checks and fee evaluation if the latter is available on the PBX. However, no inputs are neces-
sary if the PBX do not require an OAD.

 ► Originator Address

By default, the OAD corresponds to the number of the respective ISDN connection. This so called orig-
inator address can be configured for all tasks in the Messaging Server program.

 ► Job Specific; Base Number

Once the configured direct calling number of the Notes, -Exchange or SAP user is contained in the 
transfer job details, the OAD can also be determined job specifically. Both, the OAD and the Base Number 
are transferred to the PBX upon each call setup. Hence, every transfer job can be accounted for, inde-
pendent on fax or text messages. If, however the transfer job lacks of a job specific OAD, the originator 
address is used instead.

◊Note! In order to configure the job specific OAD the Expert Mode has to be enabled.

Image 2.34: Expert mode activation

 ► Number of Lines to use

◊Note! If the OfficeMaster Gate runs on hybrid mode, it is pivotal to ensure the amount chosen 
for outgoing channels do not exceed the maximum of available channels supported by 
the OfficeMaster Gate!

 ► Total

The desired amount of ISDN channels used by the Messaging Server can be entered in the box Total. All 
available channels (two for each basic rate interface (S0) and 30 for each primary rate interface (S2M)) 
are used by default, given that the respective line extension licenses have been obtained. If, however the 
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ISDN subscriber line is required to be permanently used by ISDN interfaces other than those available 
to the system, a different value has to be entered here. A different value may also be entered if various 
ISDN interfaces are required to share and occupy one line at a time only.

 ► Dispatch; Reception

An efficient channel occupancy rate can be achieved by configuring the values for Dispatch and Reception. 
By doing this, queued reception and dispatch processes may be handled simultaneously.

Example 2.3. 

• 2 Lines; license covered by the basic product license 

• 1 ISDN basic rate interface

• 2 channels in total, 1 channel for dispatch, 2 channels for reception

The interface chosen in this example requires two channel licenses. One channel may be used for dispatch 
but both channels for reception. Hence, one channel is constantly blocked for reception, regardless on the 
amount of outgoing messages.

»End  of  examp »

Example 2.4. 

• 2 Lines; license covered by the basic product license

• 2 ISDN basic rate interfaces

• BRI1: 1 channel in total; 1 for dispatch, 0 channel for reception

• BRI2: 1 channel in total; 0 for dispatch, 1 channel for reception

»End  of  examp »

We recommend to distribute receive and send jobs to multiple basic rate interfaces. The workload will be just 
minimal; hence, two channels for fax communication should suffice.

 ► Dispatch

 ► Dial Prefix

A dial prefix is the value that is used to enable communication to the respective telephone exchange 
(common value: 0). Furthermore, the subscriber number used for fax and text messages may be stored 
as fixed value as well.

 ► Enabled for Number Length From (...) Chars

An automatic detection of internal fax branches on each PBX can be configured by entering a value 
in this box. This value should correspond to the longest number of any internal call-through number. 
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Thus, an unnecessary routing through the telephone exchange is avoided. The implemented automatic 
number correction affects all numbers of outgoing calls, independent on any configurations made in 
the dial prefix box. 

A value input in this box is essential if the ISDN interfaces of your Messaging Server system are distrib-
uted between multiple locations in two or more countries or if the entire receptionist’s number (includ-
ing area code) has been provided for transfer processes. With Expert Mode enabled, click on the tab 
Advanced Settings and select the desired country to activate automatic number correction.

 ► Reception

 ► DID Prefix

The DID prefix (Direct Inward Dialing) precedes the number of any incoming fax, text or voice message 
and essentially becomes a fixed element to the receiving number. Given the configured DID prefix is set 
to 0123 and the receiving number is 456, the Exchange, Notes and SAP users need to have access to 
the fax address 0123456.

 ► Type of Connection

◊Note! If OfficeMaster Gate operates in hybrid mode (as seen on the user interface), the config-
urations made here have no effect on the connection type. Use the OfficeMaster Gate 
configuration program to perform the following configuration.

 ► Point-to-Multipoint; Point-to-Point

The type of connection is essentially differentiated between Point-to-Multipoint and Point-to-Point connec-
tions. Point-to-Multipoint supports the use of multiple ISDN interfaces (such as Telephone 1, Telephone 
2 and Fax) whereas Point-to-Point supports the use of one ISDN interface only, which is commonly a 
subsidiary PBX.

A Point-to-Multipoint connection, however, lacks the support of more than 10 MSN (Multiple Subscriber 
Numbers), whereas a Point-to-Point connection is capable of accessing the entire range of DID num-
bers. Hence, the Point-to-Point connection should be favored if more than 10 users are to be given a DID 
number. OfficeMaster Gate unrestrictedly supports both connection types.

 ► QSIG

OfficeMaster Gate is capable of performing with Euro-ISDN/DSS1 and QSIG as ISDN protocol, both of 
which are constantly used by PBX’s on Point-to-Point connections. Detailed information on supported 
connection types for third-party hardware has to be obtained by their respective documentation file. 
Please refer to this technical documentation for further instructions on how to install this hardware.

The configuration for both, reception and dispatch of the available connection type can be carried out.

 ► MSN Dependent; MSN Independent

A Point-to-Multipoint connection allows for a reception of either all recipient numbers (MSN independent) 
or just pre-selected recipient numbers (MSN dependent) that are essentially available to the port. The 
latter option is useful if multiple hardware connections are known to use the same ISDN port as the 
original ISDN interface. Enter the MSN, separated by comma, semi colon and dashes.
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◊Note! The Point-to-Point connection type needs to be selected for the following boxes to appear.

 ► Base Number

On a Point-to-Point environment, the base number is delivered and displayed by the PBX just before each 
call is put through. This base number can be configured here (often left empty, except on a base port). 
The DID and its expected character length is received after the base number has successfully been 
transferred. It is not recommended to commence the reception of fax messages without predefining 
the character length of the DID number.

 ► Autoreceive After (...) DID Digits; Autoreceive Depending on First DID Digit

The DID character length can be defined as either fixed or dynamical value for DID numbers received. 
The latter configuration setting is dependent on the first incoming digit and may be applied to individual 
number ranges.

2.4.2. Fax Settings

Parameters for fax communication can be entered and edited in the tab Fax. Here, fax dispatch can be ac-
tivated or deactivated for the ISDN port specifically. If the fax reception is to be deactivated, use the tab 
Inbound Service Selection instead.

Image 2.35: Settings for fax dispatch

 ► Headline; CSID

Enter a default headline text (e.g. Name of company) in the box Headline which additionally contains the CSID 
(Called Subscriber Identification). This CSID is created from the calling number of the telephone connection 
using the ITU rule T.30, hence, it contains the country code, area code and the actual telephone number. 
No characters other than numerals, addition key and spaces are recognized and all leading zeros should be 
omitted from the CSID entered here.
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Example 2.5. 

Ferrari electronic's main fax address in Germany is 03328/455-960, hence the generated CSID would be  
+49 3328 455 960. 

»End  of  examp »

The CSID is not only displayed in the fax header but is also stored in the fax protocol during inbound and out-
bound fax transmission and is communicated to the respective remote station.

Please note that configured default parameters for Headline and CSID only apply if no job specific settings for 
the Exchange, Notes or SAP user are existent.

 ► Recipient CSID; Append Called Party Number to Recipient CSID

Enter a value in the Recipient CSID box that is displayed on the remote station during fax reception jobs. Note 
that this value is only displayed for incoming faxes and should essentially deviate from the CSID used for out-
going faxes. A Called Party Number can optionally be appended to the Recipient CSID. If added, the remote 
station that is sending a fax via the DID number 348 is receiving the CSID +49 3328 455 348, regardless on 
whether this number has been assigned to an Exchange, Notes or SAP user.

 ► Do not Send Headline Logo

Check this box if the Ferrari electronic logo is to be detached from the fax header. The logo is attached to each 
fax header by default.

2.4.3. SMS Settings

OfficeMaster supports the transmission of both, inbound and outbound landline SMS. As the name implies, 
these text messages are sent via landline and the configuration is carried out in the tab SMS.

◊Note! Refer to installation step 2.5.1. OfficeMaster GSM Cellular Engine for SMS on page 69 
if an alternative SMS transmission via a GSM-Modem or Internet Service Provider is 
preferred.

Image 2.36: Outbound SMS

 ► SMS Center

On the contrary to fax transmission, the SMS Center of the respective provider is used to deliver land-
line SMS between sender and receiver. Text messages are received and collected by the SMS Center 
which then processes them for distribution. Hence, communication is conducted directly between ISDN 
interface and SMS Center.  Configure the SMS Center by entering its number into the box SMS Center. 
Landline SMS are received by either:

• a call from the SMS Center with a subsequent collection or
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• a decoy call (call followed by an immediate hang- up) with a subsequent return call by the OfficeMaster 
card which ultimately receives the short message

It is essential to perform configurations in the tab Inbound Service Selection, otherwise the reception of 
landline SMS will always be executed using the second variant. 

The calling number that is expected to receive landline SMS needs to be registered as a subscriber that is 
capable of receiving SMS. This registration process is a one-time action and prevents text messages to be 
received as text-to-speech. 

In Germany, T-Com (by Deutsche Telekom AG) is a provider that supports landline SMS transmission using 
the first reception variant. At T-Com, registration is concluded by sending ANMELD to 8888, thus enabling the 
telephone number to receive landline SMS. 

A properly working reception of landline SMS require, however, an adjustment to the ISDN interface. If all 
users are required to receive text messages, all SMS DIDs need to be conveyed as job dependent OAD (Open 
Access Directory) to the PBX. Subsequently, these numbers need to be registered for landline SMS reception 
on the SMS Center. 

In Austria, Telekom Austria offers the reception of landline SMS as HomeSMS. However, the use of HomeSMS 
is not supported for use on:

• Non-clip NT a/b ISDN basic rate interfaces 

• ISDN multiplex interfaces

• Serial interfaces, interfaces supporting DID

• Pre-Installations

• fee accumulation blockages

• Interfaces with configured number suppression

2.4.4. Voice Settings

Hardware-related settings for Voicemail are configured in the tab Voice.

Image 2.37: Voice settings

 ► Enable Outgoing Voice Connections

By ticking the box Enable outgoing voice connections, the ISDN interface is authorized to establish a phone 
connection to allow the rendering of voice messages on internal or external phones.

 ► Exclusive B-Channels

Additionally, the amount of reserved B-Channels/lines for inbound and outbound voice connections can be 
defined here.
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Although voice connections for basic rate interfaces, that support a maximum of two lines, may be equally 
reserved, we recommend to exclude this setting for these interfaces. A separation of fax and voice should be 
endeavored at this scale of transmission traffic.

The option of reserving lines has been implemented for the use on 30-line ISDN primary rate interfaces that 
send and receive fax and voicemail messages. If the transmission of fax messages exceeds to a certain level, 
voice messages are ultimately not received and incoming calls are refused. A lack of channel capacity is 
therefore not only inconvenient for the user itself, but also for the caller who receives a busy tone instead of 
a request to leave a message.

 ► Static; Dynamic

As voicemail connections need to be prioritized, some of the 30 lines may be reserved for inbound voice mes-
sages. This reservation may be carried out either statically or dynamically. Choosing statically will reserve the 
preconfigured amount of lines for voicemail.

Example 2.6. 

Given, at total amount of 30 channels, 20 are statically reserved for voice, then a maximum of 10 channels are 
used for Fax and landline SMS, regardless on whether the 20 voice channels are fully occupied or not. Once 
the 20 voice channels are fully occupied, further voice connections won’t be received (inbound voicemails) 
and the caller is given a busy tone. Here again, no further voice connections will be established once all 20 
channels are busy, regardless of whether just 6 out of 10 fax/SMS connections are being used.

»End  of  examp »

Example 2.7. 

Given, at a total amount of 30 channels, 4 are dynamically reserved for voice, then a maximum of 26 channels 
are occupied for fax and SMS, independent on voice connections used. However, 4 auxiliary channels for voice 
are always kept in spare no matter how many voice connections have already been established. Hence, if 20 
voice connections have been established, a mere six channels may be occupied by fax and landline SMS. A 
maximum of 30 channels may be used for voice but note that fax and landline SMS are not received if this 
capacity has been reached.

»End  of  examp »
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2.4.5. Inbound Service Selection

As inbound calls are received as fax-, voice- or landline text messages, OfficeMaster needs to evaluate the 
proper type of unified messaging service and apply the respective configuration. For each of these services, 
the ISDN parameters Calling Party Number, Redirecting Number and Called Party Number may be applied.

Image 2.38: Service selection

Example 2.8. (preconfigured)

• Landline SMS are determined by checking the calling number (Calling Party Number), stored in the ISDN 
protocol. If it matches the number of a known SMS Center, the connection is treated as landline SMS. If 
there’s no match, it is being forwarded as either fax or voicemail. 

• Voicemail recognition is managed by inspecting the Redirecting Number of the remote station. If this num-
ber is merely two to four characters long, it is likely to be that of an internal remote station that transfers 
calls to voice boxes.

• If the number has neither been matched as landline SMS nor as voicemail, it is treated as fax.

»End  of  examp »

Use the tab Inbound Service Selection to assign each number to an ISDN interface. This tab may also be used 
to configure filters that are applied to inbound numbers. Inbound calls where no filter matches will be rejected, 
however if no filter is configured, all inbound calls are received as fax.

◊Note! Default settings for each service can be restored by right clicking and selecting 
Restore Default Settings. Voicemail default settings need to be enhanced individually.

Filters

As mentioned above, filters may be configured that are successively applied to each call. If a filter is set for 
a whole number, such as the filter Calling Party Number = 01930100, matching calls are identified as landline 
SMS. However, it is not necessary to create filters for a whole number, as filters may also be created using 
regular expressions.
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Example 2.9. 

Putting in an asterisk (*) denotes the preceding character to be repeated arbitrarily. Hence, the expression 
0*1930100 defines that the leading zero may be occur more than once, resulting that the calling numbers 
01930100, 001930100 and 1930100 are all treated as landline SMS. As PBXs tend to autonomously put two 
leading zeros in front of a calling number (e.g. 001930100), the default configuration of the Messaging Server 
already contains that said asterisk.

»End  of  examp »

Starting off with the first, the configured filters are successively applied to each calling number received (First 
Match). The filter hierarchy may be altered by using the UP and DOWN arrows.

Detecting Landline SMS

By default, incoming calls (Calling Party Number) are checked whether or not they originate from a landline 
SMS center. If it matches, it is treated as landline SMS.

Detecting Voicemails

◊Note! As the service selection is customer specific, no default settings are available for detecting 
voicemails. The service selections need to be locally added.

Image 2.39: Voice service

 ► Information Element; Filter; Service; Voice Server; Voice Connector

For a proper detection of voicemails, either the Redirecting Number or the Called Party Number may be entered 
into the Information element box. If the selected Information element matches the preconfigured filter, it will 
be applied.

Three dots (…) may be set as filter if all calls that contain a three digit Redirecting Number (internal calling 
number of the redirecting remote station) shall be received as voicemail. 

Reception processes that had been assigned to a Unified Messaging service by using the Redirecting Number 
are handled using this Redirecting Number only. Hence, this number essentially becomes the Called Party 
Number of the reception process. 
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If, however, the Redirecting Number is not available on a point-to-point terminal, a separate DID range needs 
to be provided. 

Example 2.10. 

The filter 3[0-5]0 for the Called Party Number triggers all DID numbers within the range of 300 – 350 to be 
received and treated as voicemail. 

This scenario requires an additional configuration for both, a voice server (voice0) and voice connector (msx-
2kgate0 or notesvoice0). After adding the address filters for voice, they should preferably be placed between 
those for landline SMS and fax (use the arrow up/ arrow down buttons).

»End  of  examp »

◊Note! The settings accessible by clicking Advanced should only be edited on IVR systems 
lacking a PIN entry prompt.

Detecting fax Messages

A Called Party Number filter should be placed at the end of the address filter which handles all remaining calls 
if neither a landline SMS nor a fax message could be detected.

2.4.6. Outbound Routing

During the installation of multiple ISDN interfaces, the transmission jobs are distributed to them depending 
on the system’s current workload. The same applies to ISDN interfaces installed on numerous ISDN cards. 
If the ISDN cards are regionally distributed within the Messaging Server system (as common on large scale 
installations), the question of how to influence transmission between individual ISDN interfaces quickly arises.

• -.* avoids the match of all calling numbers
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• .* matches all calling numbers

Image 2.40: Routing

Here, the Least Cost Routing or Location Based Routing is going to be implemented to the Outbound Routing 
rules for fax, SMS and voice.

• Least Cost Routing

Only those ISDN interfaces that will cause the least amount of costs are selected for the conveyance of 
transmission jobs.

• Location Based Routing

In Germany, the Least Cost Routing is only effective on an international level since the German telephone 
market was liberalized in 1998. If the routing is going to be limited to your country only, you may want to 
consider favoring the Location Based Routing over the Least Cost Routing as transmission costs will only 
arise where they are caused. However, there is currently a trend towards applying this form of routing for 
international transmissions as well

Example 2.11. 

A company with locations in Berlin and Vienna possesses one ISDN interface per location which is connected 
to a Messaging Server system. Whenever faxes are addressed to recipients within Germany, the ISDN inter-
face in Berlin is used to transfer the messages. This conveyance occurs independent on whether the sender 
is located in Berlin or Vienna. Alternatively, faxes are sent from Vienna if the receiver is located within Austria. 
Hence, the routing is carried out depending on the receiver’s address.
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This example implies the essence of Location Based Routing, namely the conveyance of faxes from the sender’s 
location.

»End  of  examp »

Outbound Routing is configured for each ISDN interface in the tab of the same name. Regular expressions used 
for address filters are defined for each communication service (Fax, SMS and voice) individually. These filters 
are applied to both, the normalized number of the receiver and the sender’s information and is embedded in 
a routing string by the transferring connector (SAPCONN, MSX2KGATE, NOTESCONN, etc.).

Least Cost Routing

A Least Cost Routing is configured by referring to the normalized number of the recipient. The term normalized 
indicates that spaces have been removed from the number. 

Example 2.12. 

If a fax is sent to 0049 (3328) 455 916, it is normalized to 0049(3328)455960. This number may now be used 
for the address filter. 

Given the fact that it is rather complicated to add every possible recipient number to the address filter, this 
number may be augmented with regular expressions.

»End  of  examp »

Example 2.13. 

All faxes sent to locations within the federal republic of Germany are required to be processed by predefined 
ISDN interfaces. For this purpose, the Fax Address Filter is enhanced with the input 0049.* at the recipient’s 
location. Thus, if the example 1.12 is taken into consideration, the ISDN interface in Berlin would only be capable 
of sending faxes to Germany, whereas the interface in Vienna would be capable of sending faxes to locations 
in Austria, Germany and more. To restrict these actions, the address filter for the interface in Vienna needs to 
be reconfigured from .* to 0043.* .

This configuration, however would cause the Messaging Server to only process faxes addressed to locations 
in Austria or Germany. We therefore recommend the implementation of exception rules that would essentially 
avoid a transferral of faxes from Berlin to Austria and Vienna to Germany. Faxes to recipients in other countries 
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(France, Switzerland, USA, etc.) are freely distributed by the Messaging Server. The country codes of these 
countries may also be added to the exception rules of the respective ISDN interface if they are required to 
be excepted from addressing. Put a dash in front of an address filter to configure an excluding address filter. 

     
Image 2.41: Address filter for Berlin (left) and Vienna (right)

The following table contains a list of configuration examples. 

Table 2.4: Configuration examples

Fax recipient’s address filter for the ISDN 
interface

ISDN interface responsible for fax transmission

in  
Germany (D)

in 
Austria (A)

towards 
Germany

towards 
Austria

towards 
Switzerland

towards 
remaining 
countries

.* .* D and A D and A D and A D and A

0049.* .* D and A A A A

0049.* 0043.* D A none none

0049.*
0043.*

.*
D and A A A A

0049.*
0041.*

0043.* D A D none

-0043.* -0049.* D A both both

-0043.*
-0049.*
-0041.*

D A D both

»End  of  examp »
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Location Based Routing

Location Based Routing is managed using the addresser’s information, which ideally consists of the fax, SMS or 
voice number. The effort needed for configuration is therefore rather limited compared to a Least Cost Routing. 
This is due to the narrower address range of the addresser’s number. The connector is additionally attached 
to the addresser’s information as a Routing String which consists of three tokens, separated by commas.

Table 2.5: Routing String composition

Connector

Routing String compostion

Part 1:  
Name of component

Part 2:  
User information

Part 3:  
Addresser‘s number

FILEGW Applicom 
(R / 3)

e.g. filegw0
<LA-ID> SAP system 
and Client

<USERINFO> SAP User-
name

FILEGW Applicom 
(Open-Xchange)

e.g. filegw0 <empty> USERINFO

FILEGW HP Scanner e.g. filegw0 <empty> Username

FILEGW XEROX 
Scanner

e.g. filegw0 <empty> Username

CLIENTGW e.g. clientgw0 User
User‘s fax number
User‘s CSID

SAPCONN e.g. sapconnPRD_100 <empty>
Originator address retrie-
ved R / 3 user root

VOICE e.g. voice0 <empty> Addresser‘s number

MSX2KGATE e.g. msx2gate0

By default, regular expressions entered for the originator’s address filter are applied to the third part of the 
routing string only, as the originator’s number commonly suffices for further processing. 

Example 2.14. 

If the address filter 030456789 is configured for the addresser in Berlin, all users with this number are effected. 
In order to limit effected users, regular expressions may also be used in this case. The address filter 0043.* 
configured for the ISDN interface in Vienna will only accept addressers with an Austrian number and, in turn, 
the address filter 0049.* configured for the ISDN interface in Berlin will only accept addressers with a German 
number. Although the address filter could even be defined in more detail by including additional numbers 
(004930456.* or 00431456.*) it is not a necessity as only user’s at the Berlin or Vienna location are capable of 
using the system.

»End  of  examp »

Example 2.15. 

An Active Directory user group or individual users may be blocked from using an ISDN channel for transmission 
by entering one of these strings:
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 ► Block User1

-msx2kgate0,lab.ofma.de/CN=schulze/OU=ofma User/DC=hq/DC=ofma/DC=de

 ► Block Whole OU

-msx2kgate0,lab.ofma.de/CN=.*/OU=ofma User/DC=hq/DC=ofma/DC=de

 ► Block DID Number 388

-388

 ► Block DID Number Range 380-389

-38.

If you are unsure as to what format to apply, the Messaging Server can be used to intercept jobs and by opening 
up the job details, the appropriate format can be found.

»End  of  examp »

◊Note! Recipient numbers are processed using the two leading zeros (00) that proceed coun-
try codes. This may, however not necessarily apply to addresser numbers as, if taken 
communication via R/3 as example, the addresser numbers are transmitted as +41… 
instead of 0041… and non-numerical characters are omitted by the Messaging Server. 

Check the entries made to both, the sender's and recipient’s configuration to ensure they contain these two 
leading zeros. Find these entries at View > Job Status…. 

The first two sections of the routing string can also be used to collect information for outbound routing. In 
this case, enter the routing string without comma separation. Hence, the addressee number 004930456.* is 
equal to .*,.*,004930456.*

A distribution of various SAPCONN transmission jobs to various ISDN interfaces is just as achievable as a 
distribution using the addressee number only. A benefit of the first method is an accurate assignment of fees 
for each interface individually, however an address filter with the rule sapconnAustria;.*,.* needs to be created.

2.4.7. Fallback and Error Processing

The fallback functionality is a much-requested addition to outbound routing for more than one ISDN channel 
or SIP trunk and was first introduced with the release of OfficeMaster Suite 5. 

Configuration of a fallback is generally carried out in two steps: First, a default scenario has to be set that 
defines when a fallback is required. Not always is a fallback to another channel straightforward. Furthermore, 
a configuration set for one customer may not be sufficient for the next.

◊Note! It is necessary to activate the Fallback functionality at Tools > System settings and tick 
the box Enable fallback processing.
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The OfficeMaster Suite 6 is augmented with various error codes that you can find in the tab Error Processing. 
A default behavior for each of these error scenarios is already pre-defined but may be altered at will. 

Step 0- When do the Fallback Settings Come Into Effect?

Image 2.42: Fallback configuration

Choose the tab Error Processing to pick an error type and select the box Auto Resend… to jump into the 
next dialogue.

 ► Default Error Group Settings

A behavior for all errors of the same error type (ISDN error in this case) may be defined in this section.

 ► Retry Attempts

Enter the amount of retry attempts if an error occurs.

 ► Minimum Seconds Between Retries

Define the minimum gap (in seconds) between a failed retry attempt and a new one by entering a value 
here. In many cases, if a remote station is busy it may be advisable to wait for a prolonged period before 
attempting a new transmission.

 ► Maximum Seconds Between Retries

Define the maximum gap (in seconds) between a failed retry attempt and a new one by entering a value 
here.
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 ► Fallback After Failed Attempts

Enter the amount of retry attempts BEFORE a fallback initiates. Please note that if this value is smaller 
than the one entered in Retry attempts, a fallback will not occur for this error type. The job will be labeled 
as faulty and consequently rejected.

 ► Fallback Delay

Enter the delay (in seconds) before the fallback initiates

Step 1- Routing Settings

Image 2.43: Fallback settings for D-channels

If all filters are pre-set to .* the channel will perform the routing during a fallback, regardless on the 
Outbound Routing configuration. We recommend not to change these settings except if

1. More than two D channels are available.

2. If no retry attempt is required for selected addressee or target numbers.

Jobs are usually distributed to a different channel if the initial channel is either occupied or errors occur. Use 
the tab Fallback to adjust the behavior of the respective D-channel once an error occurs. 
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Example 2.16. A fallback scenario during a transmission of messages from one location to another via a local OfficeMaster Gate.

Table 2.6: Settings for fallback routing

Location
Outbound Routing

(Sender)
Fallback
(Sender)

Berlin
+4930.*
-.*

.*

Hamburg
+4940
-.*

+4930.*

Vienna
+43.*
-.*

-.*

• The OfficeMaster Gate (OMG) in Berlin assumes the transmission of messages for Hamburg and Vienna 
if these Gates reject transmission. 

• The OMG in Hamburg assumes transmission for Berlin if a fallback has been configured.

• The OMG in Vienna executes no fallback tasks.

»End  of  examp »

2.4.8. Advanced Settings

The options displayed on the tab Advanced Settings are essentially applicable for the following scenarios:

• Automatic number correction to correct and divert incoming numbers

• Set log levels which are requested by our hotline.

Image 2.44: Advanced Settings
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 ► Number Correction

The OfficeMaster Messaging Server is capable of analyzing the syntax of outbound calling numbers and, 
if necessary, corrects them.

Example 2.17. 

If internal calls are transmitted using the whole number (area/country code + base number) instead 
of just the DID number, the number correction will eradicate the surplus digits. This is an economically 
beneficial solution, as costs for routing will only arise within the PBX itself.

Two basic functionalities are covered by the number correction. Each of which is applicable to D channels 
individually.

• Automatic number correction by referring to a configuration table with country-specific telephone 
parameters

• Editable replacement table for the first characters of the telephone number

»End  of  examp »

 ► Country

The automatic number correction mode adds or deletes characters by determining the configured loca-
tion of the D channel in dependence to the calling number of the transmission job. If a faulty or number 
has been provided, it is corrected as well.

Activate automatic number correction for an ISDN interface by selecting the desired country in the tab 
Advanced Settings (Expert Mode only).

Example 2.18. 

If an ISDN interface located in the federal republic of Germany is used to send a fax to +49 (3328) 455 
960, automatic number correction would replace the country code (+49) with the area code. Thus +49 
(3328) 455 960 would become 03328455960.

If, however, the ISDN interface were to be located in Austria, (00) would replace the (+), hence the output 
would be 00493328455960.

Added zeros to the area code (+49 (03328) 455 960) are considered as well and essentially lead to the 
same output as described above.

»End  of  examp »

 ► Edit Rules

An added feature to the automatic number correction is a replacement table, which covers a number 
of characters that replace or deleted certain characters of a calling number.

This may be necessary for:

• Routing calls internally even if the entire number length was provided (03328455><none>)
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• A provider selection for calls to selected countries (0081> 010780081)

• Call by Call scenarios (3U> 01078; if supported by the gateway)

• Closing gaps and possible failures of the automatic number correction

Use the box Edit Rules to open up the respective configuration panel. There is a number of ways to add 
or edit rules for both inbound and outbound calls. Please note that these settings apply to the selected 
ISDN channel only.

Image 2.45: Number correction; Replacement table

Example 2.19. 

Ferrari electronic AG’s PBX in Teltow (03328) is assigned to the base number 455 and processes three-digit 
DID numbers. An inbound fax addressed to 03328 455 200 is routed through the telephone exchange 
even if number correction has been activated and an internal routing is intended. The following prefixes, 
which are deposited in the replacement table, will be used to handle these calls and essentially enable 
inbound routing:

• +493328455

• 00493328455

• 03328455

• 455

If a calling number begins with these values, the character string entered in Pattern is replaced with 
the value entered in Replacement. In this case, the replacement box has been left empty, causing all 
processes to be routed internally ([+493328455] 960). 

◊Note! The replacement table can only be used if the Use Regular Expressions checkbox is 
ticked. Once finished configuring, close the Number Correction window by clicking OK.

»End  of  examp »

 ► Debug-Level

The logging sensitivity can be incremented if requested. We do not recommend applying changes without 
contacting the support team of Ferrari electronic AG first.

- 68 -

Basic Configuration

https://www.ferrari-electronic.com/home.html
https://www.ferrari-electronic.com/home.html


2.5. SMS Components
OfficeMaster can send and receive short messages in three ways:

• As landline SMS via an available ISDN interface

• As regular SMS via mobile broadband module connected by USB or serial interface

• As SMS via an Internet Service Provider 

2.5.1. OfficeMaster GSM Cellular Engine for SMS

The component GSMSMS is incorporated into the Messaging Server and handles transmission and reception 
of short messages (SMS) via a connected GSM mobile broadband unit. These GSM mobile broadband units 
are connected to the GSMSMS component via serial interfaces (COM-Ports). 

GSMSMS can be installed to and used on distributed server locations if no serial or USB interface was available 
on the main server, as a Messaging Server system supports operation of multiple GSM components.

Create a GSMSMS Component

The GSMSMS component (commonly gsmsms0) installs automatically during a default installation. If the 
system lacks a preinstalled GSMSMS component or if an additional GSMSMS component is required, either 
create it in the component table section or in the SMS via GSM Cellular Engine configuration dialogue. Use 
the Create Component button to create a GSMSMS component individually.

◊Note! If you need the created component to work on a sub server (e.g. if the mobile broadband 
module is physically integrated into the sub server), use the IP address or resolved sub 
server host name.

◊Note! Network modems can be tethered using COM/IP converters. Please contact our support 
team or use our forum for compatible solutions.

Configure a GSMSMS Component

Access the configuration interface at Edit > Further Sender/Receivers > SMS via GSMSMS components.

A GSMSMS component is capable of addressing numerous GSM cellular modem, yet it itself is connected 
to a server via a serial interface. Each interface/GSM cellular modem needs to be configured individually. 
Components available for configuration are displayed in the dropdown list. Here, choose the component you 
wish to configure.
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Please note that the dropdown list only appears if more than one GSM cellular modem have been assigned to 
one GSMSMS component. Use the respective button above the dropdown list to execute the desired option.

Image 2.46: Dropdown list

Enter the general information, as well as connection information for the GSM cellular modem into the tab Modem.

Image 2.47: Tab Modem

Control

 ► Port

Enter the serial Port for the GSMSMS component. This port is the connection interface of a cellular engine. 
Do this for each cellular modem individually. 

Windows uses COM1, COM2 etc. to address serial interfaces.

 ► PIN

Apart from the Port specification, the PIN for the SIM card used for data transmission is needed as well. If the 
SIM card PIN is incorrectly entered three times in a row, it will be blocked. Use a mobile phone to reset the PIN 
by entering the respective six-digit PUK-Code or ten-digit Super PIN.

 ► Network Selection

Each SIM card is fixed to a specific mobile network. This may prove inconvenient if the GSM cellular modem 
is located near a country border as the SIM card might use the foreign network and accumulate unwanted 
costs. Use the Network selection feature to determine how the SIM card should behave if the native mobile 
network is not available. If neither networks are accessible, the fax transmission will be displayed as faulty on 
the sender’s notification screen.
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 ► SMS Center

By default, the number of the respective SMS center is stored on the SIM card. Certain carriers use multiple 
SMS centers that differ in transmission costs, such as an SMS center for business- and private customers. 
Hence, use this box to enter the desired SMS center.

 ► Flash SMS Marker

The Flash SMS marker is used to tag text messages that are required to be sent as Flash-SMS. These SMS 
will display a notification on the recipient’s mobile phone screen once they have been received successfully. 
If the first few characters of the SMS match the value entered into Flash SMS marker, the respective SMS will 
be sent as Flash-SMS.

Received Messages

GSMSMS accesses received messages from the cellular modem and transfers them to the Messaging Server 
where they are further processed. The receiver’s number is the decisive factor on how the Messaging Server 
handles each SMS. Messages received via landline-SMS are bound to the fixed number plan of ISDN whereas 
text messages received via GSMSMS do not contain usable numbers for procession at all.

 ► Default Recipient

If messages received via GSM lack a recipient specification, a default recipient number can be entered into 
this box. The Messaging Server will then distribute these messages.

 ► Base Number

Use this box to enter the recipient’s base number. If the base number is specified correctly, it can be used right 
within the SMS body to address the respective recipient. 

Example 2.20. 

Given a text message with the content .960. This is a SMS. 

In this case, the leading .960. is omitted from the message content and construed as recipient specification. 

»End  of  examp »

The configured base number is used as prefix for the recipient specification. Hence, the base number and 
recipient specification yield the calling number, which then is used for further procession.

◊Note! It is not mandatory to deposit the recipient specification numerically into the SMS body. 
As each letter is assigned to one or more numerals on a keypad, the Messaging Server 
detects letters and autonomously converts these into numerals. Thus, the recipient 
specification FERRARI yields the calling number 3377274.

SMS Address Filter

If these messages are required to be delivered on multiple transmission routes (e.g. via GSM cellular modem, 
via ISDN and via the provider), we recommend implementing a routing for SMS transmission jobs. The routing 
can be configured in the Outbound Routing tab.
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 ► Recipient / Sender

The address filter ideally consists of the entire calling number of both the recipient and the sender. Use regular 
expressions to simplify the address filter configuration.

Whichever preconfigured address filter for either a GSM cellular engine or ISDN interface/ SMS provider first 
matches to a sender’s/ recipient’s calling number it will be used for transmission.

◊Note! We recommend deactivating the SMS transmission for selected ISDN interfaces if these 
are required to communicate via GSMSMS instead of ISDN (OMCUMS).

2.6. OfficeMaster SMS via Service Provider
The OfficeMaster send-and reception component SMPP handles the transmission of short messages via an 
Internet Service Provider (ISP). It essentially uses the Internet to communicate with an SMS provider.

Since the initial release of the OfficeMaster Suite version 6.2, the PROVIDERSMS component can no longer 
be selected. The OfficeMaster SMPP component utilizes the SMPP communication protocol instead of http, 
allowing for a more flexible connection of providers. Select SMS via HTPP provider (SMPP) on the left toolbar to 
configure the component. Please note that depending on the IP provider, diverse settings need to be adjusted. 
Find connection parameter for selected IP providers below. 

◊Note! You may still use existent PROVIDERSMS components and adjust their configuration. 
However, as outlined above, new setups will offer SMPP components only.

2.6.1. Connecting to LinkMobility (formerly WhateverMobile)

Image 2.48: Necessary parameters for connecting to the IP provider Link Mobility
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2.6.2. Connecting to Lleida

Image 2.49: Necessary parameters for connecting to the IP provider Lleida

2.6.3. Connecting to Message Mobile

Image 2.50: Necessary parameters for connecting to the IP provider Message Mobile
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2.6.4. Connecting to Mitto

Image 2.51: Necessary parameters for connecting to the IP provider Mitto

2.6.5. Connecting to WebSMS

Image 2.52: Necessary parameters for connecting to the IP provider WebSMS
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2.6.6. Options (Expert Mode Only)

Most settings depend on the IP provider and should only be edited after informing the latter.

 ► Communication Management

 ► Concatenation Mode

• Payload

Triggers the sending of a long SMS.

• ShortMessage

• ShortMessageWithSAR

 ► Message Limit

Use this input field to specify the minimum amount of inbound and outbound SMS. This is a fixed value 
set by the provider. 

 ► Response Timeout

Specify the waiting time after which the Messaging Server expects no more inbound/outbound mes-
sages. This is a fixed value set by the provider.

 ► Keep-Alive Interval

This is a fixed value set by the provider.

 ► Request Delivery Reports

If this checkbox is deselected, the feedback will only include the confirmation of a successful handoff 
to the provider. 

If this checkbox is selected, the feedback will only be forwarded to the connector/user once the pro-
vider has received a confirmation of successful delivery. Please ensure to have the component type 
Transceiver, Receiver or Transceiver and Receiver deposited. If you have not done it yet, please do so in 
the tab General.

◊Note! For bulk faxes, it might not be very beneficial to wait until a delivery report has been gen-
erated, as the maximum job counter will not count down until it has received a feedback 
from the connector.

 ► AutoReconnect

This is a predefined setting set by the provider.
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 ► Local Port

Specify the port that the component uses to communicate (TCP). If no port has been specified, the 
following defaults will be used:

• 3550 for SSL

• 2775 for others

 ► Parallel Job Limit

Regardless on the provider chosen, you may specify a maximum amount of concurrent jobs for the 
OfficeMaster Suite. A job is active as long as the connector has not received a feedback.

2.6.7. Configure Outbound Routing

This chapter is separated into three sections. The first section outlines the phone number adjustment whereas 
the other deal with the routing rules. These settings are essential as they will determine the job assignment 
for the component in a default scenario as well as in a fallback scenario.

Image 2.53: Editing the outbound routing

 ► Adjust Phone Numbers

Select the Edit icon (  ) next to the Sender and Recipient input fields to adjust all settings for the trans-
mission of messages via SMPP. You may use a fixed value or one regular expression for each input field. 
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Image 2.54: Modifying outbound calling numbers

2.6.8. Advanced Settings

You may configure the component with a multitude of advanced settings, such as adjusting internal calling 
numbers or choose an alternative network interface. Click on the Advanced tab to access these.

Image 2.55: Advanced settings for the SMPP component
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 ► Internationalization

 ► Adjust Phone Numbers

The calling number scheme of short messages tend to be divergent from users maintained in the internal 
directory. To adjust the scheme accordingly, manipulate the calling numbers by selecting the Edit icon  
[...], then choosing Add... The process of calling number manipulation is identical to the one described 
for the SIP component (see page 37 and following).

Image 2.56: Adjusting calling numbers

2.6.9. PROVIDERSMS Component (outdated)

The transmission/reception component PROVIDERSMS handles SMS processing via an Internet Service 
Provider (ISP). It communicates with an SMS provider via Hyper Text Transfer Protocol (HTTP) as long 
as the provider is accessible. A preconfigured connection to Link Mobility (formerly Whatever Mobile) 
is available as well.

◊Note! The use of Whatever Mobile requires a pre-existent account! Call +49 40 88 88 08 0 or 
mail to sales@whatevermobile.com to apply for such an account. Upon calling or mailing, 
please indicate that Whatever Mobile is intended to be used for OfficeMaster’s SMS over 
IP provided by Ferrari electronic AG.
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If no preinstalled PROVIDERSMS component is available, use the component table to create a new one. Access 
the component table by double-clicking the respective label in the Quick launch section.

Image 2.57: Component Table

 ► Create a Component

Use the Create a component button and choose SMS via HTTP-provider (PROVIDERSMS).

 ► Name (Setup Type: Custom)

This value is preconfigured; the number that succeeds the component type name (in this case ‘0’) indicates 
the amount of existent components of the same kind.

 ► Host (Setup Type: Custom)

If the PROVIDERSMS component is required to establish a connection to an ISP via a sub server, use the IP 
address or resolved name of the respective host here.
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Configure a PROVIDERSMS Component

Use Edit > Further Sender/Receivers > SMS via HTTP-Provider… to open up the configuration window. Avail-
able PROVIDERSMS components are displayed in the left dialogue window (commonly providersms0, refer 
to Image 2.44).

Image 2.58: Configuring a PROVIDERSMS component

Connection Settings

User data for the selected Internet Service Provider (ISP) can be entered in the connection settings.

 ► Url / User Name/ Password

A Url path is already pre-entered for SMS transmission and reception via Whatever Mobile. Please fill out 
the User name and Password boxes manually.

Sender

Outbound text messages are fitted with a Calling Party Number.

 ► Default Address

Enter a default address here. This address will be used for all non-configured calling parties.

 ► Edit Rules

Use this button to manipulate the calling party address. This may become necessary if round messages 
are delivered and, due to reasons of processing, the response address is required to be other than the 
calling party address.

Advanced

These advanced settings are commonly left unaltered but can be edited, if required.

 ► Local Port

The pre-entered port 7010 is used for text message reception. If, however, conflicts arise with the local 
installation, use this box to assign a different port.
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 ► Fields

This layout is a mirrored version of that Link Mobility. If you wish to use another provider, it may become 
necessary to edit the field layout. Please contact the respective provider for further instructions.

Outbound Routing

The first match method for SMS address filter will be applied to the three main SMS transmission methods 
(ISDN, GSM and Provider) if multiple transmission procedures are used. Please refer to section 2.5.1 on page 
69 for further information on the first match method.

- 81 -

Basic Configuration

https://www.ferrari-electronic.com/home.html
https://www.ferrari-electronic.com/home.html


2.7. Voicemail Server
Even with the base license, OfficeMaster supports multiple voicemail functions, which are outlined in the fol-
lowing section. However, the common voicemail functionality needs to be distinguished from Extended Voice 
and vice versa. As for now, we look on the context of the term "Voicemail" and highlight its coherence.

2.7.1. Configurations on the Voicemail Server

In the Expert Mode, open the settings for the voicemail server at Edit > Voice Server... . The configuration set-
tings are displayed in the right pane. Use the middle pane to toggle between different voice servers.

Image 2.59: Configuring the voice server

 ► Base Settings

 ► Default Voice Project

In cases where no dedicated voice project has been assigned to a called and identified mail box, the 
Default Voice Project is used instead.

 ► Voice Project (No Mailbox)

Specify a voice project for calls that could not be assigned to a mail box.

 ► Specific Voice Path

If you intend to have the projects and personal recordings saved to an alternative path, specify the new 
path here. In doing this, personalized menu layouts are not overwritten if updates are installed.
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 ► Cut Records by / Delay Records by

A caller commonly hangs up after leaving a message on a voice box. As this action of hanging up often 
includes a handset being physically put back into the station, unwanted sounds may be recorded. In 
order to cut out these sounds, the voice server can either cut records or delay records by a given amount 
of time (in milliseconds)

 ► Connection Timeout

Specify the time in minutes after which the voice server automatically terminates the call.

 ► Enable MP3 Conversion

By default, the voice server stores all voice recordings in a WAV format. However, WAV takes up a con-
siderably large amount of space. Thus, you can choose to have the WAV files converted to MP3, which 
is much more efficiently. As per default, one WAV file takes up the same space as 10 MP3 files.

◊Note! OfficeMaster Suite provides the freeware program Lame for MP3 conversions.

 ► Access Authorization Mode

If a user runs a remote request to the voice box, both the PIN code and Calling Party Number can be 
used to check for adequate authorization. Hence, the user either calls from an authorized calling num-
ber or, if the calling number is not recognized, enters the PIN. OfficeMaster Suite uses this settings by 
default (PIN or OAD).

Alternatively, access to the voice server can be reduced by allowing only one of these forms for autho-
rization (either PIN or OAD). In addition, you can specify whether the voice server accepts empty PIN 
boxes or not.

 ► Default PIN

Unless the user or connector has a dedicated PIN, you may specify a default PIN here.

 ► Dynamic Default PIN Processing

Activate this checkbox if you intend to have a dynamic PIN generated initially for each user unless they 
possess a dedicated PIN.

 ► User PIN Notification via E-Mail

This checkbox is dependent on the Dynamic Default PIN Processing feature. Once a dynamic PIN is 
generated and used, the respective user will receive an E-Mail containing his/her PIN.

 ► User PIN Notification via SMS (Preview)

In addition to the options above, the user may also receive a SMS containing his/her PIN.
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 ► User PIN Change Request if Default PIN is set

If a default PIN has been set, the server will prompt the user to change the password once he initially 
logs into the account.

 ► Minimum PIN Length /Maximum PIN Length

Specify the minimum and maximum amount of characters that a password can consist of. Please set 
the Maximum PIN Length first, as the value in Minimum PIN Length will not change otherwise.

2.7.2. Voice Communication Procedure

As opposed to fax, incoming voice calls have to be distributed to users they are actually meant for before being 
taken by others. Furthermore, they have to be handled depending on the user’s configuration setup, such as 
language, automatic voice response, etc.

 ► Handling Process of a Voice call

• Either the OfficeMaster Gate or the component JCISDN (CAPI selection) establish calls and rout them 
towards a hardware controller on the Messaging Server. 

• The hardware controller identifies the respective voice connector (e.g. msx2kgate) as well as the voice 
server (commonly voice0). All available calling party identifiers (such as ‘called, calling, redirected’ etc.) 
can be used to determine its origin.

• The voice server subsequently establishes a UDP connection to the OfficeMaster Gate or JCISDN and 
assumes direct communication.

◊Note! It may become necessary to configure firewall rules for outbound calls (Voice server 
towards OfficeMaster Gate). A common indication that points to a firewall issue is if a fax 
number is called and you hear a fax sound instead of the default recording of a voice box.

2.7.3. Included Projects in the Voice System

After installation, OfficeMaster provides several projects that can be handled without excessive effort in ad-
ministration. These projects are created in the ...\data\voice folder of the Messaging Server and consist of 
subfolders with description files and LUA scripts.

The Voice system contains several projects, which are lain out consecutively. To maintain a decent overview, 
not every project is selectable as starting point. Loadable projects are flagged with the respective label (load-
able) in the .ini file.

 ► Voicebox Over Pilot-ID

 ► projectvoxdidcpn

The Calling Party Number will be reset to the Called Party Number and the initiating project will be 
applied (eVoice_projectStart).
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 ► Extended Voicemail

In case the OfficeMaster Suite has not been sufficiently licensed, the Extended Voicemail may not be available 
to you. In this case, the default voicebox will be used. Individual projects take on following tasks: 

 ► eVoice_projectStart

Entry point with individual value configuration for variables.

 ► eVoice_projectrecord

Default recording for voice messages.

 ► eVoice_projectPlayAudio

The desired recorded message will be played if a recording has been deactivated for voicebox or period. 
The call will then terminated after playing the record.

 ► eVoice_projectAnnouncementFromPhone

Self-made recordings will be managed via web interface.

 ► eVoice_projectAnnouncementToPhone

Self-made recordings will be played back via web interface.

 ► Default Voicebox (not Actively Selectable Since Version 5.0.2; Only for Fallback)

In this mode, the caller will be greeted with a pre-recorded recording and asked to leave a message. Once 
he presses the asterisk (*), he will be asked to enter the PIN for the voice box using telephone keys. After 
successfully entering the PIN, the caller will have full access to the configuration menu where he can change 
the PIN, listen to voice messages and delete them.

 ► projectvox

Entry point for the default voice box.

 ► projectrecord

The project where the message plays back and recording initiates.

 ► projectpin, projectloadpin

Both, the calling number and entered PIN can be used to determine whether the caller was authorized 
to access this voice box.
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 ► projectabfrage

Request new voice messages.

 ► projectabfrageold

Request voice messages that have been listened to.

 ► projectreplay

Plays pre-recorded messages back.

 ► projectconfig

Records welcoming messages and changes PIN.

 ► projecthangup

End of call; terminates connection to the Messaging Server.

 ► Default Voicebox Without Recording (not Actively Selectable Since Version 5.0.2, Only for Fallback)

 ► projectvoxprompt

Entry point.

 ► projectnorecord

Plays pre-recorded messages back with a subsequent jump to projecthangup.

 ► Call Recording Functionality

 ► projectrecordcall

Selecting and running this project will inform the party that this call is going to be recorded after the 
announcement has ended. Once the call has ended, the user will get a message with the recorded call 
included.

Due to capacity reasons, we highly recommend to activate the audio conversion to .mp3!

 ► Selecting the Calling Mailbox

 ► projectvoxdid, projectdid

The caller will be requested to select the voice box he wishes to be connected to by pressing the re-
spective telephone key.
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 ► „Recording Studio“

 ► projectrecstudio

Select this project to record voice messages or generate IVR’s (Interactive Voice Response). Recordings 
will be saved as valid file format to ensure their further use within the system.

 ► IVR Templates

An example for scripting own IVR’s with most important features.

 ► ivrExample_start

Entry point that includes timetables, holidays etc.

 ► ivrExample_normal

The company is open and the caller has the choice to either connect to another party or leave a message.

 ► ivrExample_closed

The company is closed and the caller gets played a message.

2.7.4. WebVoice

Users have the choice to administrate their voice mailbox on a web interface.

 ► Basic Configuration

The interaction between the voice server and web-services components is established during the OfficeMaster 
server setup. Here, an Internet Information Service (IIS) will be created as Windows Server feature.

Respective web pages will be provided and stored to the file path %Program Files (x86)%\FFUMS\fmsrv\bin\
WebserviceData for the IIS disposal.
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For the configuration of web services, various configuration files that apply to the IIS and OfficeMaster would 
have had to be accessed individually. However, the tool FClientGwCfgPrg (accessible via VOICE component) 
eases this process dramatically.

Image 2.60: Opening the configuration program

 ► Website Address

Enter the address of the website you wish to configure, here. As long as the default address has not been 
edited in the IIS after installation, this is either http://SERVERNAME/ums or http://SERVERNAME/fax.

 ► Configuration Password

The default password for configuration access is OfficeMaster!.
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After successfully logging in, configure the operation mode, the voice server and the respective connector 
for the user information.

Image 2.61: Settings for OfficeMaster‘s client website

 ► Change Configuration Password

We recommend changing the default password to avoid unauthorized access to the configuration settings.

◊Note! Since version 5.0.2, the OfficeMaster interface offers much greater configuration settings 
than commonly required. Some settings should only be edited if a full web client is used.

 ► Operation Mode

Choose Voice only if the base connector is either an Exchange-, Notes- or SMTP connector.
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 ► Login Type (from OfficeMaster Suite 6.2)

In this box, set the authentication details that are requested upon login. You can choose between

• Username & Voice PIN

• Voicebox- Number & PIN

• E-Mail Address & Voice- PIN

 ► Messaging Server

 ► Voice Component

Deposit the used voice server component for OfficeMaster here. This is commonly voice0 and does not 
have to be changed.

 ► Voice Gateway

The voice server requires an addressable gateway, which should support and deliver user information 
requests. The component msx2kgate is commonly used in Exchange environments whereas notesvoice0, 
univoice0 and clientgw0 are used in other environments respectively.

 ► Authorization Levels

During voice server setup, you can assign various authorization levels to individual users or user groups. 
The following authorization levels are currently available:

 ► No Voicemail

If the user had no VOX number deposited, voicemail will not be available to him.

 ► No Authorization for use of Extended Voice

As soon as a VOX number is detected on a user, the voicemail functionality activates and the default 
project is being used.

• Up to OfficeMaster version 5.0.1 this default project is projectVox, however since OfficeMaster version 
5.0.2 it has changed to eVoice_projectStart. 

• eVoice_projectStart will be set back to projectVOX if it is not licensed sufficiently.

• The same applies if no personal settings have been applied yet.

 ► Extended Voice User

As soon as an administrator or the user himself wants to edit the user profile, a default profile will be 
created. This also triggers the creation of a subfolder within the Messaging Server for that user whose 
profile contains a profile description file.

The user can edit these attributes:

• Load/edit/save own profile 
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• Edit language for both, recorded message and menu navigation via Dual-tone multi frequency sig-
naling (DTMF)

• PIN for remote request

• Calling number that is authorized to run requests

• “To my phone” calling number 

• Record/upload/rename/delete voice messages

• Assignment of initiation points to individual days or timeframes

• Add personal recordings to initiation points

• Determine whether the caller can leave a message or gets played the recording

 ► Administrator for Extended Voice Profile

These actions can be accessed on top of the common voice user settings:

• Load/edit foreign profile

• Edit the voice project

• Choose between project (with subsequent selection of target) or voicemail as initiation point type

2.7.5. Audio Files

The voice server processes audio files on a file level, thus these files are searched for on a project basis. 
Therefore, if the Messaging Server accesses the audio file greeting.raw, which is located within the project 
ivrExample_normal, it firstly browses through the subfolder ivrExample_normal. If this file is not located within 
this subfolder, the system broadens its search to a global level and browses through the Audio folder.

This browsing process supports an administration of various files on a single level as well as using two files of 
the same name that contain different content.
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2.8. Converter (CONV/OLECONV)

◊Note! In order to access the quick start tab and apply settings, the Expert Mode must be enabled.

The conversion of fax documents is one of the most important aspects on servers with an OfficeMaster in-
stallation. Our converter transforms documents running on third-party software such as Microsoft Word or 
Adobe Acrobat Reader into a faxable and graphic format.

During installation for Microsoft Word, it is important not to simultaneously install Microsoft Outlook, as the MAPI 
component would prevent the Exchange connectors (incl. Online Connector) to work properly. The Exchange 
connectors employs the local MAPI even if an alternative routing for reception and dispatch has been selected.

We recommend using a service account with administration rights to run the converter on the system.

◊Note! Programmes used for conversion must be run by the respective account at least once 
before using it in full extent. Make sure all pop-up windows, such as initials request, and 
automatic updates are disabled. On Adobe Acrobat Reader version 10 or higher, the 
protected mode must be disabled as well.

The converter (CONV) addresses external converter software while distinguishing between two conversion 
types:

• Via OLE (Object Linking and Embedding): The converter utilises OLE to issue the document on a FerrariFAX64 
windows printer and convert it into a graphic image.

• Via CLP (Command Line Parameter): Name and location of the file required for conversion will be trans-
ferred as CLP without the use of a FerrariFAX64 windows printer. The following list includes converters 
that are currently supported (as of January 2018):

Table 2.7: Type of conversion

Converter File format Type of conversion

Adobe Acrobat Reader PDF OLE

GPL Ghostscript PDF, PS Command Line

Lotus Notes NTF, NSF OLE

Notes Client Lotus 1-2-3, WordPro, Freelance OLE

Microsoft Excel XLS, XLSX OLE

Microsoft PowerPoint PPT, PPTX OLE

Microsoft Word DOC, DOCX, RTF, HTM, HTML OLE

IrfanView GIF, TIF OLE
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The configuration settings for CONV can be accessed at Edit > Central Conversion > Converter… .

Image 2.62: OLE conversion

◊Note! If you enter IrfanView as file for QuickViewPlus, the DLL recognizes the file name and 
adjusts its addressing (cmdline) accordingly.

Image 2.63: IrfanView converter

Rules can be populated to the default OLE converter.
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Example 2.21. GIF converts to DCX and TIF converts to DCX

Image 2.64: Custom OLE conversion

»End  of  examp »

2.8.1. Converter as Service

After installation of the OfficeMaster Suite, the OfficeMaster Converter is created along with the OfficeMaster 
Messaging Server.

The Messaging Server component CTRL controls the service OfficeMaster Converter and must not be edited 
in the Service section of a task manager.

Image 2.65: The service OfficeMaster converter and OfficeMaster Messaging Server
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If the installation has been carried out on a Windows Server version above 2008 R2, the OLE conversion requires 
a restart of the component. Do so by opening up the component’s properties window within the Messaging 
Server and select Run as service (See image 2.52).

Image 2.66: Properties of CONV component

2.8.2. Setting up Ghostscript as Converter

Image 2.67: Adding Ghostscript as converter
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Ghostscript is a neat alternative to the Adobe Acrobat Reader. As it allows for a much higher conversion out-
put, we recommend using it as a conversion tool for both PDF and PS in environments where a large volume 
of fax output is persistent.

 ► Executable Path

Here, enter the location path including binary name of the Ghostscript. Make sure to use the command 
line gswin32c.exe / gswin64c.exe.

 ► Disable PDF Conversion

Tick this box if Ghostscript shall process PS documents only.

 ► OCR

If OfficeMaster detects a licensed interface for the character recognition software B&L, you can configure 
command line parameters here.

 ► Supported Languages

Select the language for character recognition here. You can essentially improve rate of correctly recog-
nized characters by narrowing down the languages.

 ► PDF Creation Mode

Detected PDF’s contain both picture and text. The arrangement can be edited depending on the re-
spective needs.

Assuming that PDF documents are required to be not copyable while being collected and assorted in a 
database according to tags (such as “Invoice”, “Merida Inc.” etc.), Text over Picture has to be selected. 
If you need these documents to be copyable, select Picture over Text.

 ► Fast mode (outdated)

As the OCR technology takes up a considerable amount of processor speed, this option was often 
activated when the system performance was not sufficient enough for a coexistent use of OCR and 
other processor- consuming programs. However, while the use of processor power for OCR is kept at a 
minimum, note that the recognition quality decreases.

Table 2.8: Converter for print formats

Print format Converter Benefits in using this format/converter

Postscript (PS) AFPL Ghostscript 

Creates searchable pdf files  
(dispense with stationery)

Interprets embedded control commands in 
practically every font

Free freeware download

Printer Common  
Language (PCL)

Internal JetPCL converter*
Omits control commands from the document 
during conversion
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Print format Converter Benefits in using this format/converter

Text (Preferably while connected to 
host systems)

Internal text converter
Omits control commands from the document 
during conversion

* not available for OfficeMaster with a  10/25 user limitation

Business documents containing images or various formatting styles (e.g., cursive or bold fonts) commonly 
use PS or PCL as printing format.

◊Note! The OfficeMaster versions with a 10 and 25-user limitation do not possess a PCL converter. 
Hence, the AFPL Ghostscript takes over that task and must be selected.

GPL is a freeware and can be downloaded from the Internet. After downloading, deposit the Ghostscript as 
converter into the Messaging Server Configuration.

2.8.3. Alternative Converter for Microsoft Office and PDF

Due to the continuously rising number of restrictions for automatically installed drivers, Ferrari electronic 
endeavors to constantly find new solutions for a central conversion. However, the default conversion is still 
available with just a minimal amount of administrative effort hence why the alternative converter (OLE con-
verter hereafter) has not yet been added as default converter.

A higher processing volume and use at UAC (User Access Control) are key improvements of the OLE converter.
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Creating the OLE Converter Component

Use the quick launch bar to open up Converter > OLE Converter and click on Create Component. If the OLE con-
verter is not listed in the Converter section, click on System > Component Table, select Create a component and 
choose OLE Converter for Office 2016/2013 (OLECONV) from within the dropdown list.

Image 2.68: Creating a new OLE converter component via the Converter section

Follow the installation wizard. You will be asked to provide a service account.

◊Note! This service account needs to possess local administration rights.

Image 2.69: Entering service account details for the OLE converter
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The following dialogs for labeling the converter are identical to those displayed for other installation types. 
After successfully creating the OLE converter, you should be able to see it in the Converter section of the Quick 
Launch Bar.

Image 2.70: Configuration overview for Microsoft Office and PDF

 ► Ghostscript

 ► Program Path

Enter an executable path to the Ghostscript file here. Please use the Commandline version gswin32c.
exe or gswin64c.exe.

 ► PDF Conversion Enabled

Tick this box if you need the OLE converter to register for PDF file conversion.

 ► OLE Office Conversion

Tick these boxes if you need the OLE converter to register for the respective document type. This is im-
portant as the converter will be capable of converting only those documents into a graphic image that had 
been selected here.

 ► Internal Image Conversion

Activate the desired box/es if you need the converter to convert an image type into another.
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Disabling the Central Converter CONV for Certain Conversion Tasks

Once successfully setting up the OLE converter, the central converter has to disabled for document conversion. 
It would essentially hinder the proper functionality of the OLE converter if left unaltered. Open up the configu-
ration panel for the central converter (CONV) and click on the  Custom... box. Select the tab Disable Converter 
and tick the document types that you want to convert with the OLE converter instead. Next, restart both the 
central converter and OLE converter.

Image 2.71: Overview of settings for the central converter

Image 2.72: Deactivating selected components
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2.9. Automatic Printing of Received fax Messages
The gateway component PRINTGW allows the Messaging Server to distribute received fax messages auton-
omously to a network printer. Recipient calling numbers can be assigned to the PRINTGW and, unlike other 
Messaging Server components such as SAPCONN and Undeliverable (UNDLVRBL), it can process printing 
jobs and essentially print out fax documents. Configuration settings for PRINTGW can be accessed in the 
quick launch bar at Print/OCR > Print Gateway.

Image 2.73: Print gateway configuration

If the component has been deleted or is non-existent, you can create a new component by clicking on 
Create Component. You may freely edit the name of the component, but note that the prefix printgw is not 
editable. The Messaging Server automatically numbers newly created components according to their time 
of creation, e.g. printgw0, printgw1 etc.).

Assuming you possess multiple printers distributed throughout the office building, you may want to name 
them according to their location, e.g. printgwMarketing or printgwAccounting. 

The Host generally refers to a new IP address or resolved name of the main server.

 ► New... / Edit... /Delete

Use these buttons to either add a new printer or edit/ delete an existing printer.

 ► Printer

Once the PRINTGW has been started in the component status section, it automatically searches the 
network (such as windows domain) for available printers. If a printer has been found, it can be as-
signed to a PRINTGW component. Edit the name of the printer manually if needed using the format 
\\Servername\printername.
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 ► Tray

Available input trays are listed here if the PRINTGW component has successfully found a printer.

 ► Fax-Adressfilter

The fax address filter is applied to the fax number (Calling Party Number) of inbound faxes and regular 
expressions design how the filter treats those fax documents. The simplest form of a regular expression 
is providing the entire Calling Party Number.

Example 2.22. 

Given the scenario that faxes sent to the calling party numbers 349, 342 and 348 are required to be 
printed out, these numbers have to be entered successively into the list:

349 
342 
348

Use the regular expression 34[928] to address all three numbers in one row.

»End  of  examp »

 ► Status Printer

 ► Printer Name

If the address filter denies access to a configured printer, enter another printer that will carry out print 
jobs for fax status messages instead.

 ► Tray

Select available input trays that contain a sufficient amount of paper.

 ► Print Only the First Page

As the essential status information is often printed on the first page of a status message, you may ac-
tivate this box and thus avoid surplus paper usage.

 ► Miscellaneous

 ► Print Status Line

Tick this box if you require the PRINTGW component to compress the most important information into 
a single line and attach it to the document.

 ► Disable Printer Search on Startup

Disabling the printer search on start-up will considerably improve the overall booting time of the PRINTGW 
component.
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2.10. Integration of Printing Functionality Into a 
Third Party Software (LPD)

2.10.1. Sending Documents as Fax or E-Mail Attachments

OfficeMaster proved the be indispensable for transferring business documents such as quotations, orders and 
reminders. The printing functionality easily integrates into ERP software, e.g. Axapta, cd2000, Infor, Navision, 
proALPHA, sage KHK, SAP Business One or Varial. 

Business documents are issued to OfficeMaster, augmented with a digital signature (if configured) and trans-
ferred as Fax or PDF attachments. The user subsequently receives the status message as E-mail into his 
mailbox (Microsoft Outlook , Notes).

The OfficeMaster Messaging Server utilises a LPD gateway (Line Printer Daemon) that receives printing data. 
With help of the printing data, the LPD gateway creates a transmission job, thus preparing the print job for 
further procession. Printing data generally incorporates the actual document and information such as name 
of document as well as network location name of the user who is printing. This network location name is used 
to identify and assign multiple jobs to one user.

OfficeMaster accesses information such as calling number of the fax interface, E-Mail address of the receiv-
ing user and time of dispatch right out of the document. However, this information must consist of multiple 
commands that are embedded into the ERP system. We henceforth call these commands Control Commands. 

Listed below are all processing steps that are followed once a document routs through OfficeMaster.

Table 2.9: Steps for configuring the file transmission

OfficeMaster  
Messaging Server

Component Detail Task

-
ERP client on user workstation or 
ERP server

Issues the document including embedded control commands to the 
configured printer

-
Printer with spooler and configu-
red IP address & printing queue 
(optimised for OfficeMaster)

Converts the document into a usableprint format (PCL, PDF, PS or 
text) and routs it to OfficeMaster using the LPR

LPD Line Printer Daemon
Receives the document along with additional printing information 
(Dispatcher and file name) and handles the document according to 
printer the queue

CONV
Converter fitted with internal 
PCL converter and/or AFPL 
GhostScript

Converts the document from the received printing format into a 
graphic image (for fax) or PDF (for E-Mail) while simultaneously 
extracting the control commands

NOTESCONN, MAILGW, 
FILEGW, MSX2KGATE, CLI-
ENTGW, ...

Connector for Notes; Mail gate-
way; File interface

Assigns the document to a connector user using the LPD sender 
while creating a send job with user specific parameter (such as own 
fax CSID)

SIGNDS (optional)
Signature server connection 
including digiSeal server

Applies a digital signature to the document (if configured)

OMCUMS (for Fax) Integration of ISDN components Uses the configured ISDN hardware to transfer the document as fax

SMTPTX (for E-Mail) E-Mail dispatcher Transfers the document as pdf /e-mail attachment using SMTP

NOTESCONN, MAILGW, 
FILEGW or CLIENTGW

Gateway for Notes; Mail Gateway; 
file interface or WebClient

Provides the transmission status to a gateway user (via Notes-mail 
for NOTESCONN, via E-Mail for MAILGW and as file for FILEGW)
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Hence, connecting an ERP system to an existent IT infrastructure is rather complex and demands configuration 
processes for individual components within the OfficeMaster Messaging Server as well as within the used ERP 
system and mailing system. These individual configuration steps are listed below and can be used for reference.

Table 2.10: Configuration steps

Configuration Step Chapter and Page
OfficeMaster Connector

SMTP Notes Exchange

Setting up Ghostcript as converter for Postscript 2.8.2 on page 95 X X X

Adding or configuring LPD Gateway 2.10.2 on page 104 X X X

MS Exchange (MSX2KGATE) 2.10.3 on page 108 - - X

IBM Lotus Notes/Domino  
(NOTESCONN) 2.10.4 on page 109  - X -

Mail-Connector (MAILGW) 2.10.5 on page 110 X - -

Transmitting files via LPR command 2.10.6 on page 111 X X X

Configuring windows printer for use with LPD 2.10.7 on page 112 X X X

ERP-System 2.10.8 on page 118 X X X

File interface(FILEGW) 2.10.9 on page 119 Optional Optional Optional

2.10.2. Adding or Configuring LPD Gateway

With Expert Mode enabled, select Edit > Further Connectors > Line Printer Daemon… . All LPD gateways that 
are available within the OfficeMaster server system are listed in the left dialogue bar. The gateway lpd0 is the 
only gateway that is initially available by default. 

Supposing the installed OfficeMaster Suite configuration program is an updated version, the LPD has already 
been installed but yet needs to be manually registered to the existent configuration . 

If there is no component available, click on Create Component to add it to the Messaging Server.

◊Caution! The absence of an installed print server is a prerequisite for the LPD functionality!
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We recommend naming the component lpd0 if such component is not already present. As Host, either select 
the IP address or resolved server name of that server you want the LPD- component to run on (commonly the 
main server). The screen updates automatically once the settings have been confirmed.

Image 2.74: Settings for lpd0

The default settings apply the majority of installation scenarios. There are only a few exceptions where you 
need to edit these settings. These include:

1. Using the OfficeMaster Suite 10 user and 25 user versions as they are not equipped with any PCL 
converter (edit File type).

2. Requiring a gateway such as the fax connector for Exchange (MSX2KGATE), the fax gateway for Notes 
(NOTESCONN), the mail gateway (MAILGW) or the file interface (FILEGW) to process LPD transmission 
jobs. This setting is recommended for sending business documents as E-Mail.

3. Requiring the LPD Gateway to receive transmission jobs on another port and with diverse IP addresses 
(adjust the parameters Port, Interface, Accept messages from).

For the latter scenario, change the parameter in the Network settings box, for the others, edit/add parameters 
in the Printing Queue tab.
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Network Settings

You can edit network settings on the same tab.

 ► Port

By default, the LPD gateway receives data on the preconfigured port 515 (also known as well-known port). 
If applications use either the LPD or LPR for printing jobs, they need to send data through this port as well. 
Please note that this port cannot be altered on Windows during a printer configuration.

 ► Interface

Analogous to applying port settings, the IP address for incoming data streams can be deposited in the 
Interface box. Hence, the LPD favors data streams originating from this IP address. This setup is partic-
ularly helpful where servers accommodate multiple networking cards and routers, as now they won’t be 
overloaded with redundant data streams. With a default setting of 0.0.0.0, the LPD links to every interface 
and all IP addresses, while accepting all transmission jobs from all network segments.

 ► Accept Messages From

Use regular expressions to create a list of IP addresses that can directly communicate with the LPD. Leaving 
the default to (.*) causes the LPD to accept data streams from any IP address.

Printing Queues

The printing queue defines how received data streams to the Messaging Server are processed. It applies to the 
sender who prints these transmission jobs. By default, all transmission jobs are identically treated no matter 
on what printing queue is used to print these.

◊Note! The sender who prints the transmission jobs also manages the printing queues. Leave 
the entry at its default (.*), except you require certain Messaging Server connectors to 
process transmission jobs individually, e.g. faxes via MSX2KGATE and E-Mails via FILEGW. 
As the LPD gateway needs to distinguish the printing queues from one another, one rule 
per printing queue has to be deposited.

 ► Name

Both, regular expressions and common letters can be used to allocate a name to a printing queue. Here 
again, the default value .* means that every printing queue receives and processes transmission jobs equally. 
If, however, multiple rules have been created to ensure a divergent procession of transmission jobs, the 
name can be altered at will.

 ► Connector Component

After having received a transmission job, the LPD gateway routs it directly to a connector component that 
has been configured for the respective printing queue. 
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The connector component analyzes it and checks whether the sender is authorized to transfer documents, 
applies user specific transmission parameter (such as attaching a signature the document) and assures the 
receiver is given a status message. Depending on the installed OfficeMaster license, the following gateway 
components should be used according to their specified environment.

Messaging Server 
Component

By LPD 
Supported Dis-

patch Type

OfficeMaster Gateway

SMTP Notes Exchange Clientgw

Connector for Exchange 
(MSX2KGATE)

Fax - - X

Gateway for Notes  
(NOTESCONN)

Fax and E-Mail - X -

Mail-Gateway (MAILGW) Fax and E-Mail X - -

File interface (FILEGW) Fax and E-Mail Optional Optional Optional Optional

CLIENTGW Fax - - - X

 ► Filetype

The file type that is received by the LPD Gateway and converted by the Messaging Server cannot be selected 
and altered automatically. Thus, it needs to be both, configured and assigned, for every single printing queue. 

OfficeMaster Messaging Server converts file formats such as PCL (Printer Common Language), PDF 
(Portable Document Format), PS (Postscript) and TXT (ASCII texts). For a conversion of PS and TXT into 
an image (for Fax) and PDF (E-Mail), the Messaging Server accommodates converters within Windows. 

◊Note! The PCL converter is only available for the unlimited OfficeMaster version. Customers 
using OfficeMaster 10 or OfficeMaster 25 need to resort to the PS conversion. Considering 
that, download AFPL Ghostscript and install it on the server if you use an OfficeMaster 
Version other than the unlimited version. 

◊Note! At the first instance, the use of an AFPL Ghostscript including its extensive configuration 
effort may appear somewhat debilitating, however, due to the PS conversion, searchable 
PDF documents (for E-Mail!) are created. The PCL converter on the other hand includes 
the printed document as Bitmap into the PDF file.
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2.10.3. Connector for Microsoft Exchange (MSX2KGATE)

The fax connector for Microsoft Exchange (MSX2KGATE) receives LPD transmission jobs. It automatically 
recognizes the received process as LPD transmission job and checks the Active Directory for user specific 
parameters. MSX2KGATE subsequently initiates the document’s dispatch. In order to reliably identify the 
Active Directory user, either the login name received by the LPD Gateway or the fax address (U-parameter) 
incorporated into the control command is used. The system matches the latter with any user fax addresses 
from within the Active Directory. For this instance, multiple fax addresses can be assigned to one Active Di-
rectory user, e.g. one fax address each for receiving and sending plus one fax address for LPD transmission 
jobs assignment.

Image 2.75: Mail addresses of a fax-enabled inbox 

Example 2.23. 

If a document’s control command reads

@@+FAX:<Fax number>@@

then the user whose Exchange fax address corresponds to the received login name (LPD user) gets assigned 
the document.

If, however, the Messaging Server is not capable of using the login name of the LPD user for an automatic user 
assignment, (e.g. due to the printing process being automatically triggered by a server task with the same login 
name), the relevant Active Directory user may enter the following U-parameter into the control command:
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@@+FAX:<Fax number>;U<AD-User-Fax address>@@.

»End  of  examp »

2.10.4. Connector for Notes

Each printing and transmission job that has been forwarded to NOTESCONN is automatically assigned to a 
Notes user within the Name and Address Registry. For a reliable execution, NOTESCONN uses either the name 
of the LPD that had been labeled as sender or the name that was incorporated into the embedded control 
command as U-parameter.

Example 2.24. Without  U-parameter

A user has used his user account EXAMPLE to log in into a computer network. From within the native ERP 
software, he prints an offer using the following control command:

@@+FAX:0123/456789@@

With the user information EXAMPLE populated into the offer, the LPD gateway forwards it as transmission 
job to NOTESCONN. 

Having received the information, NOTESCONN now browses through the name and address registry for a user 
document matching EXAMPLE. Furthermore, it also checks the user specific settings on whether EXAMPLE 
is authorized to send files, which fax CSID is ought to be displayed to the receiver, etc. NOTESCONN finally 
forwards the document as transmission job to the Messaging Server using 0123/456789 while providing the 
sender with a transmission status.

»End  of  examp »

Example 2.25. With U-parameter

A user has used his user account EXAMPLE to log in into a computer network. From within the native ERP 
software, he prints an offer using the following control command:

@@+FAX:0123/456789;UDISTRIBUTION@@

Here again, the LPD gateway receives the offer along with the user information EXAMPLE and forwards it 
as transmission job to NOTESCONN. As the user specific data are stored in DISTRIBUTION, NOTESCONN 
browses for a user document within DISTRIBUTION and subsequently forwards it to the Messaging Server 
using 0123/456789. 

Regardless whether the LPD username receives the control commands from its network login name or the 
U-parameter, this username has to be found within the name and address registry that has been configured 
for NOTESCONN. The ALIAS field is used as reference for the username, given that the NOTESCONN config-
uration possesses no divergent settings.

»End  of  examp »
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2.10.5. SMTP-Connector/Mail-Gateway

Just like the gateway for Notes (NOTESCONN), the Mail gateway equivalently processes LPD transmission jobs. 

Firstly, the LPD sender is used as reference to browse for the corresponding MAILGW user. The dispatcher is 
set to either the dispatch name that has been forwarded to the LPD gateway upon reception of the printing 
job or the dispatch name that has been embedded into the printed document as U-parameter. 

Example 2.26. Without U-parameter

A user has used its user account EXAMPLE to log in into a computer network. From within the native ERP 
software, he prints an offer using the following control command:

@@+FAX:0123/456789@@

The LPD gateway receives the offer along with the user information EXAMPLE and forwards it as transmission 
job to MAILGW. MAILGW subsequently browses through the system for a user with the username EXAMPLE 
and checks user specific files for whether EXAMPLE is authorized to access the signature server stated in 
the control command. Finally, MAILGW forwards the document as transmission job to the Messaging Server 
using 0123/456789 and provides a transmission confirmation to the respective user via E-Mail.

»End  of  examp »

Example 2.27. With U-parameter

A user has used its user account EXAMPLE to log in into a computer network. From within the native ERP 
software, he prints an offer using the following control command:

@@+FAX:0123/456789;UDistribution@@

The LPD gateway receives the offer along with the user information EXAMPLE and forwards it as transmission 
job to MAILGW. In order to find user specific information, MAILGW subsequently browses through the system 
for a user called DISTRIBUTION and, if found, instructs the Messaging Server to commence fax transmission 
to 0123/456789.

In order to assign the process to a user reliably, the Mail gateway either compares the resolved name to that 
deposited to the MAILGW (if user administration is handled on the MAILGW) or utilizes the directory service 
to browse for the respective user name (if user administration is handled via LDAP).

»End  of  examp »
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2.10.6. Sending Files via LPR Command

After successfully installing and configuring the LPD gateway, we recommend testing the functionality without 
the interaction of third party software such as Winword. However, as this is only achievable for files convertible 
by the Messaging Server, create a text file with a few sample sentences and include a simple control command:

Example 2.28. 

@@+FAX:03328/455-960;EFerrari electronic AG@@

This is my first fax via LPD and OfficeMaster Messaging Server.

In order to send this file to the LPD gateway manually, use the command lpr in a Windows environment. 

Image 2.76: lpr command

The fax address needs to be converted into an E-mail address if it is supposed to be delivered to the LPD 
gateway successfully.

@@+FAX:info@ferrari-electronic.de;EFerrari electronic AG@@

@@+PAR:from=sender@ferrari-electronic.de@@

This is my first E-Mail via LPD and OfficeMaster Messaging Server.

»End  of  examp »

◊Note! The Messaging Server component SMTPTX has to be fully configured and started up 
before initially starting a transmission via E-Mail (see chapter 2.2.2 on page 25 for ref-
erence). Furthermore, FILEGW or MAILGW has had to be selected as gateway component 
on the LPD gateway.

- 111 -

Basic Configuration

https://www.ferrari-electronic.com/home.html
https://www.ferrari-electronic.com/home.html


2.10.7. Configuring a Windows Printer for the LPD Gateway

As there are just a few applications that manage to convert files into PCL, PS or TXT, it is recommended to 
configure a windows printer for these tasks. This printer can either be configured individually for the desired 
workstations or centrally on the server. On windows, select Add printer in the devices and printers window and 
chose Add a local printer or network printer with manual settings and confirm by clicking Next.

Image 2.77: Adding a printer as administrator

Image 2.78: Finding a printer
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If run as administrator, you may add a new connection to the selected printer. Note that this connection uses 
the default TCP/IP port, which in turn has to reference the LPD component.

Image 2.79: Adding a new connection that is based on TCP/IP

 ► Hostname or IP-Address

Enter the OfficeMaster server with the correspondent LPD component. We recommend using an IP 
address.

 ► Port Name

The wizard automatically fills this field with the value of the host name. Usually, there is no alteration 
needed.
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Image 2.80: Indicating the desired port

It is important to configure the TCP/IP port recognition, which will be done next.

Image 2.81: Automatically detecting the TCP/IP port
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The installation wizard won’t be able to recognize the printer. Hence the Device Type has to be set to Custom 
and some of the following entries need to be entered manually.

Image 2.82: Adding connection information

Image 2.83: Assigning a name to a printing queue

The Port Name and Printer Name or IP address boxes have already been prefilled, yet the protocol needs to be 
set to LPR, LPR Byte Counting Enabled needs to be checked and a name has to be assigned to a printing queue.
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◊Note! You may choose the name for the printing queue arbitrarily. This can also be used as 
filter for the LPD component. By doing so, settings should correspond to those found 
on Image 2.74: Settings for lpd0 on page 105. Replacing .* with a name would potentially 
equal the desired filter.

Once the installation wizard has concluded, the respective printing driver needs to be installed. You will not 
find the driver in the list of available printing drivers. Hence, click on Windows Update to download it from the 
Internet.

Image 2.84: Finding a driver via Windows Update
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In the following dialogue, select the manufacturer HP and choose HP LaserJet 5 if you require the LPD to send 
the PCL code. If you require the printing to be executed as PS code, we recommend selecting HP LaserJet 
2300LPS.

Image 2.85: Selecting HP LaserJet 5 for PCL printing

The subsequent dialogs requests the name of the printer, its location and the intended use.

Image 2.86: Assigning an expressive printer name
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2.10.8. ERP System

In order to send documents from the ERP system automatically, a LPD/IP printer needs to be configured. It 
may become necessary to synchronize the newly configured LPD printer with the ERP system (Fax and E-Mail).

Some ERP systems already possess fax interfaces for connecting printer drivers; these enrich the printing 
data stream with the required transmission information without having to adjust any forms. Classic Line by 
Sage KHK allows a configuration directly on the fax interface for syntaxes for embedded commands and its 
appropriate font (Courier 10). 

If ,however, the ERP system does not offer any implemented fax interfaces, these control commands need to 
be populated to the document via form adjustments. The same applies to the automatic document transmis-
sion via E-Mail attachment, although most ERP systems utilise alternative ways other than the print interface:

The following two examples demonstrate the most commonly used control commands:

Example 2.29. Sending documents via fax

@@+FAX:030/456789;UExample;Z2017-05-11-22:00@@

@@+PCX:letter.pcx@@

@@+PAR:sign=signdsFax@@

Dear Sir or Madam,

On 11th May 2017 at 22:00 hrs, this document will be sent automatically to the fax number 030/456789 and the 
respective connector will assign it to the user Example. Prior dispatch, the stationery letter.pcx saved on the 
Messaging Server will be added to the document and signed with the signature component signdsFax. …

»End  of  examp »

Example 2.30. Sending documents via E-Mail

@@+FAX:info@officemaster.de;UExample@@

@@+PCX:letter.pcx@@

@@+PAR:sign=signdsEmail@@

@@+PAR:from=Example@ferrari-electronic.de;subject=Your document@@

@@+PAR:cover=mail.htm;salutation=Dear Sir or Madam@@

Dear Sir or Madam,

This document will be sent to the address info@officemaster.de as PDF E-Mail attachment where it will be sub-
sequently assigned to the user Example. Prior dispatch, the stationery letter.pcx saved on the Messaging Server 
will be added to the document and signed with the signature component signdsEmail. The subject and address 
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of sender will be prefilled with “Your document” and Example@ferrari-electronic respectively. After switching the 
placeholder @@salutation@@ with “Dear Sir or Madam”, the body of the mail will be extracted from the mail.
html file. …

»End  of  examp »

2.10.9. File Interface (FILEGW)

The file interface (FILEGW) instantly creates a transmission job for any documents received via the LPD and 
conveys it without a further check. As with any other transmission jobs, the FILEGW saves the conveyed docu-
ment to the IN registry while creating an expressive file within the ACK registry. Any third party software linked 
via FILEGW can therefore instruct the OfficeMaster Messaging Server to handle transmission jobs. Regardless 
on the kind of instruction used, the conveyance of the status messages remains unaltered.
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2.11. Basic/ Extended System Settings

2.11.1. General Settings

Select Tools > System Settings... to access and edit general settings for the OfficeMaster Suite. These settings 
apply to all components equally. 

Image 2.87: General system settings

 ► Language

Set the system language here. You may choose between German, English, Italian, French and Spanish.

 ► Transmission

 ► Keep Send/Receive Protocols for the Last

Leave the value at its default (0) if you intend to have new protocols generated daily. These will not be 
deleted at any point. However, if you want to have them deleted after a given time, enter the respective 
value here (in days).

 ► Enable Fallback Processing

The Messaging Server processes jobs by applying predefined routing rules. Every send and reception 
component registers for a certain type of job. If you activate this checkbox, a fallback process will be 
initiated for repeated transmission errors. The fallback dictates that the transmission job has to be 
reassigned to another component that essentially registered for a fallback. Having a fully-functioning  
fallback process adds a great deal of redundancy to the system.
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 ► Continue Aborted fax Messages

OfficeMaster Suite version 6.2. provides a functionality that continues to transmit aborted outbound 
fax messages if DirectSIP (fsip) is used. Repeating fax transmission that has been configured are left 
unaltered.

 ► Minimum Free Hard Disk Space

The OfficeMaster Suite will not accept any messages once the minimum hard disk capacity has been 
reached. Hence, a failed saving of the message due to a lack of hard disk space can be prevented. Enter 
the value in Megabytes.

 ► SMS

Control how short messages (SMS) are treated by the Messaging Server. If they exceed 160 characters, 
they may be split into individual messages.

Furthermore, short messages can be given a higher priority than fax messages.

 ► Change Password

Create and/or change a password for the OfficeMaster Suite. Once closed, access to the OfficeMaster Suite 
Configuration Program can only be granted if you provide the correct password.

Image 2.88: Entering the password for the configuration program

2.11.2. Undeliverable Status Messages (UNDLVRBL)

The component Undeliverable receives incoming messages (Fax, SMS and E-Mail) that cannot be assigned to 
a particular gateway within the Messaging Server. It holds four different modes on how to treat undeliverable 
messages (inbound):

• Deposit mode: The incoming message is saved to a registry located on the server

• Print mode (Fax only): The incoming message is deposited before being printed via a PRINTGW component

• Forwarding mode: The incoming message is forwarded to an alternative address of the same type (within 
the Messaging Server)

• Notification mode: The incoming message is routed to an arbitrary E-Mail recipient via SMTP who can be 
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either internal or external

Access the configuration menu for Undeliverable by selecting Edit > Further Base Components > Undeliverable 
Messages... .

 ► General

Parameter for the modes outlined above can be configured in this tab.

Image 2.89: Configuration for undeliverable messages

 ► Dump Directory

Undeliverable messages (Fax, SMS, E-Mail) are collected in the Dump directory. The default path on a 
Windows machine is %ProgrammeData%\FFUMS\FMSRV\work\undeliverable\dump.

 ► Sender Mail Address

The E-Mail address entered here receives forwarded status messages.

 ► Wait for DSN (h)

The value that is entered here defines how long the UNDLVRBL component waits for DSN (Delivery 
Status Notification) before deleting the undeliverable message. Note that the amount is set to hours.

For the sake of an unobstructed reception of DSN, the Messaging Server has to be accessible externally 
from the previously configured E-Mail address. Each mode can be assigned to messaging types (Fax, 
SMS, E-Mail) individually.

 ► Fax

 ► Dump

This is the default mode for UNDLVRBL immediately after installation. All undeliverable messages re-
ceived by the Messaging Server are stored to the dump directory that had been configured in the General 
tab. Messages where the forwarding or notification processes failed are also stored to that directory. 
For every undeliverable message, the Messaging Server generates two files: 

• a job file that accommodates job information, e.g. file name and document name (recognizable by 
the .FMJ ending)
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• a document file that accommodates the actual message.

As the Messaging Server does not process the files within the dump directory, they remain unaltered 
until being deleted by a network administrator.

 ► Print

This mode is available for faxes only. Here, a configured PRINTGW has to be selected which ultimately receives 
the forwarded document.

Image 2.90: PRINTGW component  for fax prints

 ► Forward

Selecting the Forward mode causes the Messaging Server to forward the undeliverable message to 
a new address of the same type (within the Messaging Server environment). The sender information 
remains unaltered.

An internal forwarding address of the same type (Fax for Fax, E-Mail for E-Mail) has to be deposited and, 
again, messages that are still undeliverable are stored to the dump directory.

Example 2.31. 

A fax from +49123456 is received on the number 999. As no connector has been assigned to this number, 
the Messaging Server forwards it to UNDLVRBL where a forwarding process to the internal fax address 
960 has been configured, affecting all undeliverable fax messages. Consequently, UNDLVRBL generates 
a new fax notification message to the forwarding number 960. However, the sender information remains 
unaltered at +491234546. The process can now be assigned to a connector that is configured for the 
number 960, e.g. NOTESCONN, SAPCONN or MSX2KGATE.

»End  of  examp »

 ► Notify

If undeliverable inbound messages are intended for E-Mail dispatch, we recommend selecting Notify. 
However, this also requires the operation of the Messaging Server components SMTPTX (for notification 
mails) and SMTPRX (for incoming status mails). 
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Furthermore, an origin mail address needs to be entered into the General tab. UNDLVRBL uses this mail 
address and essentially displays it for every E-Mail notification (use e.g. undeliverable@officemaster.
company.com). An external access to this mail address is a prerequisite as the UNDLVRBL component 
needs to be notified on any failed delivery attempts.

Both, an internal and external mail address that are used to receive undeliverable-notifications have to 
be entered to Notify Address. You may opt for .TIF or .PDF as file formats for the fax attachment.

Image 2.91: Notification address receiving undeliverable messages

If, due to a missing SMTPTX configuration the notification message fails to send, or the Messaging 
Server receives an undeliverable message (DSN), the original message is saved to the dump directory. 
Otherwise, this message will be deleted once the latency time that has been configured in the General 
tab has run up.

Example 2.32. 

The counterpart station +49 123 456 receives a fax on 999. As this number has not been assigned to a gateway, 
the job is forwarded to UNDLVRBL. Because a forwarding process to the notify address postmaster@company.de 
has been configured for UNDLVRBL, the component sends it to that address. Upon transmission, the configured 
origin address undeliverable@officemaster.company.de is communicated, yielding in an accurate evaluation of 
notification mails (DNS) and a faultless reception.

»End  of  examp »
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2.11.3. Redialling and Transmission Control (SPLIT)

To adjust the configuration on how faulty transmission processes are handled, select Tools > System Settings… 
and select the Error Processing tab. This tab contains the central transmission control for error occurrences in 
ISDN- and fax protocols. Redial attempts and the idle time in-between can be configured for the error codes 
individually.

Image 2.92: Configuration for faulty transmission jobs

2.11.4. Fax Request (POLL)

The POLL component of the Messaging Server provides the fax polling service. Please note that only one POLL 
component per Messaging Server system can be configured.
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Configuration

In Expert Mode, select Edit > Further Base Components > Fax Polling… for configuration.

Image 2.93: POLL component for fax requests

 ► Document Directory

In this box, configure the fax-polling directory that contains documents ready for fetching. Distinguishing 
between a fax polling number and file is determined using the file name. If the remote station signals 
its intent for an imminent file request, the file that corresponds to the received extension number is 
transmitted. 

 ► Default File

The file that is deposited here is transmitted to the counterpart station whenever no (transmissible) 
document for the received calling number (Called Party Number) is available in the fax-polling directory.

Supported Graphic Formats

The following file formats can be supplied as originals: BFF, DCX, PCX, SFF, TXT.

For a swift assistance in generating these file formats, refer to the ferrariFAX32 operation software that comes 
along with OfficeMaster.

Example 2.33. 

Supposing the original document is a Microsoft Word file named request.doc, which is about to be fetched as 
4711.dcx from the polling server. The processing order would be as followed: Microsoft Word starts up, opens 
the file request.doc and sets the printer to ferrariFAX32 operation software. Once the printing job has been 
triggered, the ferrariFAX: Recipient dialogue pops up. In the Options tab, click on Preview. The document will 
then be converted to fax for preview purposes. Select File > Save as… to open the savings menu where the 
path for the fax-polling directory can be chosen. For file type, select DCX and type 4711.dcx into the file name 
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box. Confirm the changes by clicking OK. The document is then saved to the fax-polling directory under the 
file name 4711.dcx. Conclude the setup by closing the pop-up window and selecting Cancel in the ferrariFAX: 
Recipient window.

»End  of  examp »

Alternative Formats and Compiled Documents

DOC, PDF, PPT and XLS documents may also be used for fax-polling as long as the converter component 
(CONV) has access to a converter software on the server (e.g. Microsoft Word). Furthermore, the use of 
compiled documents eases the polling process immensely as multiple documents can be fetched with one 
connection build-up only. For that, an ASCII file is generated that includes a consecutive list of document names:

• Document1.doc

• Document2.xls

• Document3.dcx

• Pricelist.pdf

This ASCII file is named 4711.par and saved to the fax-polling directory. Therefore, if the caller dials the calling 
number 4711, all four documents are transmitted.

◊Note! If these documents cannot be found in the fax-polling directory but in any other direc-
tories on the computer, make sure to deposit the respective file name and file path to 
the PAR file.

Using the fax Server and fax-Polling Server on Separate Computers

If you wish to allocate the fax-polling directory to any other computer but the main server, run the POLL com-
ponent as offset installation on the intended machine. 

For that purpose, run the OfficeMaster Suite setup and select Sub Server as installation type.

The setup will request the IP address or the resolved name of the main server (CTRL). Once the setup process 
has concluded, run the Messaging Server Configuration and, under Edit > Component table, change the IP 
address for the POLL component. With the Expert Mode enabled, select the Host entry and replace the main 
server IP address with the sub server IP address (offset system).
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2.12. SNMP
The Simple Network Management Protocol (SNMP) has been supported since the release of OfficeMaster Suite 
version 4.1. This network protocol serves as prime surveillance of network elements.

To enable SNMP on the OfficeMaster Suite server, the Messaging Server had to be linked to the runtime en-
vironment of the Windows SNMP service.

Launch the OfficeMaster service before the Windows SNMP service, otherwise a faulty incorporation of the 
OfficeMaster SNMP library may result. Thus, we recommend setting the Windows SNMP service to a delayed 
start. 

◊Note! Once the OfficeMaster software has been set up successfully, restart the Windows SNMP 
service. This will potentially yield in a faultless integration of the Messaging Server’s 
SNMP Extension Agent.

If you purposely constrain using OfficeMaster for receiving SNMP messages, use regular expressions that 
essentially filter out these kind of messages. Please refer to the filter section page 130 for further reference.

You may voluntarily use a network management program to observe the OfficeMaster software via SNMP.

Image 2.94:  FSNMP in relation to the OfficeMaster Suite (FMSRV)

Port Release

The SNMP agent addresses the following ports:

• 3216 outbound- for communicating with the Messaging Server controller

• 3214 inbound and outbound- for receiving error notifications from the Messaging Server

• 161 inbound and outbound and 162- used by the SNMP service itself for transmitting Traps.
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2.12.1. Installing the SNMP service

Windows Features is used to add the Windows SNMP service to the OfficeMaster Suite server. Firstly, the re-
spective SNMP service has to be selected from the SNMP Services submenu. The feature SNMP WMI is not 
a prerequisite for this process. Clicking on Next will commence the installation.

Image 2.95: Adding SNMP as feature

2.12.2. Configuring the SNMP Service

For the configuration of an SNMP service, the service management that is native to Windows will be used. Two 
tabs, namely Traps and Security can be found in the settings window of the selected SNMP service.

 ► Traps

Here, at least one community name and one target needs to be specified for the Traps.

Example 2.34. Possible entry: Community name: public; Trap destination: 127.0.0.1

Image 2.96: Configuring Traps

»End  of  examp »
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 ► Security

Here, the management of user rights for a community name can be undertaken. This segment also regu-
lates the reception of SNMP packages for various computers.

Image 2.97: Configuring security settings for the SNMP service

Example 2.35. 

Possible Entry: Community: public ; Rights: READ WRITE ;  
Accept SNMP packets from these hosts: localhost

Reassure yourself that the IP address of the computer where the network management program is located at 
is listed, if such program is made use of. If not, the network management program will not possess sufficient 
rights to transmit a SNMP command (such as GET, SET or WALK).

»End  of  examp »

◊Note! For an unhampered communication between the Windows SNMP service and OfficeMaster 
Suite Server, Port No. 3214 has to be enabled!

2.12.3. Filtering Transmitted Messages (Traps)

Currently, no separate error class for transmittable Traps has been implemented into OfficeMaster. Thus, all 
errors are forwarded by default. 

Typically, it is not necessary that every single Messaging Server error is routed as Trap to the SNMP management 
system. Hence, we recommend using regular expressions to establish a filter for unwanted error messages. 
Use the set of rules (regex.txt) for this purpose, which is located in the ProgramData folder (C:\ProgramData\
FFUMS\fmsrv\data\snmp). The file contains a default configuration along with instructive examples.
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2.12.4. Management Information Base

Use the Ferrari electronic Management Information Base (MIB) for assessing within a network management 
programme. You will find the MIB at C:\ProgramData\FFUMS\fmsrv\data\snmp\ferrari-electronic-mib.mib

Ferrari electronic‘s MIB accommodates all the necessary information to monitor both the OfficeMaster Suite 
and OfficeMaster Gate via a network management programme.

◊Note! You may also obtain the MIB from an OfficeMaster Gate.

Table 2.11: Ferrari electronic Management Information Base (MIB)

Name OID Type Description

Common .1.3.6.1.4.1.17524.1 folder

Productname .1.3.6.1.4.1.17524.1.1 String Product name

Location .1.3.6.1.4.1.17524.1.2 String Computer name

SoftwareVersion .1.3.6.1.4.1.17524.3 String OfficerMaster Messaging Server version No.

UtilityVersion .1.3.6.1.4.1.17524.1.4 String Applies to hardware (OfficeMaster Gate)

ModulVersion .1.3.6.1.4.1.17524.1.5 String Applies to hardware

TrapMessage .1.3.6.1.4.1.17524.1.6 String Message for Trap

Software .1.3.6.1.4.1.17524.4 Folder

fmsrv .1.3.6.1.4.1.17524.4.1 Folder

fmsrvJobCount .1.3.6.1.4.1.17524.4.1.1 Integer Volume of jobs since start-up

fmsrvComponents .1.3.6.1.4.1.17524.4.1.2 Folder

fmsrvComponentsUndev .1.3.6.1.4.1.17524.4.1.2.1 String To be defined

fmsrvJobCountCurrent .1.3.6.1.4.1.17524.4.1.3 Integer Volume of current jobs

◊Editorial note: This document is has been created for administrators. If you have any enquiries concerning 
this manual, please don‘t hesitate contacting the Ferrari electronic Product Management 
team at pmc@ferrari-electronic.de. For enquiries on products offered by Ferrari electronic, 
mail to info@ferrari-electronic.de or call +49 3328 455 90.
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3. Connector for Microsoft 
Exchange®
OfficeMaster supports the integration of Microsoft Exchange Server 2007, 2010, 2013 and 2016. It comes in 
form of a connector for all communication services (Fax, SMS and voicemail). The connector itself can be 
run on all server that are a member of the Exchange organization; the only prerequisite is that these servers 
possess an Exchange administration tool. OfficeMaster can be installed onto an Exchange server directly; 
however, we do not recommend doing it due to the increase of maintenance work.

The Exchange connector utilizes the Active Directory Service Interface (ADSI) to access user data stored to 
the Active Directory. User-relevant parameter such as Fax CSID, SMS number extension and Voice-PIN are 
maintained by the OfficeMaster Exchange administration. For that reason, respectively labelled input fields 
are provided to avoid the surplus effort of extending the Active Directory scheme for running OfficeMaster.

For server communication, the Exchange connector employs the Simple Mail Transfer Protocol (SMTP) and 
Exchange Web Services (EWS) protocol. 

Table 3.1: Communication protocols

Communcation 
Protocols E-Mail Voice

SMTP Deliver and dispatch Deliver

EWS Encode and decode
Remote request (Accessing the respective user 
inbox)

◊Note! As both the Active Directory as well as the Exchange server grant access via LDAP/EWS 
only if certain authorization requirements are met, we recommend putting great care 
and attention when setting up the service account for the connector.

3.1. Connectors for Microsoft Exchange 2007-
2016

◊Note! The following chapter addresses the technical implementation to Microsoft Exchange 
2007- 2016 and to the existent Active Directory. The content of this chapter has been 
created for advanced IT administrators that want to enhance their knowledge about the 
functionality of OfficeMaster connectors. Because of that, this chapter contains details 
about the basic technique of the OfficeMaster connectors. However, this knowledge 
might not necessarily be needed for setup and initial start-up of this solution.

Although the OfficeMaster Exchange Connector is a Messaging Server component itself, it integrates deeply 
into the structure of the Exchange server and the Microsoft Active Directory. A scheme extension of the latter 
is not needed.
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A full Unified Messaging linking consists of the components depicted in Image 3.1:

Image 3.1: Base technology utilized by the OfficeMaster Exchange connectors

The image includes a combined Exchange server for the sake of easy understanding. It essentially equals an 
Exchange Server 2016 with installed hub server, inbox storage and a client-access role. 

Transfer Flow of Messages

1. Sending Messages From Outlook

Once a message has been sent, the Exchange server transfers it to the Messaging Server via SMTP.

2. Receiving the Message From the Microsoft Exchange Server

The Messaging Server forwards the message to the connector component.

3. Processing Message Data

The respective connector component processes data provided by the Exchange server. 
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The processing encompasses:

• Resolving the sender in the Active Directory with ADSI requests 

• Editing data by using the access permissions of the relevant user / global

• Generating a fax transmission job and forwarding it to the Messaging Server

4. Faxing the Document

The Messaging Server receives the transmission job and sends the message as fax.

5. Receiving Feedback Whether or not the fax Document has been Transmitted Successfully

The Messaging Server discloses the transmission status of the current transmission job to the connector.

6. Generating a Feedback

As mentioned above, the connector component receives the transmission status, which is then configured 
in the user specific way.

7. Forwarding the Feedback to the User

The Exchange server receives feedbacks via SMTP. As the Exchange connector processes messages 
using the Microsoft Active Directory as well as the global user directory, it must have access to the user 
permission structure.

Versatile Setup

Because of the advanced connection technology and SMTP, the complete connector organization may also be 
installed on an external computer that is connected to the Exchange server and the network. Hence, it provides 
a good deal of flexibility as no physical installation on the Exchange server is required and can be used in a clus-
ter scheme (the OfficeMaster Exchange connector is not based on Transport Agents or Foreign Connectors).

Configuration Without Scheme Extension

All configuration settings for the individual connectors are stored to the Microsoft Active Directory. This setup 
requires no scheme extension and uses existent attributes. The configuration attributes of the connector are 
saved in a compressed format. To obtain a domain wide distribution, global settings need to be installed to 
one central node. This creates a full autonomy for domains within.

◊Note! Accessing data from an Active Directory stored within this setup requires reading rights 
to the Exchange organization.
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3.2. Setup
OfficeMaster supports the following operation systems:

• Microsoft Windows 7/ 8/ 10

• Microsoft Windows Server 2016

• Microsoft Windows Server 2012 R2

• Microsoft Windows Server 2008 R2

◊Note! Microsoft Windows/NT, Microsoft Windows 2000/2003 Professional Server or Advanced 
Server are not supported.

The following Exchange server versions are supported (need to be part of the network)

• Microsoft Exchange Server 2007 (all versions)

• Microsoft Exchange Server 2010 (all versions)

• Microsoft Exchange Server 2013

• Microsoft Exchange Server 2016

◊Note! Exchange server versions below Exchange Server 2007 are no longer supported.

3.2.1. Components for Administration

We recommend installing the Exchange system administration tools on the server. By doing so, you will be able 
to administrate the connectors after installation. The installation integrates itself into the user administration 
Active Directory User and computer as well as into the Exchange administration console for Exchange Server 
2013/2016.

Should you require the use of the recipient update service for fax and SMS addresses (not recommended!), 
ensure the directory approval bearing the name Address of Exchange servers within the organization are 
accessible. 

◊Note! Should this not be possible due to insufficient access rights, please execute a proxy 
extension installation on the respective exchange servers instead.
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The central conversion software (Microsoft Office, ghostscript etc.) should be linked to the same service account 
that has been set for the CONV component. The connector administration is carried out in the OfficeMaster 
Exchange Administration program.

Please note that the OfficeMaster Exchange Administration tools will only become visible once the administration 
components of the respective connectors has been installed successfully. The setup installs these components 
to the server by default. Should you feel the need to administrate from a different computer, you will need to 
install these components manually.

The following two installation components are stored to the Messaging Server directory \\<server compo-
nent>\FFACCESS\REDIST\Install:

• Setup-OfficeMaster-Exchange-Administration64.exe used to install the administration tool on Windows 
operation systems that are based on a x64 processor.

• Setup-OfficeMaster-Exchange-Administration.exe used to install the administration tool on Windows op-
eration systems that are based on a i386 processor.

OfficeMaster provides so-called proxy description objects during setup that fit the relevant address types. 
Hence, organization-wide recipient updates (previously known as Recipient Update Services-RUS) can be 
supported. These proxy description objects have to be existent on any Exchange server that is part of the 
organization. However, we do not recommend using the proxy description objects anymore.

3.2.2. Creating the Service Account

The service account for the OfficeMaster Connector is identical to the login account of the msx2kgate com-
ponent. This service account needs to be run with a dedicated service account.

In order to install the Exchange connector successfully, you need to be logged in into a service account that 
should possess the following properties:

• Domain administrator or authenticated user with relevant domain rights

• Exchange organization administrator (for the entire organization)

◊Note! You may use the setup account to create the service account. However, please bear 
in mind that both accounts need to possess different authorization levels, thus 
the setup account and the service account must be two individual accounts (!).

Creating the Service Account that is Used for Running the Exchange Connector

• Create a user via the user administration or Exchange 2013/2016 system administration console. This user 
needs to be a member of the domain user group and possess a dedicated inbox.

• The inbox needs to be visible and accessible within the global address list.

◊Caution! The service account’s mailbox and / or the transfer mailbox will be accessed by the 
connector component. The mailbox content may be processed. To prevent loss of any 
important user specific mailbox content, please do not use an existing personal user 
mailbox for this purpose.
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• The account receives full reading permission for the entire Exchange organization (see Table 3.2)

• The account is added to the group of local administrators on the computer the setup is running on.

◊Note! The use of voicemail presupposes that the service account deposited for the Exchange 
connector possesses writing permissions for the user object and thus may execute a 
PIN change via remote request.

Table 3.2: Setting reading permissions for the Exchange organization

Exchange 2007 Exchange 2010 Exchange 2013 Exchange 2016

Must be a member of the 
Exchange View-Only administ-
rators group

Must be a member of the 
Public Folder Management 
group

Must be a member of the 
Public Folder Management 
group

Must be a member of the 
Public Folder Management 
group

◊Note! A domain controller possesses no local administrators. Add the service account to the 
group of administrators if the OfficeMaster Exchange connector is to be installed on a 
domain controller.

◊Note! Domain administrators cannot be edited via remote request even if the service account 
carries sufficient rights to edit user-specific values (writing permission of the respective 
Active Directory attribute). This behavior is a common one and is a result of the fact that 
the administration attributes are secured by the ADminSDHolder services. However, the 
service account is an authenticated user that lacks the rights to edit these attributes.

Creating access rights to access the inbox storage of the user: 

• No specific permissions are required for the use of fax and SMS. 

• It is crucial that the service account possesses sufficient access rights to execute a remote request to the 
relevant voice boxes using the Exchange connector. Please enter the respective command listed in Table 
3.3 into the Exchange administration shell.

Table 3.3: Setting permissions to access the inboxes

Exchange 2007/2010 Exchange 2013/2016

add-adpermission „Datenbank“ 
-user „Domain\Account“ -access-
rights GenericAll

new managementRoleAssignment 
„OfficeMasterVoiceAccess“-user „Domain\
Account“-Role ApplicationImpersonation

The connector can be added using the Messaging Server configuration.

◊Note! If the account shall be used for the conversion component CONV, execute a local login 
on the setup computer and run the conversion software (Microsoft Office, Adobe Acrobat 
Reader) manually. This process is needed to confirm/close configuration dialogs and 
complete online updates. We recommend oppressing automatic updates on the Adobe 
Acrobat Reader as pop up windows would disrupt the workflow.
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◊Note! Please refrain from installing Microsoft Outlook on the setup computer. The outlook 
client is not needed for running the connector and its existence has often resulted in 
incompatibility issues with the MAPI client component used by the connector. This 
greatly hinders the productive operation of the msx2kgate component and also affects 
the CONV connector itself, even if MAPI is not used for communication.

3.2.3. Installing the OfficeMaster Exchange Connector

The OfficeMaster Connector for Microsoft Exchange is part of the full OfficeMaster Suite setup. Once the 
OfficeMaster Suite setup has been successfully concluded, the connector itself is ready for installation and 
configuration.

◊Note! The Connector for Microsoft Exchange utilizes the service account outlined in the pre-
vious chapter 3.2.2 on page 138. Thus, it ought to exist by now.

Once the full installation of OfficeMaster Suite has been fully completed, you will see a folder called Exchange 
in the quick launch bar. Extend it and double-click on On-Premises to open the configuration window. Here,  
all connectors that have already been installed are shown. If no connectors have yet been installed,all boxes 
are greyed out, identical to Image 3.22.

Image 3.2: Creating an msx2kgate component

To add a connector entity for all communication services, click on Create Component. This will initiate the instal-
lation wizard (Image 3.3). We highly recommend using this wizard for both adding and deleting a component.
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Image 3.3: Welcome dialog

◊Note! You may also utilize this wizard to delete connector versions 3.1. and 3.0. .In case you wish 
to delete a connector version 2.0, use the common uninstall routine in the control panel. 

After clicking Next, the installation wizard requests the Exchange Server (local bridgehead), which is used for 
bidirectional communication to the Exchange connector. The server essentially sends E-Mails to the Exchange 
connector and receives inbound documents and feedbacks. In case you are using Exchange Server 2013/2016, 
versions, ensure you are selecting a hub server (see Image 3.4).

Image 3.4: Selecting the Exchange server

After confirming the Exchange server, determine setup parameter in the next window (see Image 3.5).
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Image 3.5: Setup parameter

 ► Messaging Server

Use the dropdown list in the Messaging Server input field to select a server that will essentially run the 
msx2kgate connector component. The main Messaging Server is usually pre-set by default. If your server 
is not featured due to a fragmentary access of certain sub servers, you may freely enter a different server 
manually.

 ► Exchange Server

This is the server that had been selected in the previous step. The entry in this input field cannot be edit-
ed here. Should you require to edit it, use the One Step Back ( )arrow on the upper left hand side.

 ► Create Receive Connector

A special receive connector can be created if an Exchange 2007 - 2016 hub server has been chosen. As 
there must be no overlay of data on an Exchange server, it will get a different port assignment than the 
default receive connector of the hub server. The suggested port may be edited individually. We recommend 
utilizing this option.

Receive Connector (Exchange 2007-2016 hub server)

Microsoft Exchange 2007-2016 hub servers possess respective connectors by default. However, they have 
mainly been designed for client /inter site transportations and cannot accept anonymous authentications. 
Either the security settings need to be edited (by deselecting the Create Receive Connector box) or the 
anonymous authentication need to be enabled to allow communication to a connector. Both options are 
sensitive interferences. To avoid resorting to them, create the receive connector that solely enables com-
munication to the Messaging Server. The installation wizard configures this connector with the following 
configuration:

• Name: Connector for UMS (ExchangeServer- MessagingServer)

• Using just the stated port for reception
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• Using no anonymous authentication

• Activating NTLM authentication

• Activating the service account exclusively for the connector

• Granting communication only via the IP address of the Messaging Server

Send Connector

A SMTP transmission connector (= Send Connector) is created automatically in addition to the receive 
connector. It bears the following configuration:

• Name: Connector for UMS (Exchange Server - Messaging Server)

• SMTP port 25

• Activating no outbound authentication

• Setting the selected Exchange server as the transmission server (Local bridgehead)

• Setting the selected Messaging Server that employs the connector component as reception server (Smart 
host)

The connectors that had just been created should be ready for use immediately. Administrators may adjust 
these connectors according to their demand.

◊Note! Please avoid renaming the connectors as the installation wizard utilizes their name as 
criteria for both installation and removal.

 ► Template Directory

The global directory refers to a directory approval of the Messaging server installation. Every Messaging 
Server from version 3.0, where the OfficeMaster for Exchange server Option has been chosen, consists 
of a directory approval called FFACCESS. The template directory forms the basis of all administration 
SnapIns and connectors. You may alternatively create a template directory on a file server. If you do, please 
ensure this directory has the same directory layout. Furthermore, be aware that this entry may be altered 
by another installation. The template directory consists of the following content: 

Table 3.4: Template Directory on the MessagingServer

Directory Content

Cover
Cover pages in Rich- Text- Format (RTF) and HTL template files;  
may be deposited by both administrators and users.

Sign
Signature files in Rich- Text- Format (RTF);  
may be deposited by both administrators and users.

Letter
DCX image files (multi-page PCX) that are blended into fax documents;  
may be deposited by both administrators and users.

Picture
Image files in Portable Network Graphics (PNG) format. These images may be distributed to various 
users and appear in voice messages. They should not exceed 160 pixel (width) x 180 pixel (height); may 
be deposited by both administrators and users
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 ► License Group

This input field contains the license group where all licensed users need to be deposited. It is commonly 
used for the user-limited versions (OfficeMaster Suite for 10, 25 or 250 users) and is created within the 
container Users by default. The license group itself is labeled OfficeMaster License Group. This input field 
is not editable.

◊Note! Please do not shift the location of the license group after installation as its respective 
reference cannot shift. Should you require a shift of the location nonetheless, please 
reinstall the connector and edit the license group manually.

 ► Service Account

Please use this input field to enter the service account for msx2kgate (see previous chapter Chapter 3.2.2 
on page 138 ). This account will essentially receive the necessary authorization to access the connector.

◊Note! Beware that upon entering the wrong service account, there is no solution to correcting 
the error other than reinstalling the connector.

 ► Global Settings

 ► Create the Basic Settings Data Object Globally (recommended)

If this option is selected, global user settings will become templates for all users who are not being 
administrated directly. These settings are saved to a central object, which is replicated centrally and 
provided to the whole organization. It is the default setting for organizations with just one administrative 
group or routing group.

 ► Create the Basic Settings Data Object in Local Domain Context

In larger organizations, the respective service account or installation account may not possess the re-
quired rights to save the global settings for the whole organization, even if the reading and access rights 
have been maxed out. In this case, you may choose this option, which essentially causes all settings to 
be stored to the current domain object. All remaining office locations should choose this option as well 
during installation.

◊Note! Once set, avoid switching between the two options. Furthermore, we recommend employ-
ing the same Basic Data Object storage procedure for all future installations. Otherwise 
the object would be installed twice, which could only be fixed by deleting and reinstalling 
the component. In case a Basic Data Object has been installed globally as well as in a 
domain context, the settings of the latter will be favored and applied.

Next, the connector will be installed and initialized (see Image 3.6). Here, all configured options and the con-
nector itself are being incorporated into the Active Directory. This window will inform you of any issues during 
installation. Thus, should the log in account lack of any privileges needed for installation, you are being informed. 
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Image 3.6: Connector initialization

◊Note! During installation, a new folder called FerrariLogFiles will be created for the purpose of 
simplifying support, if requested. It will contain the log file finstallhelp.log which is con-
stantly enriched with information about installation and removal processes.

As various Messaging Server components (such as  mailgw and sapcon) utilize the same interface as the 
SMTP reception component (smtprx), we suggest creating just this SMTP component which then forwards 
the messages. 

◊Note! In case the setup is run on the Exchange server itself, avoid using port 25 for transmission, 
as the transmission connector (Connector for UMS) would then deliver messages to its 
own reception connector. To avoid changing IP addresses, use a different port (such 
as port 10026) instead. The installation wizard generally detects these sort of issues 
automatically and applies the relevant counteractions. However, you may adjust the 
configuration with administration SnapIns.

Distributing Proxy Address Generators (not Recommended!)

In the further setup process, a dialog for distributing proxy address generators will show up. Proxy address 
generators are used for supporting the organization-wide reception update service. Install this component 
manually to all servers with limited setup authorization. Use the Deselect All button if this process has been 
carried out in a previous setup. Clicking Proxy Install will initiate the setup. Clicking Next will guide you to the 
next setup step. Use the server list to reassure the distribution of all proxy address generators has been car-
ried out successfully.
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Image 3.7: Distributing proxy address generators

Connectors use fax and SMS addresses as originator authentication and therefore process outbound jobs 
effectively. You may create both addresses here, if needed.

◊Note! The setup will not create any recipient guidelines, as they do not support a useful gen-
eration of fax, SMS or voice addresses. Furthermore, the implementation and usage of 
these recipient guidelines is not recommended. Fax, SMS and voice addresses should 
always be generated manually or via script.

Find the Connector for UMS component in the component status window (see Image 3.8). Notice that the 
component itself is not running yet. Use the respective Exchange system administration tools to start it.

◊Note! Please check whether the connector component msx2kgate and the SMTP reception 
component smtprx are both running. Should they not be running, please start them up 
manually. Errors are often caused by the SMTP windows service, which needs to be 
either deactivated or reassigned to a different port or IP address.
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Image 3.8: The new msx2kgate component

3.2.4. Installing Multiple Connectors Within the Same  

Organization

Repeat the setup process that has been described in the previous chapter (Chapter 3.2.3 on page 140) if you 
endeavor to run multiple connectors and Exchange servers within a single organization. 

Only a single connector can be installed to one Exchange server on a component server. However, multiple 
connectors can be installed to different Exchange servers on one component server.

Example 3.1. 

Two connectors are installed on one component server without issue because they address different Exchange 
servers.

»End  of  examp »
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3.2.5. Updating Connectors (Reinstallation)

Existent OfficeMaster Exchange connectors are being updated and repaired if the exact same connector 
type is installed again. Please note that this only applies if the same Exchange server is addressed. The setup 
also updates missing parameters but leaves all settings unaltered. Should you carry out this step for the sole 
purpose of repairing, you may freely edit the OfficeMaster License Group or the service account.

As outlined above, configuration settings are mainly left unaltered. It may merely correct server specific data 
such as the template directory. However, before doing so, it will ask for your confirmation.

Image 3.9: Changing the mutual reference directory

Once the directory has been correctly deposited during an earlier setup, there is no need to overwrite the 
entries. Hence, continue by selecting No.
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3.3. Global OfficeMaster Settings
All settings regarding and affecting the connectors are carried out in the OfficeMaster Exchange administra-
tion program.

The connector components and other elements are visible on the setup computer. Thus we recommend 
installing the Exchange administration programs on the same server that also holds the OfficeMaster setup.

Table 3.5: SnapIns of the Microsoft Exchange Administration / OfficeMaster setup

Microsoft Exchange 
Administration SnapIn OfficeMaster Administration

Exchange 2007
Exchange System Management 
console

Run > Programs > OfficeMaster >  Office Master Exchange Administration

Exchange 2010
Exchange System Management 
console

Incorporated; alternatively:
Run > Programs > OfficeMaster >  Office Master Exchange Administration

Exchange 2013/2016
Not available as these servers are 
being administrated via a browser

Run > Programs > OfficeMaster >  Office Master Exchange Administration

The display language (German or English) for the administration tools are based on the system language. 

For Exchange Server versions 2007 and 2010, access the global settings in the OfficeMaster subfolder within 
the Organization Configuration (see Image 3.10).

Image 3.10: Global configuration settings in the Exchange 2007/2010 Exchange administration console

Select Server Configuration > OfficeMaster to display OfficeMaster connectors that are ready for use. In this 
view, you also find previous connector versions.
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Image 3.11: Connector Configuration in the Exchange 2007/2010 administration console

The dialogs for both the Exchange Administration Console and the OfficeMaster Exchange Management pro-
gram are identical, thus the following images are taken from the OfficeMaster Exchange Management program.

3.3.1. General (Connector) Properties

The tab Global Connector Settings (see Image 3.12) contains global settings for fax, SMS and voice services 
that form the basis for all OfficeMaster Exchange connectors within the organization.

Image 3.12: Options within the General Properties tab
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 ► Global Configuration for Fax, SMS and Voice

 ► Global Directory (for Cover Pages etc.)

To store front pages, signature files, stationery and caller images, set a global directory as UNC path 
that matches the structure of the FFACCESS share. This means, that the connectors expect sub-di-
rectories named COVER (front pages), LETTER (stationary files), SIGN (signature files) and PICTURE 
(caller images). Administrating these folders is only useful, if there are several OfficeMaster Connectors 
in one organization. During setup, that folder might change.

In mutual agreement with the actual users of the other connectors, the administrator may create a 
base directory. Selecting Save Global Settings in a Local Domain during installation creates a global 
directory at every site.

 ► Language

Connectors are capable of displaying notifications to users in German, English, French, Italian and 
Spanish. Each user may change the language in the reception- specific settings.

 ► Message Layout

The OfficeMaster connectors can display feedbacks and inbound documents in various graphical for-
mats. Choose between the following options:

• Text only

Documents will be created as emails with an entire text content. This setting creates the highest 
compatibility to all user applications the Exchange server can be connected with.

• HTML-Layout: Neutral, OfficeMaster and Outlook

HTML layouts are graphic layouts that alter the general look of a message. The message is generated 
as HTML message with the first page of its attachment taken as preview. 

As feedbacks include the converted attachment files individually, only the cover pages of each 
attachment file is displayed in the message. The format of the incorporated preview file (.png) is 
independent from the actual attachment file format. The three internal layouts you can choose from 
contain different color designs. Only an administrator can only select and edit the layout, which, by 
default, is set to OfficeMaster.

 ► HTML Template

In addition to the HTML templates included, you can load external templates for more specific designs. 
They are created using a special HTML/XML variant and can be saved with the normal RTF cover pages 
in the global cover directory. These special template files (*.HTL) save entire language sets to HTML 
templates and can positively transform the appearance of incoming documents and , if applicable, 
adjust them to your corporate design. The HTL editor and a documentation of the HTL script language 
can be found in the directory <SERVER>\FFACCESS\Redist\Tools. 

 ► Resolve Sender and Recipient

The connectors can resolve incoming and outgoing telephone numbers. You can set in which directories 
contact information can be searched for by default.
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• Global Address Book/ Microsoft Active Directory

When choosing this option, incoming caller identification and outgoing cover page information are 
taken from Active Directory user data or Active Directory contact data. This option ensures that 
only internal calls are resolved, because contact data is usually not stored in the Active Directory.

• Private Contacs (User-Mail- Profile)

Private Contacts are contact information stored to the E-Mail profile of the sender or for incoming 
documents of the recipient. They do not refer to private folder files (PST file) embedded in the email 
profile, but rather to the contacts folder of the email profile. Note that you can only use this function if 
the service account of the connector component has sufficient reading rights to the mailbox storage 
of the corresponding user.

• Public Folder

The connectors usually resolve cover page fields and information from senders of incoming and 
outgoing documents and messages from the address book. As most of this sender information is 
not saved as an Active Directory contact, but as an element in global folders, this setting allows the 
connectors to use this as data source. It essentially uses the first contact element. Although dupli-
cates are narrowed down by their display name, they are not recognized as errors because no other 
information is used to find the data.

◊Note! The search within private contacts and global folders are processed in real time for each 
of the settings. Such processes can take a considerable amount of time. As an alterna-
tive, the connectors can use the meta-cache database which works independently of 
this setting.

 ► Global Fax- Connector- Configuration

 ► Fax Send Defaults

• Send Electronic Business Cards (VCARDS) as Additional fax Page 

In Microsoft Outlook you can choose to attach the electronic business card of Outlook to the mes-
sage. This option, common to emails, can also be activated for sending faxes. The business card is 
then converted into an additional page of the fax.

• Use 64k - Connection (G3C) by Default

The OfficeMaster card supports the standard fax protocol G3C that, within fax group 3, allows 
transmission with a speed of 64 kBit/s on ISDN lines. In this case, with using the OfficeMaster Gate, 
it attempts to both establish and transmit the fax or the file with this speed. If the connection is suc-
cessful, the time and money saved is of considerable importance. Should the connection fail, because 
the recipient is incapable of accepting the data stream, a new connection has to be attempted. The 
second attempt uses the default speed. Please bear in mind that trying to establish a connection 
twice takes up more time. Should this option be active, the individual user can deactivate it for their 
task in the transmission options.

• ECM (Error Correction Mode)

This option activates the error correction mode when sending faxes or files. Should the recipient 
support this function, faulty data packages will be identified and resent. This allows files to be trans-
mitted faultlessly even through poor lines. We recommended leaving this option at its default. Should 
the need arise, the individual user can deactivate it later for each task.
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• Enhanced Resolution (200x 200 dpi)

By deactivating this option, all faxes will be sent using the standard resolution of 200 dpi horizontally, 
100 dpi vertically. This saves considerable time and financial resources compared to the enhanced 
resolution (200x200 dpi). Here again, the individual user may set a custom resolution for each task.

 ► Coverpage Mode

A cover page can be incorporated into a fax message that is sent with Microsoft® Exchange. This box 
lets you customize the cover page.

• Never Suppress Cover Page

If a cover page exists, it will always be sent. 

• Suppress on Empty Body Text

Should the message contain no text but attachments only, this option will suppress the cover page. 
Any data entered into the Subject input field will be ignored. You may use this option if the attached 
files contain this information, e.g. a cover page created with a word processor.

• Suppress on Empty Body Text and Subject Line

This option suppresses the cover page only if there is no text in both the message itself as well as in 
the Subject input field. You should select this option if you want a cover page to be created for each 
message that contains a value in the Subject input field, since the subject is usually part of the cover 
page.

 ► Priority Controlled Send Time

Use this option to set the transmission periods of fax and SMS documents according the E-Mail prior-
ity. The check box urgent assigns a higher prioritization to the queued messages within the Messaging 
Server. Use this option for high priority E-Mails only as it interferes with the placing of documents within 
the server queue.
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3.3.2. User Defaults (FAX)

The settings apply to every user of the organization, unless they had been administrated individually.

Image 3.13: User settings (Fax) tab

 ► Initial User Defaults for FAX

 ► CSID

You can set the global fax identifier for all users of the organization. It will appear in the header of each 
outgoing fax. Please use the international norm: (+) (country area code) (no leading 0) (calling num-
ber) (forwarding number).

The individual CSID ensures the fax number of the sender, including the forwarding number, is transmit-
ted correctly. Answering faxes can therefore address the recipient directly. If you leave this field empty, 
data entered during setup of the messaging server will be used.

Example 3.2. +49 3328 455 960

»End  of  examp »

- 154 -

Connector for Microsoft Exchange®



 ► Headline

You can globally set a headline for the users of the organization. This may be your company name and 
the department.

 ► Coverpage template

Here, you can activate a cover page. Enter the name of the RTF file in the corresponding field. Cover 
pages are saved to the sub folder COVER that is created automatically upon setup (refer to chapter 3.2.3 
on page 140). The default is set to Inactive. Should you activate cover pages, all faxes sent through 
connectors of this organization receive a cover page unless the respective user was given authorization 
to turn off or replace the preset cover pages.

◊Note! If you created the cover page using Microsoft Word, we strongly recommend using it 
again for the central conversion of a message. Microsoft Word creates RTF files that are 
not interpreted by the internal RTF converter of Microsoft Exchange or Quick View Plus, 
particularly if you used more complex formats like tables or position frames.

 ► Signature

You can choose the name of a signature file here. It is turned off by default. All signature files from the 
sub-folder SIGN are shown. You may also enter an alternative name; In this case save a cover page file 
to the sub-folder SIGN before using the system.

◊Note! It is the responsibility of the administrator to assign the correct signature files to each 
user. The signature file has to be an RTF file so it can be correctly integrated into the 
Microsoft Exchange message.

Creating Signature Files

• Scan the signature

• save it as graphic file e.g. PCX

• import this file into an RTF file object

◊Note! The internal converter cannot convert objects into RTF files. Hence, utilize Microsoft 
Word or an alternative program.

 ► Billing Code

The billing code refers to an entry in the log file, created by the messaging server. This is only useful if 
users do not possess a billing code entry, thus the value that is set here is supposed to be applied. A 
billing code is a code with a maximum of 12 digits that identifies the user in the log file.
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 ► Letterhead Attachment

Standard is the default setting for this input field. This means that the letter paper set for the fax con-
nector is used for attachments. However, the respective user may freely set an alternative letter paper 
that is used instead. This input field shows the name of all letter paper files that are stored to the sub-
folder LETTER. Before editing the display name, ensure the appropriate file is saved to the LETTER 
subfolder. The following checkboxes control in what manner documents with multiple pages utilize the 
letter paper file:

•  1.) Repeat the last page (of letterhead)

• 2.) Use only first page of letterhead

There are four possible ways to combine these options:

• Option 1: Both settings turned off (default)

Every page of the letter paper is associated to the appropriate cover page and message. Should the 
cover page or message have more pages than the letter paper, the other pages receive no letter paper.

• Option 2: Setting 1 = activated, Setting b = deactivated

Here again, every page of the letter paper is associated to the appropriate cover page and message. 
As opposed to the previous scenario, remaining pages of the cover page or message receive the last 
page of the letter paper.

• Option 3: Setting 1 deactivated, Setting 2 deactivated

Only the first page of the letter paper associated to the appropriate cover page and message. Remain-
ing pages of the letter paper are discarded just as well as remaining cover pages or message pages.

• Option 4: Setting 1 activated, Setting 2 activated

Only the first page of the letterhead is used. This page is repeated on all pages of cover page and 
message.

 ► Fax Feedback

Every user sending a fax is eligible to receive a transmission report. This report (called feedback hereafter) 
can be configured depending on the Exchange server. Feedbacks indicate whether the fax transmission 
was successful or not. If a Non-Delivery Report (NDR) is requested, the sender will receive a report that 
includes information about why the fax could not be delivered and allows the user to change the fax number 
and repeat the process. As a NDR is fairly versatile, you may choose your preferred output.

• Positive and Negative as Mail Without Attachment

Positive and negative feedbacks are conveyed via mail to the inbox of the sender, excluding the 
converted fax.
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• Positive as Mail, Negative as NDR

Positive feedbacks are conveyed to the sender’s inbox via mail, whereas negative feedbacks generate 
a NDR. NDR’s occupy an option that allows the user to resend the message.

• Only Negative as Mail

Only negative feedbacks are conveyed to the sender’s inbox.

• Only Negative as NDR

Choosing this option triggers one NDR per transmission error.

• Positive and Negative as Mail with Attachment

Here, positive as well as negative feedbacks are conveyed via mail to the inbox of the sender, along 
with the converted fax as attachment.

• Positive as Mail with Attachment, Negative as NDR

Positive feedbacks will be sent as mail with the converted fax included, while negative feedbacks are 
sent as NDR to the mailbox of the respective sender.

• Only Negative as Mail with Attachment, Negative as NDR

The sender usually receives a message from the fax connector, informing him of whether each fax 
transmission was a success or failure. Particularly for serial faxes this form of feedback is rather 
cumbersome and contra productive. Hence, this option only informs the user if failures did occur. 

 ► Multistatus Feedback of Bulk Faxes

An additional option is to choose to receive a summary of the feedbacks for bulk faxes (outgoing faxes 
with the same content but different addresses). Instead of receiving one mail for each successful or 
unsuccessful fax transmission, you rather receive one message that confirms the successful delivery 
of ALL faxes or you receive a message indicating which fax transmission job was faulty. Please note that 
this option is not possible for bulk E-Mails, as each job needs to be processed manually.

 ► File Format

The default format for incoming fax documents is TIFF/G4. However, you may choose an alternative 
format from the dropdown list. The format essentially depends on the picture program that is going to 
be used for the fax depiction. One of the most dominantly used being PDF or TIFF.

 ► PDF with Included OCR-Information

Additionally, if the text recognition is turned on, you may choose to have a inspectable document created 
that is then attached to the incoming document.
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 ► Electron. Fax-Signature

Use this input filed to include a qualified electronic signature with outgoing fax documents. This option 
requires the respective OfficeMaster Exchange Connectors to possess a corresponding signature com-
ponent (SIGN). Because signatures are usually used by individuals rather than by groups, you should 
activate this option in the user settings and not here.

3.3.3. User Defaults (Voice)

Use this tab (see Image 3.14) to set user defaults for the voice connectors. They will be applied to every user 
who is not administered individually.

Image 3.14: Tab for setting up Voice User Defaults

 ► Initial User Defaults for Voice

 ► Record Mode

The record mode differentiates between conveying pure audio messages including file attachment 
(Voice message only) and conveying an additional call notification without attachment (All calls) if the 
caller didn’t leave a message.

 ► Audio Directory

The audio directory is the audio tree of the messaging server. Each messaging server with an installed 
voice-tree includes audio directories, which in turn include language-related voice prompts. As of now, 
you can choose between English and German.

 ► Voice Project

Please choose the voice project that you intend to use. The voice project determines the behavior of the 
voice server for inbound messages.
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 ►  Voice Picture

The voice picture is a default image, which is shown if the user has no allocated picture or the caller could 
not be identified. It is an image file (PNG or JPG) saved to the global directory PICTURE. The image 
should not exceed 160 x 180 pixel (width x height).

 ► Message Waiting

In this section, you may configure how the Message Waiting Indicator (MWI) resets. The MWI is a visual 
feature that notifies users on any new voice messages. It is triggered autonomously and its behavior 
primarily depends on the Messaging Server configuration and the respective MWI configuration on the 
PBX.

Choose between three reset modes:

• Indication off by remote inquiry

• Indication off by inquiry of one message at least

• Indication off by inquiry of all messages

 ► Voice File Appearance

Use this input field to choose whether the voice files (WAV or MP3) are shown within the message or 
not. Suppressing them will let you to listen to them by remote request only and not through your com-
puter’s speakers.

 ► Message Behavior

Specify whether you prefer receiving voicemails in the classic E-Mail format used by the OfficeMaster 
Suite or the Exchange UM voicemail format.

◊Note! The format will only appear once the respective user has been authorized for the Unifed 
Messaging role of the Exchange Server.

 ► Caller Number Reading

Use this input field to determine whether the telephone number of the caller is read out during listening 
to the respective audio message. It may be read out before or after.

 ► Callback via Inquiry

Activating this option allows the user to call the caller directly.

 ► Availability Check

If needed, the voice connector employs a functionality that evaluates the private schedule of the user 
and thus determines whether he is available or not.
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 ► Initial PIN

Every user who has not been administrated individually uses this PIN entry. This PIN is also used to adjust 
the functional sequence in accordance to the actual behavior. In conjunction with other connectors, the 
voice server is given the option of utilizing an initial PIN as well. To generate a dynamic PIN, utilize the 
voice server. Should the voice server configuration apply to the Exchange Server as well, leave the input 
field blank. (Hence, delete the default value ‘0000’).

◊Note! If you require the voice server mechanisms to apply to the Inital PIN (automatic calculation 
or preset) as well, please set the value to <empty>. 

 ► Encrypt PIN of User Objects

To amplify the safety, the Messaging Server is giving you the possibility to encrypt the PIN by a PBKDF2- 
Hash standard.

 ► Query Permission 1/2/3

If the voice box receives calls from the telephone numbers entered into this box, it immediately enters 
the configuration mode. We recommend leaving these input fields blank, as they cannot be integrated 
into a useful global operation.

3.3.4. User Permissions

Each user of the OfficeMaster Exchange Connectors can receive a multitude of permissions from the 
administrator.

The permissions shown are set for all users by default, unless users possess an individual administration. The 
tab User Permissions (see Image 3.15 below) incorporates all permissions a user can obtain. Activate them 
by ticking the respective box.
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Image 3.15: User permissions

The individual permissions determine the following behavior:

 ► Fax

 ► Change Send Time

This permission enables the user to set a date and time for messages to be broadcast. These entries 
have priority to the urgency settings low, normal and high.  If a time is given without a specific date, the 
current date is taken. Has the time already passed, the next day will be taken.

 ► Change Resolution

The resolution can be set to high or standard. We recommend having these settings set to standard 
resolution. This will essentially keep the costs as well as the transmission time at a minimum. For special 
cases, the resolution can be changed for the individual task.

 ► Turn off Cover Page

Within the global administration, a cover page for all users or a cover page for an individual user can be 
set. This option enables the user to suppress the selected cover page. This is useful whenever an out-
going document already contains a cover page. Please note that the use of cover pages add additional 
transmission time and costs.

 ► Turn off Letterhead for Cover Page

A default letterhead for cover pages can be set within the global administration. With this option, the 
user can suppress the use of letterheads/ letter paper for cover pages.
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 ► Turn off Letterhead for Attachment

The same can be done for attachments. It also lets users suppress the use of letterheads for attachments.

 ► Binary File Transfer

The actual message as well as possible attachments are conveyed to the counterpart station via file 
transfer through the fax connection. We recommend choosing this option only if the counterpart station 
inherits the respective option for the fax protocol using the ITU guideline T.434. This will give the recipient 
the possibility to further process the files or execute the programs within the files. Please note that the 
binary file transfer might not be supported by the utilized fax hardware.

 ► Fax Polling

Incorporating this option allows the user to benefit from the fax polling services offered by OfficeMaster. 
The fax number/fax address is being called and the fax protocol signals that a document is about to be 
transmitted. There is ultimately no difference between this option and receiving a regular fax.

 ► Turn off ECM Mode

Here, the user is given the possibility to suppress the default setting Sending with error correction. 
OfficeMaster Gate supports transmission with ECM (Error Correction Mode) and we highly recommend 
utilizing it.

Should the addressee use devices that do not support ECM, the ECM suppression is applied automati-
cally. ECM repeats the transmission of all faulty data blocks and thus regulates the faultless conveyance 
of faxes. If the line quality is poor, it may cause a minor transmission delay. Suppressing ECM is only 
recommended if the line is very poor and essentially causes the transmission time to soar up immensely. 
Furthermore, errors need to be tolerated.

 ► Force Feedback With fax Document

When sending faxes users may opt to receive feedbacks stating whether the fax has been transmitted 
successfully. In addition to the status information, they also receive the actual fax as image file attach-
ment. Utilizing this option is of particular significance for users who triggered multiple jobs but cannot 
allocate the transmission feedbacks to the respective faxes.

 ► Specify Cover Page and Letterhead per Document

The user will be authorized to choose their own cover pages and letterheads. They can set a name of a 
cover page file or letterhead, as long as the corresponding file exists in the installation directory <Mes-
saging Server>\FFACCESS\Cover.

 ► Turn off Signature Template

A signature of the user can complement a fax document if needed. These so called signature templates 
need to be activated by the global administrator and are found within the setup directory <Messaging 
Server>\FFACCESS\Sign. Turning on this option suppresses the signature template. Hence, no signa-
ture will complement the fax.
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 ► Prohibit Print of Outgoing fax

The administrator can select a default printer, which automatically prints all outbound faxes. Turning 
on this option suppresses this functionality.

All these user permissions also appear in the OfficeMaster transmission settings for Outlook whenever a 
message is sent.

◊Note! The internal mechanisms for Microsoft Exchange prevents the display of any rights that 
had been enabled for the user. Thus, they see all settings and essentially rely on the 
administrator to tell them which settings they may take influence on. This functionality 
is applied regardless on the configuration of any printing interfaces (printgw).

◊Note! Although the following settings affect the user permissions, they do not appear in the 
OfficeMaster transmission settings for Outlook.

 ► Send With High Priority

An important feature of transmitting faxes is to set the priority for a message. As a message with high 
priority is sent immediately, significant transmission costs may arise for long faxes. To avoid this, we 
recommend assigning only priority levels that are low in costs. Enabling this option will allow the user 
to make use of the highest priority level.

 ► Send with Normal Priority

Checking this box allows the user to send messages with normal priority.

 ► Send Fax Documents

Here you give per mission to Microsoft Exchange users to send faxes.

 ► Receive Fax Documents

Activate this checkbox to block the reception of faxes for the respective user. If activated, inbound faxes 
are forwarded to the inbox of the default user who then decides whether he himself forwards the fax 
document to the blocked user.

 ► Suppress Electronic Signature

Utilizing the transmission settings, the user is given the possibility to disable the electronic signature 
for faxes. This permission can be toggled on and off here.
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 ► SMS

 ► Send SMS

If an SMS connector is installed, this option allows the sending of SMS’s. Users who send messages 
without permission receive an error message.

 ► Receive SMS

The SMS connector can also receive messages. This feature can be toggled on and off with this check-
box. All inbound messages addressed to the blocked user are forwarded to the default recipient, who 
will then decide whether to forward the SMS message to the intended user or not.

 ► Sending Split SMS

If the user has been authorized to transmit SMS’s, any text message that exceeds the maximal char-
acter count of 160 will be split up and transmitted individually. As this option might be quite costly, it is 
turned off by default.

 ► Maximum of Partially Split SMS

Select the maximum amount of individual SMS whenever SMSs need to be split into individual mes-
sages. The maximum value possible is 99. Hence, 99 individual messages can be sent per document.

 ► Voice / CTI

 ► CTI Enabled

CTI (Computer Telephony Integration) is an outdated feature and therefore not supported since 
OfficeMaster Suite version 5 and higher.

 ► Voice Administration

This checkbox controls the display of administrative options on the Web-UI for voicemail.
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3.4. Administration of the Messaging Server Con-
figuration

3.4.1. Connector Configuration

Despite the fact that the connectors incorporate all relevant settings to a configuration file, the individual 
components possess basic settings that ensure a smooth operation as well.

Image 3.16: Basic configuraton for the msx2kgate component

Find these basic settings in the Connector Configuration tab (see Image 3.16).

 ► Microsoft Exchange Server 2010 -2016 Parameter

The installation wizard sets these settings automatically. It encompasses the name of the Exchange con-
nector, the file path of the connector within the Active Directory, the name of the Exchange Server for login, 
the X.400 address of the administrative group and the file path of the complementary configuration node.

◊Note! Although the basic settings can be edited with the Expert Mode enabled, we endorse to 
refrain from using this method. Only the installation program should set basic parameter 
as editing them manually may cause errors.

 ► Connector for Fax, SMS, Voice and CTI Information Services

These settings determine the interaction of the Exchange connector component with fellow Messaging 
Server components.

 ► Component Name

This box contains the name of the connector component and cannot be edited.
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 ► Sign Component

In order to support digital signatures, choose a sign component here. It will work in unison with the 
connector component.

 ► Notify Component

A notify component updates the user on the transmission status of a fax document or SMS. Archive 
gateways can be added here.

 ► Notify Option

The following status options endeavor to optimize the communication between msx2kgate and other 
gateways.

• Notifications for SAP via User Address entry

Utilizing the SAP connector sapconn, address destinations can be resolved in the Active Directory 
using the entry in the User Address input field.

• Notifications for SAP via User Name entry

The address resolution is carried out similar to the process described above, however, instead of 
using the User Address entry, the User Name is used instead.

 ► Suppress Mail Notifications

If the connector operates together with an LPD (for printing) component, it can transmit documents 
autonomously via SMTP as long as an E-Mail address is provided. In this case, transmission is carried out 
using the connected Exchange Server. A report indicates whether the server has accepted the E-Mail. 
This report, however, provides no evidence that the destined recipient has actually received that E-Mail, 
which is why many users decide to ignore this report altogether. This can be achieved by ticking the box.

 ► Requeue Interval

If the connector fails to deliver messages to its intended target (due to conversion errors, printing errors 
etc.) the messages can be requeued and the connector will attempt to deliver them again. Use this box 
to define the delay (in minutes) until it executes a new attempt. The default entry is set to 15 minutes.
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3.4.2. Recipient Configuration

This tab (see Image 3.17) exerts direct influence to inbound documents. Phone numbers (Called Party Num-
ber) designated for reception processes may be used as address filter for fax or SMS. To forward all inbound 
messages to the Exchange connector, use the default setting (.*).

Changing this value only becomes necessary if inbound messages need to be forwarded to multiple gateways, 
such as SAPCONN or FILEGW or if OfficeMaster shall receive messages on designated calling numbers. 

The latter is called Whitelist Procedure and can be turned on by following Tools > Black-/Whitelist… > Block 
undeliverable messages .

◊Note! We recommend configuring the UNDELIVERABLE component on the Messaging Server if 
you need the address filter to be limited to designated calling numbers without employing 
the Whitelist Procedure. By doing so, you avoid that inbound messages are saved to the 
server without noticing and thus remain untouched.

Image 3.17: Recipient configuration of the msx2kgate component

Example 3.3. 

The plainest address filter is composed of a list of numbers that are assigned to the Exchange connector. 
Hence, if all faxes addressed to the calling number extensions 150 to 154 are destined to be processed by the 
Exchange connector, the address filter would contain the following entry:

150     151     152     153     154

Regular expressions can be used to summarize multiple entries (15 [0-4] ). 

»End  of  examp »
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The default value (.*) is also a regular expression. An arbitrary character is defined by the dot (.) whereas the 
star (*) defines that the previous character may occur any number of times. Please note, that for each row 
only one address entry can be provided. Adding multiple regular expressions, such as OR (|) and AND (&) 
within one row is not possible.
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3.5. Using the OfficeMaster Exchange Administra-
tion Shell

3.5.1. General Settings

Every Exchange server requires its own specific settings. These are being administrated in the properties 
section of the respective object. To follow up with the configuration described below, open the tab General 
(see Image 3.18).

Image 3.18: General settings

 ► Postmaster

The postmaster (default recipient) is a recipient who receives all documents (Fax or SMS) that could 
not be distributed automatically.

The automatic distribution of faxes requires an appropriate hardware that allows every Exchange user 
to have an individual forwarding number, such as 123, 124, 125 etc.

Should you use analog hardware without call forwarding functionality all faxes will be sent to the default 
recipient. The default recipient should then determine the designated addressee and forward the message.

◊Caution! We highly recommend setting up a default recipient. Should this entry be missing, un-
deliverable documents may be left unnoticed in the overflow registry of the connector 
component.
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 ► Global Copy

 ► Copy Incoming to / Copy Outgoing to

This section can be used to forward a copy of all inbound and outbound documents to a preset public 
folder or inbox. Resorting to this option will allow the archiving of all fax communication straight to these 
folders. Furthermore, archived messages can be browsed through using various processes and copies 
can be resent. The folder Microsoft Exchange System Objects folder contains these public folders.

 ► Print Incoming to / Print Outgoing (UNC Path for fax Documents Only)

Here you can select a network printer that prints all inbound documents for the respective user. Instead 
of searching for a printer, you may directly enter a printer name using the UNC (Universal Naming Con-
vention) standard. By default, this option is inactive.

For the connector to be able to print incoming and outgoing faxes with the selected printer, the computer 
running the connector component has to have the appropriate driver installed.

An additional option can be applied inbound and outbound printers, which defines what sort of 
documents are printed out (All documents; successfully received/sent documents or faulty inbound/
outbound documents).

◊Note! Print gateways that essentially employ the same functionality can be configured in the 
Messaging Server Configuration program. However, this process does not support the 
configuration of user specific settings. To test the printing functionality, use the tool 
MsxPrinterTest.exe. It is located on the server that also contains the OfficeMaster soft-
ware, more specifically in the <SERVER>\FFACCESS\Redist\Tools.

 ► Additional Send Options

 ► Country Dial prefix

Most ISDN ports fail to establish a connection if the country code is used as prefix. To avoid this issue, 
enter the country code prefix here. The Exchange connector will then convert this code into a zero 
(0). As the Messaging Server allows the setup of central system with OfficeMaster Gates distributed 
throughout multiple countries, the connector could also be used for processing documents in foreign 
countries. Having such an environment requires an adjustment of the Messaging Server, thus, this input 
field must bear the value <empty>.

 ► Address Prefix

If call extension numbers are distributed in an Exchange environment with a dedicated Exchange con-
nector for each location, these numbers need to be unambiguous. If one location utilizes multiple con-
nectors, the entire fax number needs to be entered. The prefix, which is the dial-up number, must not 
include direct dial information as the fax server analyzes merely the call extension number and not the 
entire fax number. Both, the prefix and the call extension number provided by the fax server form the 
complete calling number of the recipient, who can be identified using the global directory.
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Example 3.4. 

One organization is divided into the following locations

• Munich (Trunk number of the fax server without call extension: 089 4647) and

• Stuttgart (Trunk number of the fax server without call extension: 0711 4746).

Both locations possess a fax connector and fax server. 

• Recipient Huber uses the call extension number 105 in Munich;

• Recipient Bachmann uses the same call extension number (105) in Stuttgart. 

If the call extension had been set as address type FAX for both recipients, an address replication would not 
be possible due to the identical call extension numbers. Hence, the complete fax CSID need to be entered for 
both recipients.

Huber: +49 89 4647 105 Bachmann: +49 711 4746 105

Add the following values to the fax connector:

• Munich +49 89 4647

• Stuttgart  +49 711 4746

»End  of  examp »

◊Note! Entering an address prefix to the connector is only beneficial for an organization that 
possesses multiple connectors. As the tendency shifts towards systems that employ 
only a single connector and use gateways at their locations, the prefix has to be added 
to the ISDN configuration of the gateway (direct dial prefix).

 ► Embedded Images

Image files included in E-Mail bodies are deleted from cover pages by default. The function 
Support embedded images allows images to remain in the E-Mail body. Thus, signatures added in an 
image format are supported.

3.5.2. Server Connection

To configure the SMTP client of the OfficeMaster Exchange connector, use the Server Connection tab (see Image 
3.19). Here, properties of the Messaging Server for transmitting SMTP mails to the Exchange server can be set.
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Image 3.19: Setting up the Server Connection

 ► Exchange Server

The Exchange Server shown here receives E-Mails from the component. This input field is not editable.

 ► Mailbox/CAS-Server

This input field is blank by default. Some environments incorporate servers with multiple IP addresses that 
address various networks. The Exchange connector usually determines the IP address of the Exchange 
server automatically. Should the connector fail to determine the correct IP address, use this input field to 
deposit an alternative IP address.

 ► Alternative Mailserver

Occasionally, the feedbacks and inbound documents are required to be received on a server other than 
the one stated as communication partner. Additionally, due to the lack of an authoritative server domain, 
the communication partner occasionally rejects the primary E-Mail address of its own users. In this case, 
E-Mails need to be redirected to an alternative entry server (Smarthost), to a cluster IP address or a DNS 
A-Record, which can be achieved by entering a Full Qualified Domain Name (FQDN) or an IP address he.

 ► SMTP Send Port

In this input field, nominate the SMTP port that is used for receiving E-Mails via the Exchange server de-
posited above. This functionality essentially defines the transmission direction between Messaging Server 
and Exchange server.

 ► Authentication

The authentication determines the level of security that is applied for E-Mail transmission from Messaging 
Server to Exchange server. Please note that you cannot set this arbitrarily. A service account entered here 
would have had to be set at least once during data verification in the setup wizard. There are two options 
to choose from:

- 172 -

Connector for Microsoft Exchange®



 ► No Authentication

By choosing this option, no SMTP authentication is carried out. However, the Exchange server must 
allow an anonymous access to the SMTP service.

 ► NTLM Authentication (Recommended Setting for Microsoft Exchange Server 2007 and 2016)

This kind of authentication (NTLM, WindowsNT Challenge/Response, WindowsNT Lan Manager Authen-
tication, Internal Windows authentication) utilizes a WindowsNT domain account for login and trans-
mission of SMTP mails. It is deposited in the format Domain\Account. As hub servers in an Exchange 
2007-2016 surrounding block the use of an anonymous SMTP service access, the authentication via 
NTLM is preferred. Furthermore, the service account is activated on the hub server by default. Hence, 
editing the entry at a later point is not possible.

 ► Plain Authentication

This kind of authentication (plain text password SMTP) uses a special login account for the related server.

 ► Service Account, Password

This section is used to deposit a service account and password. Once a service account is deposited, please 
do not change it here but rather take the installation wizard of the Messaging Server for these kinds of edits.

 ► Connection Security

This parameter determines how the communication to the server is encrypted. It essentially increases 
the communication security. This option is turned off for Office 365 installation, but may be turned on for 
encrypted connections.

Four security levels are provided:

 ► Enable Transport Layer Security (TLS)

This activates the general encryption via TLS. The encryption protocols are mediated between systems 
automatically and no certificate is used for authentication.

 ► Establish Only Secure Connections

Communication to servers that do not use TLS can be blocked here. Connections will be terminated 
immediately, should the recipient request a TLS-free communication.

 ► Verify Server Certificate

If this checkbox is activated, the certificate provided by the server and the certificate stored within the 
local Windows certificate storage are compared. The connection will be dropped immediately should 
both certificates not match up.
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 ► Use Global OfficeMaster Certificate Folder

As outlined above, the system checks whether the certificates provided by the server match up to any 
certificates stored to the Windows certificate storage. In addition to this general validation, the global 
OfficeMaster certificate directory (\\Server\FFACCESS\CERT) may also be browsed through to check 
for explicit certificates. Activate this box to enable this functionality.

 ► Mailbox Access

The connector employs two access modes to mailboxes. The installation wizard sets the adequate mode 
automatically.

 ► Exchange Web Services (Exchange Server 2010 and higher)

This mode must be selected for Exchange Server 2013 and higher.

 ► Microsoft MAPI Interface

Select this mode for Exchange Server 2007 and Exchange Server 2010.

3.5.3. User Data

The tab User Data (see Image 3.20) incorporates options that help increase the processing speed of inbound 
and outbound documents for fax and SMS, as well as increase the user resolution for voice calls.

Image 3.20: Setting options that determine user data
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 ► Metacache File

The metacache database is a proprietary database that can be created while the connector component 
is running. Unlike the global catalog, this database contains all relevant address data of the domain. It is 
created by choosing a file with the file extension .mcss. The files, which are ready for access almost im-
mediately, are used for the resolution of users if cover pages are being generated. Thus, the database is 
speed-optimized and can be run without additional database systems. Moreover, it can be extended with 
interfaces that allow the connection of databases to CRM systems via third party plugins.

 ► Replicate MS Active Directory Data to Metacache

Activating this option copies the Active Directory Forest of the user data to the database. This may take 
some time.

 ► Replicate Public Folder Items to Metacache

Additional public contact folders can be copied to the metacache with this option. This requires the 
existence of global folders and may take some time to process.

 ► Replicate only the following Public Folder with subfolders

To optimize access time to the global folder database, you can enter or create a public contact folder 
here that limits the search for folders. 

 ► Internal Phone Numbers

As the metacache saves all calling number data, internal calling numbers that contain ambiguous data may 
cause doublets. To avoid doublets, use this input field and specify how internal calling numbers are treated 
according to their length and whether they ought to be assigned to certain domains.

 ► Replication Schedule

The replication schedule determines the point of time, at which data are being copied. To trigger replica-
tion immediately, select Replicate Now.

3.5.4. Address Space

In this tab (see Image 3.21), address spaces or address types can be selected that utilize all functionalities 
provided by the connector (for outbound communication).

Apart from connecting E-Mail programs such as Outlook to the Exchange Server, other programs can access 
the Exchange Server via SMTP/POP3 as well. Hence, the definition of fax or SMS addresses is essential.

Define them by configuring an additional SMTP address space that contains an expressive domain suffix. The 
domain suffix can be chosen arbitrarily and servers the sole purpose of providing an addressing function. 
Once entered, there is no need for further administration efforts, neither in the Exchange System Manager 
nor in the DNS.
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Image 3.21: Setting details for the Address Space

 ► Authoritative SMTP-Domain

Here, the domain suffix used for transmitting E-Mails and faxes from the Exchange Server to the OfficeMaster 
Messaging Server can be selected. Entries are only needed if the Messaging Server utilizes multiple Exchange 
connectors for various Exchange organizations. These connectors all employ the same SMTP recipient 
agent. Hence, organizations need to be distinguished by their domain suffixes. Otherwise, connectors would 
be addressed that request a different user administration. You can enter more than one domain suffixes 
(without leading @ character). Keep them apart by using a semicolon (;) in between.

◊Note! Any changes here may greatly obstruct the working order of the component and thus 
should only be done intentionally, e.g. if an OfficeMaster possesses multiple Exchange 
connectors that address various organizations.

 ► Use SMTP Address Space as Originator Domain

The connector assigns an originator address to inbound documents. This originator address corresponds 
to the originator CSID and consists of the address types Fax, SMS or Voice, which are encoded as fax 
address, SMS address or VOX address. Previous environments (such as Exchange Server 2003 SP2 with 
intelligent message filter) were not capable of decoding these addresses and forwarded them untouched. 
Originating addresses looked similar to this:

 IMCEAFAX-03328+20455+20960@fax.firma.de

To help the Exchange connector resolve the address, use the option 
Use SMTP address space as originator domain. It essentially links the SMTP address space to the cor-
respondent calling numbers. However, the preexistence of SMTP type address spaces is a prerequisite. 
They can be created in the following form:

 fax.company.de    sms.company.de   voice.company.de
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The prefixes fax, SMS and Voice (or VOX) help the connector distinguish the SMTP document types. Thus, 
the documents receive these originator addresses:

 03328455960@fax.company.de   01520123456@sms.company.de   0332845590@voice.company.de

Providing originating addresses in this form is easier to understand for recipients.

3.5.5. Address Resolution

The tab Address Resolution (see Image 3.22) incorporates settings that help optimize the connector’s per-
formance. Whenever inbound/outbound documents are received, the appropriate sender/recipient is being 
resolved in the Active Directory to gather and transmit information about permissions. All Active Directory 
domains are being browsed through on a worldwide organization. As this generally takes some time to process, 
you may set a domain selection and domain order explicitly or add a domain position of trust.

Image 3.22: Tab to configure the Address Resolution

 ► Add Trusted Domain

For comprehensive domain networks, you can add a trusted domain. In this case, the service account of 
the component is additionally used to contact this domain.

 ► Resolve Users by Using Global Catalog

This option potentially increases the processing speed in networks that incorporate multiple domains. 
Whenever possible, the global catalog is requested.
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3.6. User Administration
As the native administration programs offered for Microsoft Exchange 2007 forestall any administration 
extensions, Ferrari electronic provides an administration program (OfficeMaster Exchange Management) for 
Microsoft Exchange to manage users and connectors on the Exchange Server. This program is installed by 
default if you install the OfficeMaster Suite configuration program.

Open up the OfficeMaster Exchange Management (search for OfficeMaster Exchange in the search tool of 
Windows) or download it from the official website of Ferrari electronic AG if it is not yet on your system.

The OfficeMaster Exchange Administration is fully integrated into the native Exchange Administration console 
for Microsoft Exchange Server 2010.

For Exchange Server 2013 and higher, the OfficeMaster Exchange Administration can be used as well.

Access the user properties by selecting Recipient Configuration, then right-clicking on the respective user.  
Choose Properties in the dropdown menu. 

Image 3.23: User properties

.
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3.6.1. Fax, SMS, Voice Addresses

Image 3.24: Tab E-Mail Addresses

Common Microsoft dialogs do not support adding additional Unified Messaging address types. Hence, navigate 
to the tab called E-Mail Addresses.

If no fax, SMS or VOX (Voice) address types are yet existent, create them by clicking Add... . You may now add 
and administrate a user-defined address.

Image 3.25: Creating new address types

In case an entry of the same address type already exists, double-click it to edit the respective values.

◊Note! We do not recommend creating fax, voice or SMS addresses via the recipient guidelines, 
despite there being a way to do so. Please ensure all Exchange servers connected to the 
network are available after entering these values manually!
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Enter the fax extension number or SMS extension number of the respective user. The number should be 
unambiguous if one organization possesses multiple Exchange Server and connectors as the same number 
might exist more than once. Render it unique by adding a forwarding number prefix (see chapter 3.5.1 on page 
169). Hence, the number should show the format <Forwarding number prefix> <Forwarding number>.

3.6.2. The tab „OfficeMaster“

The tab OfficeMaster can be used to set user specific parameter.

Image 3.26: OfficeMaster tab

 ► Defaults

Select a default profile for the users here. This may either be the central OfficeMaster default (see chapter 
3.3 on page 149) or the user group default. To apply a user default, create a group of the type Security or 
Distributor. This group has its own OfficeMaster settings that can be used as defaults for the user settings. 
If a user is not administrated individually, the central user defaults will be applied automatically once the 
setup has concluded. If a user group has not been administrated individually but is set as default, the central 
OfficeMaster defaults will be applied.

 ► Fax

 ► CSID 

Use the CSID input field to set a fax identifier that appears in the headline of an outbound fax. Please 
use the international norm: 

<+> <Country area code (no leading 0)> < calling number> < extension number>
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Example 3.5.  +49 3328 455 960

»End  of  examp »

Setting an identifier ensures that both, the fax number of the sender and the call extension number are 
transmitted correctly. Hence, return faxes can be directly addressed to the sender. If this input field is left 
blank, data that have been globally set for the connector will be utilized. However, if no entry had been 
made there as well, data set for setting up the ISDN hardware will be used. It is generally recommend 
setting an individual identifier for each user. Only by doing this, valid addresses for return faxes can be 
transmitted even if users send data from various locations.

 ► Headline

Enter an individual header text for each user (or user group) into this input field. This could be their 
company name and the department the user is working in.

 ► Cover Page 

Here you can choose a user-specific cover page file. The file names of all cover pages are listed here, 
which are saved to the subfolder COVER. The folder itself is created automatically on the computer that 
was used to carry out the setup of the fax connector. By default, this option is inactive.

Additionally, you may enter a new file name. However, ensure the file is located in the subfolder COVER 
before running the system and the file extension .rtf has been stated.

 ► Signature 

If your fax document is required to show a signature, choose the appropriate signature file here. All 
.rtf files that have been saved to the subfolder SIGN will be shown in this dropdown list. Again, this 
option is deactivated by default.

Similar to the Cover Page dropdown menu, you may also enter a new file name. Before running the 
system, ensure the appropriate .rtf file has been saved to the subfolder SIGN. 

◊Note! The administrator is responsible for assigning the signature files to the respective user. As 
outlined above, the files need to have an .rtf extension or else they cannot be integrated 
correctly into the Microsoft Exchange message.

Example 3.6. Creating a Signature File

1. Scan the signature

2. Save the file as graphic file (such as PCX)

3. Import the graphic file as RTF file object into the Messaging Server Configuration program

»End  of  examp »
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 ► Billing Code

For the billing code, choose any alphanumerical identifier with up to 12 digits. This identifier will appear 
in the log file of the Messaging Server for all outbound jobs. Having a billing code allows the assignment 
of jobs and the corresponding costs to an individual user.

 ► PBX-ID

Some organizations use their PBX to keep record of accumulating costs for telecommunication pro-
cesses. On a trunk that is used by multiple users (e.g. fax line), each user has to type in a set of numbers 
(code) before providing the actual calling number. Thus, each cost can be traced back to an individual 
user. As the PBX interprets the code, the Messaging Server cannot establish a connection itself because 
the code would appear in front of the PBX ID. One possibility to counteract this issue is to integrate the 
dial prefix into the PBX ID.

 ► SMS

 ► Number

This number specifies the main send and receive address for SMS messages. It only applies to SMS 
Large Accounts. In all other instances, users are identified by their SMS address.

 ► Voice 

 ► Record Mode

When selecting the messages that need to be recorded, you may opt between:

• All Calls

If you opt for All calls, the recipient will additionally receive a message on the Exchange Client should 
no recording be made on the voice inbox. Hence, the recipient is notified that an inbound call has 
been received along with the details of the caller.

• Only Voice Messages

Similar to All calls, with the exception that the recipient will only get a call notification, if the caller 
has left a voice message.

 ► Script

This is the initial script that manages the behavior of the mailbox. The default project is eVoice_ProjectStart.

 ► PIN

Enter a PIN for the voice box here. It will be requested when switching to the configuration mode or if 
you attempt to listen to voice recordings.

 ► User must change PIN

If a user accesses the configuration mode (remote request), he will be prompted to change his PIN. The 
checkbox will be reset once the PIN has been changed successfully.
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3.6.3. OfficeMaster Details

Select Details in the lower right hand corner to access further configuration settings for the respective user 
(see Image 3.27 below).

Image 3.27: OfficeMaster user details

General

 ► Language

Set the language for text outputs and prompts here. Four languages are being offered  for selection (German, 
English, French and Spanish). The default setting is based on the language that has been set for the global 
connector settings (see chapter 3.3 on page 149 for reference.

 ► Message Format

In order to display the documents more flexibly, four display modes can be set here. Choose between:

• Plain Text

• HTML Layout: Neutral

• HTML Layout: OfficeMaster 

• HTML Layout: Outlook
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 ► HTML Template

Apart from the HTML templates provided, you can load external templates for more specific design choices. 
Commonly, a special version of HTML/XML is used to generate them. In order for them to appear in this 
dropdown list, deposit them to the global COVER subfolder, which also contains the .rtf Cover Page files. 
As these template files (*.HTL) save entire language sets to HTML templates, they can essentially alter the 
appearance of an inbound document to match the corporate design. Find the HTL editor and a manual for 
the HTL script language in the directory <SERVER>\FFACCESS\Redist\Tools .

 ► Subject Mode

To meet individual demands for the subject line of a fax document or a SMS, the subject mode can be 
changed here. These modes do not affect voice messages. Choose between four modes:

 ► Transmission Subject 

This is the classic form of a subject feedback.

Example 3.7. Fax transmission to <Fax number> 1 Page ok

»End  of  examp »

 ► Original Subject

The output is similar to the one given for Transmission Subject. However, the subject line is also added 
to the feedback. Business programs are capable of processing such feedbacks, which brings in a great 
advantage. Furthermore, stating the subject line provides an additional way to keep fax documents 
apart from each other.

 ► User Defined

Here, the subject line of the feedback can be arranged manually. 

 ► Subject Format

If you select the subject mode User defined, you may generate a text output manually. Hence, click on 
the [...] button and choose your preferred placeholders. See Table 3.6. for a list of placeholders that can 
be used according to the language setting. Check the output row beneath Subject Format and ensure 
your feedback is as intended.

Table 3.6: Placeholders for Feedbacks

Character Feedback

%S Original subject line

%T Transmission type (Fax or SMS)

%F To/from (depending on transmission type and language set)

%E Status (“OK” or “Error”)

%P Number of pages (e.g. “1 page”, “2 pages”)
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Character Feedback

%A
Recipient (if it can be resolved in plaintext, or else recipient number or fax 
CSID if it cannot)

%N Called number that has been transmitted via ISDN

%R Exchange recipient number (fax address of the recipient)

%M
Short message (the word “short message” will be displayed in the respec-
tive language)

%% Percentage sign

Example 3.8. %S - %T %F %A %E

Supposedly, a fax with the subject line Offer No. 0000145 is sent to the fax number +49 3328 455 960, the 
feedback line would display as follows: 

Offer No. 0000145 – Fax transmission to +49 3328 455 960 OK

»End  of  examp »

Fax

This tab contains options that are specific to the fax service.

Image 3.28: Options for the fax service
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 ► Copy Incoming to / Copy Outgoing to

Use this option to specify preconfigured folders or inboxes that are used for storing copies of all inbound 
and outbound documents (fax and SMS). Keeping copies of these documents have many benefits: It allows 
for a gapless archiving of fax/SMS communication, browsing for certain processes and resending faxes. 
Find public folders in the dropdown list of the folder Microsoft Exchange System Objects. Groups cannot 
be selected.

 ► Print Incoming to / Print Outgoing to (UNC) 

Here you can separately specify the network printer that is supposed to print all inbound or outbound 
documents for the respective user. Instead of searching for a printer, you may directly enter a printer name 
using the UNC (Universal Naming Convention) standard. By default, this option is inactive (<empty>).

For the connector to be able to communicate with the printer for inbound or outbound faxes, the computer 
running the connector component has to have the appropriate driver installed.

◊Note! Print gateways that essentially employ the same functionality can be configured in the 
Messaging Server Configuration program. However, this process does not support the 
configuration of user specific settings. To test the printing functionality, use the tool Msx-
PrinterTest.exe. It is located on the server that also contains the OfficeMaster software, 
more specifically in the <SERVER>\FFACCESS\Redist\Tools.

An additional option can be applied to inbound and outbound printers, which defines what sort of documents 
are printed out (All documents; successfully received/sent documents or faulty inbound/outbound documents).

 ► Attachment Letterhead

The default setting for this input field is <empty>. This means that a pre-set letter paper is used for the user. 
To set an alternative letter paper, use the dropdown list to select the respective letter paper. The name of 
all letter paper files saved to the sub-folder LETTER are shown here.

The following checkboxes control in what manner documents with multiple pages utilize the letter paper file: 

• Repeat the last page (of letterhead)

• Use only the first page from the letterhead

Refer to „Letterhead Attachment“ on page 156 for help on how to combine these functions effectively.

 ► Message Letterhead 

The options and their functions are equivalent to Attachment Letterhead.

 ► Feedback

Again, this option is equivalent to the section „Fax Feedback“ on page 156). Refer to it for a more detailed 
description of the individual settings. Feedbacks indicate whether the fax transmission was successful or 
not. If a Non-delivery Report (NDR) is requested, the sender will receive a report that includes information 
about why the fax could not be delivered and allows the user to change the fax number and repeat the 
process. You may choose between

• Positive and negative as Mail

• Positive as Mail, negative as NDR
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• Only negative  cases as mail

• Only negative cases as NDR

• Positive and negative as mail with attachment

• Positive as mail with attachment, negative as NDR

• Only negative cases as mail with attachment (recommended)

 ► Collected Feedback for Serial Documents

An additional option is to choose to receive a summary of the feedbacks for bulk faxes (outgoing faxes with 
the same content but different addresses). For documents that have only one recipient, the settings set 
in Feedback will be applied.

 ► File Format 

Should the user favor a particular file format, use this box to specify it. Find further information in the sec-
tion „File Format“ on page 157).

 ► PDF Format with OCR-Information

If the text recognition is turned on, you can also opt to have a searchable document created that is then 
attached to the incoming document.

 ► Electronic Fax Signature

Use this input field to add a qualified electronic signature to outgoing fax documents. If this option is en-
abled, the user may turn it on or off in the properties section of his outlook account. Please be advised that 
this feature will not work if the Messaging Server does not support fax signatures.
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Voice

Use this tab to configure the personalized voicemail feature.

Image 3.29: Voice settings

 ► Audio Directory

The audio directory, which is essentially the voice tree of the Messaging Server, defines the language that 
the voicemail feature utilizes to play back commands and requests (output language). Every Messaging 
Server contains an audio directory where all voice feedbacks are stored. You may choose between English 
(EN) and German (DE).

 ► User Image

Use this box to select a user image. The user image is a default image that is used as placeholder if the user 
has not set one specifically or a caller could not be identified. Please choose a PNG or JPG file and ensure 
it is located in the global directory PICTURE. Furthermore, ensure the image does not exceed 160 Pixels X 
180 Pixels (width X height).

 ► Message Waiting

In this section, you may configure how the Message Waiting Indicator (MWI) resets. The MWI is a visual 
feature that notifies users on any new voice messages. It is triggered autonomously and its behavior pri-
marily depends on the Messaging Server configuration and the respective MWI configuration on the PBX.

Choose between four modes:

• No Message Waiting Indication

• Indication off by remote inquiry

• Indication off by inquiry of one message at least
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• Indication off by inquiry of all messages

 ► Message Behavior

Specify whether you prefer receiving voicemails in the classic E-Mail format used by the OfficeMaster 
Suite or the Exchange UM voicemail format.

◊Note! The format will only appear once the respective user has been authorized for the Unifed 
Messaging role of the Exchange Server.

 ► IP Phone

In many cases, the number of the voice box is not identical to the telephone that has been assigned to the 
voice box. To reset the MWI nonetheless, specify the calling number that shall have the MWI deactivated 
once its voice box had been accessed. This number essentially represents the telephone on the respective 
work desk.

 ► “To my Phone” Number

The integration to Outlook facilitates the forwarding of messages to a dedicated telephone, commonly the 
telephone on the work desk. In cases where the work desk regularly shifts its position or the mail client is 
run from various computers, you may specify an alternative telephone that is in close proximity. Enter its 
number into this input field.

 ► Representative Number

Specify a number that receives the redirected call in case the caller has no intention of speaking to the 
voicemail

 ► PIN Processing

To amplify safety, the Messaging Server is giving you the possibility to encrypt the PIN by a PBKDF2-Hash 
standard.

 ► Query Permission 1- 3

If the voice box receives calls from these telephone numbers, it immediately enters the configuration mode. 
You may provide up to three numbers.

 ► Voice Attachment

Here you can determine whether the voice files (WAV or MP3) are incorporated into the message or not. 
If the files are suppressed, you may no longer play them via the computer speaker. Play them via remote 
request instead.

 ► Caller Number Reading

Use this input field to determine whether the telephone number of the caller will be read out while listening 
to the respective audio message. It may be read out prior or after the message.

 ► Callback via Inquiry

This section allows or prevents the user to initiate a callback. If the user is eligible, the option will be given 
in the remote request menu.
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 ► Availability Check

If needed, the voice connector employs a functionality that evaluates the private schedule of the user and 
determines whether he is available or not.

User Permissions

The tab User Permissions incorporates all permissions a user can obtain. Activate them by ticking the respec-
tive box. Find a thorough description of each check box in chapter 3.3.4 on page 160.

Image 3.30: User Permissions

 ► User Permissions, Blacklist and Short Message Split Parts by Default

If this checkbox is activated, user permissions will be set according to the global permission guidelines. The 
profile configuration that has been specified in the Default (3.6.2 on page 180) input field would then be 
used. Please note that by activating this option, you will no longer be capable of toggling the other options 
on or off.

 ► SMS- Maximum Amount Split Parts

Select the maximum amount of individual SMS whenever SMSs need to be split into individual messages. 
The maximum value possible is 99. Hence, 99 individual messages can be sent per document.

 ► Truncate SMS Content to Ensure Sending

The OfficeMaster server defines the maximum amount of short messages for global users. To ensure that 
multiple SMS can be sent without restriction, the amount should always be lower than the one set in the 
OfficeMaster server. Thus, in cases where automatic systems trigger notification messages that exceed the 
maximum amount of split messages, users no longer receive a transmission error. However, such systems 
usually deliver their most important information in the upper part of a message. Thus, shortening the text 
might be a favorable alternative.

- 190 -

Connector for Microsoft Exchange®



3.6.4. OfficeMaster Group and Folder Wizard

Large companies that utilize multiple OfficeMaster connectors may have difficulties in applying global con-
nector settings (see Chapter 3.3 on page 149) for individual user groups or recipients of routing groups. 
Furthermore, these global connector settings may not always be in accordance with the corporate guidelines.

In order to be able to edit the user settings without having to open and administrate every object individually, 
you may use the OfficeMaster Groups And Folder Wizard for this purpose instead. This wizard is capable of 
ignoring specific settings to retain their original value.

Access the wizard by switching from the tab Recipient List to the tab Recipient Tree, then open the properties 
of a selected organization element or group. Switch to the OfficeMaster tab and select Administration Wizard.

Image 3.31: Running the OfficeMaster group and folder wizard

◊Note! Depending on the type of folder, it may be either an Administration Wizard for organization 
elements or a Member Administration for groups.
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Image 3.32: Folder Administration

 ► Options

 ► Only Administrate Objects of This Container

Choose this option to restrict the wizard to edit users other than those contained in this folder. Users 
who are located in other folder objects within the main folder (sub-level folders) will not be administrated. 
This option is only available in the OfficeMaster folder administration.

 ► Also Administrate Objects of Current Container and Sublevel Container Objects

As oppose to the option outlined above, this option will allow the wizard to administrate users located 
in sub- folders. Again, this option is only available in the OfficeMaster folder administration.

 ► Include Group Objects

Group objects such as distribution lists and security groups can also be given the desired settings.

◊Note! Group objects for OfficeMaster connectors are no transmission defaults but property 
defaults.

General Settings

The next window is essentially a mirrored version of the general properties found in the OfficeMaster tab for 
each user. See chapter 3.6.2 on page 180 for reference.
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Image 3.33: General Settings

 ► Fax

 ► CSID

To optimize the fax CSID, the manual entry can be enhanced in this input field. Click […] to access a 
window that aids you in this process (see Image 3.34).

The fax CSID can be composed using Extensions, such as:

• Private Number (Taken from the first number of the Active Directory Calling Number section – 
Private Phone)

• Radio Number (Taken from the first number of the Active Directory Calling Number section - Pager)

• Mobile Number (Taken from the first number of the Active Directory Calling Number section - Mobile)

• Fax number (Taken from the first number of the Active Directory Calling Number section - Facsimile)

• IP Phone (Taken from the first number of the Active Directory Calling Number section - IP - Phone)

• FAX Address (Default reply address of the type FAX; only if it is numeric - FAX - Address)
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Image 3.34: Configuring a dedicated CSID

As not all of the calling numbers provided can be used effectively, choose Use Extension Text in Parts to process 
only the desired characters of the calling number.

Details

The windows Details (Fax) and Details (Voice) incorporate the same properties as by selecting the Details 
button in the OfficeMaster tab and navigating to the respective tab (Fax and Voice). See chapter 3.6.3 on page 
183 for reference.

 
Image 3.35: Details for Fax and Voice
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3.7. Installing the Voice Form
In order to use the native outlook client to mark inbound messages with a speaker symbol, we recommend 
utilizing the voice form. Please publish it within a library for organizational forms and distribute it throughout 
your Exchange organization.

• Find the Outlook template file FFVoice.oft in the REDIST directory, which in turn is located in the FFACCESS 
folder (<MessagingServer>\FFACCESS\Redist). Double click to open it using your Outlook client. If your 
system fails to find the appropriate program to open this file, choose Open With > Outlook.

• Image 3.36 shows an open E-Mail. This element has to be published on the new library for organizational 
forms (in this case the Organizational Forms Library). To execute this step in Outlook, open the Developer 
tab, select Publish and choose Publish Form As…

Image 3.36: Publishing the Outlook template for Voice

• The form will bear the name FFVoice (see Image 3.37 below)

• Once confirmed, all inbound voice messages will henceforth show a speaker icon within Outlook.
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Image 3.37: Publishing the template in the library for organizational forms voice

◊Note! Please create the Organizational Form Library if it is not yet existing.
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3.8. Removing a Connector
To delete a connector, select it and click on Remove (see Image 3.38).

Image 3.38: Removing a component

In the next window, select Remove Connector/Gateway Components.

Image 3.39: Welcome dialog

In the next window, you may specifically select connectors you wish to delete (see Image 3.40). This will also 
allow the removal of previous connector versions.
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Image 3.40: Selecting the respective Exchange connector

If the organization contains yet another connector, please select No. The global settings will then be retained.

Image 3.41: Deleting the global configuration object

While the Messaging Server removes the connector, it also attempts to remove global settings. However, the 
remaining connectors might require these settings. Thus, the wizard inquires whether the connector that is 
about to be removed is the last entity in the organization (see Image 3.42). If this is the case, select Yes. All 
global settings within the Active Directory will then be removed.

Image 3.42: Removing the configuration node

Execute the same procedure to remove Exchange receive connectors (Image 3.41).
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Image 3.43: Process status

Individual removal tasks are listed consecutively, as shown in Image 3.43. Select Next to conclude the removal 
process.

◊Note! You may contact the Ferrari electronic support team if errors occur during removal. In 
that case, please provide the finstallhelp.log file. The file is being updated continually 
during installation and uninstallation processes.
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3.9. Cover Pages
A fax message sent via Microsoft Exchange can hold a cover page with transmission information of the respec-
tive transmission job. Any text-processing program capable of generating RTF files can essentially generate 
cover pages as well (such as WordPad). You may add the following field types (container) to the cover pages:

• Fields with a fixed expression

• All fields that are also featured in the global address directory of Microsoft Exchange

Table 3.7: Cover page input fields

Meaning Field Name

Sender ORIGINATORNAME

Fax number of the sender ORIGINATOR

Recipient (all) RECEIVERNAME

Fax number of the recipient (all) RECEIVER

Recipient Carbon Copy (CC)(all) CCRECEIVER

Include the respective placeholders by typing

@@[Field Name]@@

Fields that contain listed content (Recipient, Fax number of the recipient, Recipient Carbon Copy, Recipient 
Blind Copy) will appear as full list on the document.

Placeholders for text attributes (Font, font size, leading etc.) will be replaced with the appropriate content.

◊Note! Attributes added to a placeholder need to be persistent throughout the placeholder 
chain. Thus, the font, font size, leading etc. must not be edited within the @ symbols. 
Furthermore, please refrain from using an explicit line feed within the placeholder.
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Example 3.9. 

Fax Message

Sender : @@ORIGINATORNAME@@
Fax extension No.: 03328 / 455-@@ORIGINATOR@@
Recipient: @@RECEIVERNAME@@
Fax No.:  @@RECEIVER@@
Send Copy to: @@CCRECEIVER@@

Subject:  @@SUBJECT@@

»End  of  examp »

Use the following syntaxes to integrate fields from a global directory into the cover page:

@@AddressIdentification_NumberfromAddressList_AddressDirectoryField@@

Table 3.8: Integrating fields from the address directory

Address Identification One of the Four Objectives FROM, TO, CC, BCC

Number from address list
E.g.: @@TO_1_DISPLAY_NAME@@ The number that represents an address within the address list

Address directory field
The name that is used for addressing the field within the global 
address directory (see Table 3.10 for reference)

Table 3.9: Sample parameter for cover pages with elucidation

Entry on Cover Page Effect

@@FROM_1_DISPLAY_NAME@@ Name of sender as displayed in 
the address directory

@@FROM_1_BUSINESS_TELEPHONE_NUMBER@@ Calling number of sender

@@TO_1_DISPLAY_NAME@@ Name of first recipient listed in 
the To-list

@@TO_1_DEPARTMENT_NAME@@ Department specification of the 
first recipient in the To-list

@@CC_2_BUSINESS_TELEPHONE_NUMBER@@ Calling number of the second 
recipient listed in the CC-list

As a message always possesses one sender only, set the Address Identification FROM to Number From Address 
List =1. You may use a dedicated syntax for the address identification TO, such as:

@@TO_*_ AddressDirectoryField@@

The asterisk character (*) serves as placeholder. While processing the address list, the Messaging Server 
gradually replaces this character with the Address directory field of the respective recipient. This feature is 
optimized for circular faxes with a comprehensive recipient list, where the cover page is supposed to show 
only the respective recipient and not the entire recipient list. The cover page will feature the entire address list 
of the TO field if you enter CC or BCC addresses.
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Example 3.10. 

Fax Message

Recipient:  @@TO_*_DISPLAY_NAME@@
Department:  @@TO_*_DEPARTMENT_NAME@@
Recipient Distributor: @@TO_1_DISPLAY_NAME@@,  
   @@TO_1_COMPANY_NAME@@
   @@TO_2_DISPLAY_NAME@@, @@TO_2_COMPANY_NAME@@
   @@TO_3_DISPLAY_NAME@@, @@TO_3_COMPANY_NAME@@
   @@TO_4_DISPLAY_NAME@@, @@TO_4_COMPANY_NAME@@
Sender:   @@ORIGINATORNAME@@
Calling Number:  @@FROM_1_BUSINESS_TELEPHONE_NUMBER@@

Subject:   @@SUBJECT@@

The cover page sent to the second recipient of the TO-list would essentially look as follows:

Fax Message

Recipient:  Johann Deutinger
Department:  Chairman
Recipient Distributor: Holger Schröder, Ferrari electronic AG
   Johann Deutinger, Ferrari electronic AG
   Peter Schröder, OfficeMaster GmbH
    Bert Mittelstedt, Ferrari electronic AG
Sender:   Holger Schröder

Calling Number:  03328 455 960

Subject:    Cover Page Design

»End  of  examp »

The cover page template incorporates placeholders for five recipients. As only four have been stated, the fifth 
entry remains blank. Should the list of recipients exceed the amount of placeholders, no entry will be made 
and the field is left blank as well.

Use the syntax on the previous page to add information of the recipient to the cover page. Please note 
that this recipient needs to be a member of the global address directory. To access the address field 
PRIMARY_FAX_NUMBER, open the tab Telephone/Remarks and enter a value into the box Fax. Ensure you 
are within the global address directory.
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◊Note! By filling out Fax, Microsoft Exchange will not create an entry that could potentially be 
used for transmission. It is shown for information purposes only.

Specify the fax number of the recipient in the tab Addressing. The fax number entered here will not be ap-
plied to any field in the address directory that could potentially be used by the Address identification Address 
Directory Field. To make the actual recipient fax number appear on the cover page, use the following syntax:

@@TO_*_RECEIVER@@

The placeholder Receiver represents the recipient fax number that has actually been used as recipient ad-
dress. It can be obtained from the address directory (Fax type address) or the TO field. The latter has to be 
filled in manually.

By applying the asterisk (*), the cover page will only feature the fax number of the recipient that ultimately 
receives the fax as opposed to listing every fax number that are part of the distribution list.

The following Table 3.10 contains a list of all designations that can be used as Address Directory Field on the 
cover page. It also specifies their location within the Active Directory User and Computer environment. Please 
note that not every attribute within the user administration is directly administrable.

Table 3.10: Address Directory Field for cover pages

Shortcut Variable
AD Users and Computers

Tab in AD Input field in Tab

AS ALIAS General Description

AT ASSISTANT

AN ASSISTANT_TELEPHONE_NUMBER

BC BUSINESS_ADDRESS_CITY Address City

BY BUSINESS_ADDRESS_COUNTRY Address Country / region

BB BUSINESS_ADDRESS_POST_OFFICE_BOX Address P.O. Box

BP BUSINESS_ADDRESS_POSTAL_CODE Address Zip/ Postal Code

BS BUSINESS_ADDRESS_STATE_OR_PRO-
VINCE Address State/province

BT BUSINESS_ADDRESS_STREET Address Street

BF BUSINESS_FAXNUMBER Telephones Fax

BH BUSINESS_HOME_PAGE General Web page

BN BUSINESS_TELEPHONE_NUMBER General Telephone number

BU BUSINESS2_TELEPHONE_NUMBER

CN CALLBACK_TELEPHONE_NUMBER

CU CAR_TELEPHONE_NUMBER

CO COMMENT Telephones Notes

CM COMPANY_MAIN_PHONE_NUMBER
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Shortcut Variable
AD Users and Computers

Tab in AD Input field in Tab

CE COMPANY_NAME Organization Company

CW COMPUTER_NETWORK_NAME

CI CUSTOMER_ID

DN DEPARTMENT_NAME Organization Department

DE DISPLAY_NAME General Display name

DP DISPLAY_NAME_PREFIX

EA EMAIL_ADDRESS

ES EMAIL_ADDRESS_SMTP General E-mail

FS FTP_SITE

GE GENERATION

GN GIVEN_NAME General First name

GI GOVERNMENT_ID_NUMBER

HO HOBBIES

HC HOME_ADDRESS_CITY

HY HOME_ADDRESS_COUNTRY

HB HOME_ADDRESS_POST_OFFICE_BOX

HP HOME_ADDRESS_POSTAL_CODE

HS HOME_ADDRESS_STATE_OR_PROVINCE

HT HOME_ADDRESS_STREET

HF HOME_FAX_NUMBER

HN HOME_TELEPHONE_NUMBER Telephones Home

HU HOME2_TELEPHONE_NUMBER

IS INITIALS General Initials

IN ISDN_NUMBER

KW KEYWORD

LE LANGUAGE

LN LOCATION

MN MANAGER_NAME

ME MHS_COMMON_NAME General (Object Name)
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Shortcut Variable
AD Users and Computers

Tab in AD Input field in Tab

MA MIDDLE_NAME

MT MOBILE_TELEPHONE_NUMBER Telephones Mobile

NN NICKNAME Exchange (Gen.) Alias

OL OFFICE_LOCATION

OI ORGANIZATIONAL_ID_NUMBER

ON ORIGINAL_DISPLAY_NAME

OC OTHER_ADDRESS_CITY

OY OTHER_ADDRESS_COUNTRY

OB OTHER_ADDRESS_POST_OFFICE_BOX

OP OTHER_ADDRESS_POSTAL_CODE

OS OTHER_ADDRESS_STATE_OR_PROVINCE

OT OTHER_ADDRESS_STREET

OU OTHER_TELEPHONE_NUMBER

PN PAGER_TELEPHONE_NUMBER Telephones Pager

PH PERSONAL_HOME_PAGE

PA POSTAL_ADDRESS

PB PREFERRED_BY_NAME

PF PRIMARY_FAX_NUMBER Telephones Fax

PT PRIMARY_TELEPHONE_NUMBER

PR PROFESSION

RN RADIO_TELEPHONE_NUMBER

SN SPOUSE_NAME

SE SURNAME General Last name

TN TELEX_NUMBER

TE TITLE General Title

TD TRANSMITABLE_DISPLAY_NAME General (Object Name)

TP TTYTDD_PHONE_NUMBER

◊Note! Please use the PRIMARY_FAX_NUMBER and not the BUSINESS_FAX_NUMBER to 
apply the fax number of a recipient or sender to a cover page.
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Any text-processing program capable of generating RTF files can essentially generate cover pages (such as 
WordPad). During administration, select the name of the respective cover page file and turn the cover page 
option on. Furthermore, the cover page file must be located in the sub-folder Cover and on the same server 
that runs the fax connector.

You may also add images to a cover page, such as company logos. However, please ensure that Microsoft 
Word had been activated during administration. Only then will the converter be capable of converting images 
into a fax format.

◊Caution! If you created the cover page with Microsoft Word, we strongly recommend using it again 
for the central conversion of a message. Microsoft Word creates RTF files that are not 
interpreted by the internal RTF converter of Microsoft Exchange or Quick View Plus, 
particularly if you used more complex formats like tables or position frames.

To minimize paper consumption and optimize the transmission time, cover pages are not generated on an 
individual page but rather precede the text body of an Exchange message. If the Exchange message contains 
no text body, you will be given the option of having no cover page created.

Server Administrators set the behavior and the eventual use of cover pages. As cover pages are saved to the 
public folder (see Table 3.2 on page 139), the server Administrator is also responsible for using adequate 
security measurements to essentially restrict unauthorized access. 

Choose one of three settings:

 ► Default Cover Page for all Microsoft Exchange Users 

The administrator can set whether the individual user is authorized to turn cover pages off. This setting 
applies to all fax messages.

 ► Default Cover Page for Each Individual User

The administrator can set a specific cover page for an individual user if required. Additionally, the user 
may be given authorization to turn automatic cover pages off whenever he transmits faxes. For this 
functionality, the same checkbox is used that also disables cover pages for all Microsoft Exchange users.

 ► Individual Cover Page for Each Transmission job

Lastly, the administrator can choose whether the user is authorized to choose a specific cover page 
for each transmission job. In doing so, the user needs to select the respective file name (RTF file). As 
mentioned further above, this file must be located on the same machine that also incorporates the fax 
connector.

◊Note! By looking at the OfficeMaster Send Options for Outlook, the users cannot conclude their 
assigned settings.
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4. Connector for Office 365 ®
This documentation describes the installation and configuration process of the Connector for Microsoft 
Office 365® of the OfficeMaster™ Server starting at version 6.0. These descriptions lay the technical ground-
work for the development of further documentations.

4.1. General

4.1.1. What is the OfficeMaster Connector for Microsoft  

Office 365?

Since OfficeMaster 4.0 an additional connector for online services is being offered with the Exchange Connec-
tor. This connector is the improved version of the successful Exchange Connector msx2kgate. 

msxbcsgate (Microsoft Exchange Business Communication Services Gateway)

We endeavor to achieve the following functions:

• Compatibility to earlier versions

• Possibility to use an existing Active Directory

• Use in On-Premise- and Hybrid settings

• Connector configurations not saved in Active Directory

• Use of known and proven administration tools

Bidirectional support of the Exchange Server transmission format (TNEF)

Benefits:

• Easy installation

• No higher authorization in the Exchange Organization necessary

• Use for Office 365 possible (Full Featured)

• No MAPI to access mailbox

• Use of existing user configurations in Active Directory at on-premise and hybrid installations

Downsides:

• SMTP-Transfer-Connectors have to be set up manually at on-premise installations

4.1.2. Range of Application

This product is an Exchange Connector for Fax, SMS and Voicebox services. It can connect all installation 
forms of Exchange Server based messaging settings.

• Connection to Microsoft Office 365
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• Connection to Microsoft Office 365 / Exchange 2016 On-Premise Hybrid

• Connection to Microsoft Exchange Server 2010 On-premise

• Connection to Microsoft Exchange Server 2013 On-premise

• Connection to Microsoft Exchange Server 2016 On-premise

4.1.3. Differences From Previous Versions

OfficeMaster versions 4 and 5 required a local Active Directory. Voice mailboxes were not supported. These 
shortcomings have been eradicated with the current product.

4.1.4. Differences From On-Premise Exchange Connector

The Online Connector MSXBCSGATE differs from the Exchange Connector msx2kgate in the following points:

• The msx2kgate traditionally requires a Microsoft Active Directory with a working Exchange Server Or-
ganization.

• The Online Connector MSXBCSGATE always saves configuration data in a datafile. It doesn’t create a node 
in an Active Directory. For that reason, the Connector doesn’t require an Active Directory.

• The Online Connector MSXBCSGATE supports the individual user configuration by optionally saving the 
data in the Active Directory to create compatibility to the msx2kgate. This compatibility is only for migra-
tory settings. The MSXBCSGATE supports saving user data directly in their mailbox. Again, the Connector 
doesn’t necessarily need an Active Directory.

• The Online Connector MSXBCSGATE supports mail transfer through a transfer mailbox (Service Transfer 
Mode). This circumvents the existing SMTP transfer through the Internet.

• The Online Connector is optimized for direct communication with the Microsoft Online Protection Endpoint. 

• The installation wizard of MSXBCSGATE supports direct communication with Microsoft Office 365.

4.1.5. General Requirements Prior Setup

To use the Connector for Office 365 an OfficeMaster installation is required. This installation has to happen 
with the option of installing the OfficeMaster for Exchange/Exchange Online Connector. Without this option, 
the Exchange management tools are not available. 

Ideally, ISDN hardware or VoiP access points should be available and in working order.

Further requirements:

• Microsoft Windows Server 2008 R2

• Microsoft Windows 8 (32Bit or 64Bit) or higher

• Microsoft .Net-Framework 4.5 Client Profile

- 210 -

Connector for Office 365 ®



Image 4.1: Exchange install options

For the use of the different work modes, different service accounts are necessary. They will be dealt with 
separately in the corresponding section on each installation.
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4.2. Connection to Microsoft Office 365™
The exclusive connection to a Microsoft Office 365 service does not require a Microsoft Active Directory. The 
Connector only needs a connection to the Internet to access the Office 365 server.

Because connecting to Microsoft Office 365 does not require an Active Directory, the user specific settings 
are saved directly to the mailbox of the appropriate user. The Connector msxbcsgate retrieves the data when 
sending or receiving documents. This connection supports all Unified Messaging services available with a 
conventional Exchange Connector.

The installation wizard automatically carries out all important installation steps in the Cloud. Technically, it is 
possible to go through each step via Office 365 admin center or Office 365 PowerShell respectively.

4.2.1. Installation Requirements

Login to Office 365 with an Organization Administrator

Installing the Connector requires an Internet connection. During the installation Office 365 requires a login. This 
login refers to the administrative account containing the rights to create objects in the Office 365 Exchange 
admin center (organization administrator).

◊Attention! The installation account is no service account. It is primarily an administrative login 
for installation purposes. This account should never be used as a service account.

Office 365 Service Account to Access Address Books

Operation of the Connector requires a separate service account or mailbox. This mailbox should be created 
manually as any user mailbox beforehand. The mailbox is used to access the global address list of the Office 365 
installation and is saved in the Connector.

◊Note! It is essential to remove the service account of the Connector from the password rota-
tion of Office 365. For this purpose the Azure AD-Module should be used. (https://msdn.
microsoft.com/de-de/library/jj151815.aspx) 

It is part of the default OfficeMaster installation. To remove the service account from 
the password rotation, use this command:

set-msoluser <ServiceAccount> -PasswordNeverExpires $TRUE
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Office 365 Service Transfer Account

The Office 365 Connector differentiates between two transfer modes:

• Service transfer mode

For the service transfer mode outgoing messages are not sent to the OfficeMaster server over the Internet, 
but are redirected to an internal Office 365 mailbox. This circumvents the time-consuming administration 
of the SMTP-line to the OfficeMaster server (MX record, Provider, etc.)

• Internet transfer mode

The Internet transfer mode is the conventional way of transferring outgoing messaged to the OfficeMaster 
server through the Internet. A unique fax and SMS domain is chosen for this purpose (e.g. fax.domain.
com, sms.domain.com). It will then be connected by an Internet provider to an MX record,  that will be 
configured to the public Internet address of the OfficeMaster server or an existing Frontend server.

To use the service transfer mode, you have to create a mailbox manually that temporarily buffers outgoing 
messages, before the OfficeMaster Server collects them. For that, the data limit for that mailbox should be 
adjusted to handle possible mass faxes.

For convenience sake the general service account can be used for this function.

◊Note! The general service account can be used as transfer account. It is essential to set an 
adequate mailbox limit and remove this account from the password rotation.

For this purpose the Azure AD-Module should be used. (https://msdn.microsoft.com/de-
de/library/jj151815.aspx). It is part of the default OfficeMaster installation. To remove the 
service account from the password rotation, use this command:

set-msoluser <ServiceAccount> -PasswordNeverExpires $TRUE

◊Caution! The service account’s mailbox and / or the transfer mailbox will be accessed by the 
connector component. The mailbox content may be processed. To prevent loss of any 
important user specific mailbox content, please do not use an existing personal user 
mailbox for this purpose.
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4.2.2. Installation

The installation of the connectors is carried out in the properties section of the “Exchange Gateway for Online 
Services” window.

Image 4.2: Installing the Connector in the configuration

An installation wizard appears. Installation and removal of components should only be carried out with the 
installation wizard.

Image 4.3: Selection dialog for installation

The welcome screen is followed by a dialog to choose the type of installation. There are three types of instal-
lation available:

1. Microsoft Office 365 as complete Cloud installation
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2. Microsoft Office 365 Hybrid installation with a local Active Directory

3. Local Exchange Server installation (On-Premise)

The first installation type is used for a pure Office 365 installation without local directory services.

To set up further installation objects within Office 365, a successful login to the Office 365-organization is 
necessary.

This should take place with an administrative account, holding appropriate organizational authority. The wizard 
will verify the login. The next step will become available only after the login has been cleared.

Image 4.4: Installation dialog and login to Office 365
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The next step allows you to choose the transport type. The transport type determines how outgoing documents 
are treated. The decision is meaningful as it determines whether the transfer of outgoing documents is to be 
conducted through the Internet or be collected in a mailbox to be retrieved by msxbcsgate.

Image 4.5: Transport type selection

 ► Messaging Server

You can select the server that will eventually run the connector component. The field shows the main 
messaging server by default. You can enter a different messaging sub-server. Should the configuration  
program fail to access certain sub servers and thus show an empty list, you can enter their names manually.

 ► Organization

In the pure Office 365-mode, this field only shows the name of the organization of the current Office 365 
login. In this case it is not editable and serves only as information.

 ► Transfer Mode

Here you can select the transfer mode. “Internet Transfer Mode” is selected by default. For reasons of 
simplicity, it is suggested to set the mode to “Service Transfer Mode”.

 ► Internet Transfer Mode

The Internet transfer mode is the conventional way of transferring outgoing documents to the Office-
Master server. “Outgoing” describes the direction from mail client to Fax server. This is usually done via 
SMTP protocol through the Internet. This form of transfer holds some drawbacks or obstacles:

• To configure the OfficeMaster server for SMTP reception from the Internet, the server or the SMTP 
reception has to be accessible through the Internet. This is generally done using Frontend-server or 
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through custom port forwarding settings. However, the OfficeMaster server is now accessible through 
the Internet. The OfficeMaster server has no SPAM or malware protection systems. If required, they 
have to be installed as third-party software.

• To correctly transport an e-mail with an SMTP domain, the selected domain (transport domain) has 
to be linked with the IP address of the OfficeMaster, meaning the transfer server (Office 365) identi-
fies the IP address of the OfficeMaster hardware. Such a configuration is set in a MX record that, in 
a global DNS server environment, is usually entered by an Internet provider.

These configurations always have to be done manually for the Internet transport of outgoing messages.

 ► Service Transfer Mode

The service transfer mode uses a dedicated mailbox for outgoing message transport, addressed by 
msxbcsgate. The emails therein—outgoing messages only—are being processed and then deleted. This 
method has advantages and disadvantages:

Advantages

• Fax and SMS addresses can be used unrestrictedly. There is no compulsory use of Fax domains or 
SMS domains.

• The transfer domain can be set at your discretion. 

• Transfer SMTP domains don’t have to be entered in global MX records.

• The OfficeMaster server doesn’t have to be available as SMTP server on the Internet. An SMTP server 
administration is unnecessary.

• A transfer of outgoing messages through the Internet does not apply. 

Disadvantages

• The transfer mailbox has to possess a suitable data limit to handle possible mass sending.

• The transfer mailbox has to be accessible by the OfficeMaster server at all times.

• The transfer mailbox should be omitted from the password rotation.

It is recommended to use the service transfer mode, allowing for more flexibility when transporting 
messages. This method allows for the use of FAX and SMS address spaces without restrictions.

 ► Transfer domains

Even though the service transfer mode makes no restrictions to FAX and SMS address spaces, it is es-
sential to enter transfer domains. Transfer domains are SMTP domain specifications that are used as Fox 
or SMS send domains. These domain specifications are also used for inbound messages. The sender can 
send their outgoing documents to faxnumber@domain. By default, domains should be specified with the 
sub-domain prefix “fax” and “sms”.

E.g. fax.exampledomain.com, sms.exampledomain.com

The domains are separated with a comma or a semicolon.
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◊Note! With the service transfer mode, the domains can be set without restrictions. With the 
Internet transfer mode, the domains have to be make known to each other on the Internet 
through an MX record. Those entries are not arbitrarily adjustable.

 ► Address spaces

When activating the address spaces, the traditional address spaces for FAX and SMS can be used in ac-
cordance with the local Exchange-Connector installation.

Apart from transfer domain addressing, users can address as follows:

• [FAX:Faxnumber]

• [SMS:Smsnumber]

In the same manner the local Outlook fax contacts can be used—when the FAX address space is activat-
ed—without explicitly changing them into SMTP addresses.

◊Note! Activating address spaces is only possible in the service transfer mode. The Internet 
transfer mode forces addressing through transfer domains.

The following step sets the service account for accessing the Office 365.

Image 4.6: Setting up the service account

Here you can choose the service account. The dialog shows all available mailboxes in the Office 365 that can 
be used as the service mailbox.
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◊Note! The service mailbox of the connector has to be removed from the Office 365’s password 
rotation list. For this purpose the Azure AD-Module should be used (https://msdn.micro-
soft.com/de-de/library/jj151815.aspx).

It is part of the default OfficeMaster installation. To remove the service account from 
the password rotation, use this command:

set-msoluser <ServiceAccount> -PasswordNeverExpires $TRUE

 ► Enable Service Account for Voicemail Services

Activating this function automatically enables the selected service account to access voicemail services. 
That is to say, the account is then able to read voice mailboxes and make telephone remote access possible. 
No further administrative steps are necessary.

◊Note! To manually open access afterwards, a connected remote PowerShell to the Office 365 
can be used:

New-ManagementRoleAssignement OfficeMasterVoiceAccess –Role 

ApplicationImpersonation –User <ServiceAccountEmailAddress>

Further information on the topic of remote PowerShell and Office 365 can be found here: 
https://technet.microsoft.com/de-de/library/jj984289(v=exchg.160).aspx

 ► Local Service Account With Access Authorization to the Local Active Directory

This item is not available in the pure Office 365 installation mode because this type of installation doesn’t 
have local Active Directory connections.

 ► OfficeMaster License Group

In the small business versions (e.g. OfficeMaster 250 for MS Exchange) the license group, that includes 
the licensed users, is entered here. By default, the license group is created automatically and is named 
“OfficeMaster License Group”. For unlimited OfficeMaster versions, this item is not accessible.

The next step in the installation configures parameters that determine the location of saved connector con-
figurations.
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 ► Filepath

Traditionally the general configuration of the component msxbcsgate is administrated through MMC con-
figurations SnapIns. With this type of connector, the configuration data is always saved in a configuration 
file. The path for this file can be set here. By default a file is suggested that is located within the OfficeMaster 
clearance FFACCESS.

Image 4.7: Installation parameters

 ► User Settings Management

In the pure Office 365 installation type the user data (fax identifier, header, front page, etc.) can only be 
saved in the user’s mailbox. There is no alternative.

 ► Global User Settings

Global user settings are presets that apply to all users, except when otherwise specified (fax identifier, 
header, cover sheet, etc.). In the pure Office 365 installation type these presets can only be saved in a con-
figuration file. It is recommended to use the same file that also contains the connector configuration data.

The necessary parameters for the installation of the connector have now been established. The connector 
can be created in the next steps.
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Image 4.8: Installing the connector Image 4.9: Finishing installation

After installation, the component should start directly and be ready for use.

Image 4.10: Components view
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4.3. Office 365™ On-Premise-Hybrid Installation
Another installation type is the hybrid installation. This corresponds to the established installation type of the 
precedent installation. Saving user settings and determining SMTP addresses requires a local Active Directory. 
The connector needs an Internet connection to access the Office 365 server. A connection to the local Active 
Directory is also required.

4.3.1. Installation Requirements

Login to Office 365 With an Organization Administrator

Installing the connector requires an Internet connection. During the installation, Office 365 will requires a 
login. This login refers to the administrative account containing the rights to create objects in the Office 365 
Exchange admin center (organization administrator).

◊Note! The installation account is no service account. It is primarily an administrative login for 
installation purposes. This account should never be used as a service account.

Office 365 Service Account to Access Address books

Operation of the Connector requires a separate service account / mailbox. This mailbox should be creat-
ed manually as any user mailbox beforehand. The mailbox is used to access the global address list of the 
Office 365 installation and is saved in the connector details.

◊Note! It is essential to remove the service account of the Connector from the password rotation 
list of Office 365. For this purpose the Azure AD-Module should be used. (https://msdn.
microsoft.com/de-de/library/jj151815.aspx) 

It is part of the default OfficeMaster installation. To remove the service account from 
the password rotation list, use this command:

set-msoluser <ServiceAccount> -PasswordNeverExpires $TRUE

Office 365 Service Transfer Account

The Office 365 Connector differentiates between two transfer modes:

 ► Service Transfer Mode

For the service transfer mode outgoing messages are not sent to the OfficeMaster server over the Internet, 
but are redirected to an internal Office 365 mailbox. This circumvents the time-consuming administration 
of the SMTP-line to the OfficeMaster server (MX record, Provider, etc.)

 ► Internet Transfer Mode

The Internet transfer mode is the conventional way of transferring outgoing messages to the OfficeMaster 
server through the Internet. A unique fax and SMS domain is chosen for this purpose (e.g. fax.domain.
com, sms.domain.com). It will then be connected by an Internet provider to an MX record,  that will be 
configured to the public Internet address of the OfficeMaster server or an existing frontend server. 
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To use the service transfer mode, you have to create a mailbox manually that temporarily buffers outgoing 
messages, before the OfficeMaster server collects them. For that, the data limit for that mailbox should be 
adjusted to handle possible mass faxes.

For the sake of convenience the general service account can be used for this function.

◊Note! The general service account can be used as transfer account. It is essential to set an 
adequate mailbox limit and remove this account from the password rotation list.

For this purpose the Azure AD-Module should be used. (https://msdn.microsoft.com/de-
de/library/jj151815.aspx). It is part of the default OfficeMaster installation. To remove the 
service account from the password rotation list, use this command:

set-msoluser <ServiceAccount> -PasswordNeverExpires $TRUE

Local Active Directory

The hybrid installation assumes that user settings can be saved in the Microsoft Active Directory. The main 
reason for this installation type is the migration of a local exchange installation to the Office 365 cloud. The local 
Active Directory, that holds the Exchange organization’s extension, remains. The user objects then possess 
the necessary attribute fields (proxyAddresses, extensionAttribute15).

Are those attributes missing, because a new Active Directory has been created during migration, or, as it was 
a new installtion the attributes have never existed, there are two ways in which to proceed:

1. Extending the Scheme to the Exchange attributes

In this case a scheme extension can still be done. Download test version of any Exchange server from the 
Internet and start the setup with the following parameter:

 Setup /PrepareScheme

Optional:

To create a global configuration node that can be saved in the Active Directory, the following command 
can create the Active Directory requirements:

 Setup /PrepareAD

Usually this is not necessary because the global configuration node is set via configuration file. This scheme 
extension should be expendable.

2. Installation as Pure Office 365 Connection

If no scheme extension is needed, the installation type “pure Office 365 Connection” can ignore the local 
Active Directory.

Local Service Account (Access to the Local Active Directory)

The connector has to possess minimal access to the local Active Directory, to authenticate the users accord-
ingly. Its reading rights within the organizational units of the domain should correspond to those needs.
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 ► Several Reasons Speak for Using a Service Account:

• Reading of configuration data of the Connector in the Active Directory

• Reading of global configuration data

• Resolving the domain’s users and reading of user data

• Writing user specific data after configuring voice parameters (unique phone number, voice box pin, etc.)

 ► This Account Should Possess the Following Authorization:

• Member of the group of domain users

• Local administrator of the computer the installation is running on

• Reading permission to the path that contains the configuration file

• (Installation option) global data: global Active Directory context

In this case the service account needs organization authorizations (Exchange-ViewOnly-Administrator). 
This setting is recommended, when there are other connectors with this setting.

• (Installation option) global data: Active Directory standard context

In this case, no additional authorizations are needed for the account.

• (Installation option) global data: shared configuration file

In this case, no additional authorizations are needed for the account.

• (Installation option) User data: Active Directory user object

If the connector is meant to change voice attributes like Pin or phone numbers of users remotely or with 
the Outlook-Client, the account needs reading access to the user objects of the connected domains. 
Saving data within the user mailbox makes this unnecessary.
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4.3.2. Setup

Installing the Connector is done in the settings of the component administration for Exchange/Online services.

Image 4.11: Create component

An installation wizard appears. Creating and deleting components should only be done with this wizard.

Image 4.12: Welcome screen
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After the welcome screen you can choose the installation type. There are three types available:

1. Microsoft Office 365 as complete Cloud installation

2. Microsoft Office 365 Hybrid installation with a local Active Directory

3. Local Exchange Server installation (On-Premise)

For the Office 365-Hybrid-Installations with local Active Directory, choose the second type. 

To set up further installation objects within Office 365, a successful login to the Office 365-organization is 
necessary.

Image 4.13: Installation Type Selection and login to Office 365

This should take place with an administrative account, holding appropriate organizational authority. The wizard 
will verify the login. The next step will become available only after the login has been cleared.

◊Note! Should you, as an exception, need to continue the installation without login, nothing 
can be set up within Office 365. In this case, leave username and password empty. The 
installation wizard will grant access to the next step anyway.

You can choose the transport type in the next step. The transport type determines how outgoing documents 
are treated.
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The decision is important as it determines whether the transfer of outgoing documents is to happen through 
the Internet or be collected in a mailbox to be retrieved by MSXBCSGATE.

Image 4.14: Transport type selection

 ► Messaging Server

You can select the server that will eventually run the Connector component. The field shows the main 
messaging server by default. You can enter a different messaging sub-server. Should the list be incomplete 
because the configuration program cannot access certain sub-servers, you can enter their names manually.

 ► Organization

This box shows the name of the organization of the current Office 365 login. In this case it is not editable 
and serves only as information. If you skipped the login earlier, you can enter the name of an organization 
or some suffix of a domain here. This can serve as a guideline for the transfer domains. 

 ► Transfer Mode

Here you can select the transfer mode. By default “Internet Transfer Mode” is selected. For reasons of 
simplicity, it is suggested to set the mode to “Service Transfer Mode”.

 ► Internet Transfer Mode

The Internet Transfer Mode is the conventional way of transferring outgoing documents to the Office-
Master Server. “Outgoing” describes the direction from mail client to Fax server. This is usually done via 
SMTP protocol through the Internet. This form of transfer holds some drawbacks or obstacles:

• To configure the OfficeMaster server for SMTP reception from the Internet, the server or the SMTP 
reception has to be accessible through the Internet. This is generally done using Frontend-Server or 
through custom port forwarding settings. However, the OfficeMaster server is now accessible through 
the Internet. The OfficeMaster server has no SPAM or malware protection systems. If required, they 
have to be installed as third-party software.
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• To correctly transport an e-mail with a domain designation, the selected domain (transport domain) 
has to be linked with the IP address of the OfficeMaster. This enables the transfer server to determine 
the address of the respective OfficeMaster computer. Such a configuration is set in an MX record 
that, in a global DNS server, is usually entered by an Internet provider.

For the Internet transport of outgoing messages, these configurations always have to be entered manually.

 ► Service Transfer Mode

The service transfer mode uses a dedicated mailbox for outgoing message transport, addressed by 
msxbcsgate. The emails therein—outgoing messages only—are being processed and then deleted. This 
method has advantages and disadvantages:

Advantages

• FAX and SMS addresses can be used unrestrictedly. There is no compulsory use of fax domains or 
SMS domains.

• The transfer domain can be set at your discretion. 

• Transfer SMTP domains don’t have to be entered in global MX records.

• The OfficeMaster server doesn’t have to be available as SMTP server on the Internet. An SMTP server 
administration is unnecessary.

• A transfer of outgoing messages through the Internet does not apply. 

Disadvantages

• The transfer mailbox has to possess a suitable data limit to handle possible mass sending.

• The transfer mailbox has to be accessible by the OfficeMaster server at all times.

• The transfer mailbox should be omitted from the password rotation list.

It is recommended to use the service transfer mode, allowing for more flexibility when transporting 
messages. This method allows for the use of FAX and SMS address spaces without restrictions.

 ► Transfer Domains

Even though the service transfer mode makes no restrictions to FAX and SMS address spaces, it is essential 
to enter transfer domains. Transfer domains are SMTP domain specifications that are used as Fox or SMS 
send domains. These domain specifications are also used for inbound messages. The sender can send 
their outgoing documents to faxnumber@domain. The domains should be set with sub-domain prefixes 
“fax” and “SMS” as default.

E.g. fax.exampledomain.com, sms.exampledomain.com

The domains are separated with a comma or a semicolon.

◊Note! With the service transfer mode, the domains can be set without restrictions. With the 
Internet transfer mode, the domains have to be make known to the Internet through an 
MX record. Those entries are not adjustable at will.
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 ► Address Spaces

When activating the address spaces the traditional address spaces for FAX and SMS can be used in accor-
dance with the local Exchange-Connector installation.

Users can address, in addition to the transfer domain addressing, in the following manner:

• [FAX:Faxnumber]

• [SMS:Smsnumber]

Likewise, the local Outlook fax contacts can be used—when the fax address space is activated—without 
explicitly changing them into SMTP addresses.

◊Note! Activating address spaces is only possible in the service transfer mode. The Internet 
transfer mode forces addressing through transfer domains.

The following step sets the service account for accessing the Office 365 and the local domain.

Image 4.15: Setting up the service account

Here you can choose the service account. The dialog shows all available mailboxes within Office 365 that can 
be used as the service mailbox.

◊Note! The service mailbox of the connector has to be removed from the password rotation list 
of the Office 365. For this purpose the Azure AD-Module should be used (https://msdn.
microsoft.com/de-de/library/jj151815.aspx).

It is part of the default OfficeMaster installation. To remove the service account from 
the password rotation list, use this command:
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set-msoluser <ServiceAccount> -PasswordNeverExpires $TRUE

 ► Enable Service Account for Voicemail Services

Activating this function automatically enables the selected service account to access voicemail services. 
The service account is then capable of reading voice mailboxes and making telephone remote access 
possbile. No further administrative steps are necessary.

◊Note! To manually open access afterwards, a connected remote PowerShell to the Office 365 
can be used:

New-ManagementRoleAssignement OfficeMasterVoiceAccess –Role 

ApplicationImpersonation –User <ServiceAccountEmailAddress>

Further information on the topic of remote PowerShell and Office 365 you can find online 
here: https://technet.microsoft.com/de-de/library/jj984289(v=exchg.160).aspx

 ► Local Service Account With Access Authorization to the Local Active Directory

This item is not available in the pure Office 365 installation mode because this type of installation doesn’t 
have local Active Directory connections.

 ► OfficeMaster License Group

In the small business versions (e.g. OfficeMaster 250 for MS Exchange) the license group, that includes 
the licensed users, is entered here. By default, the license group is created automatically and is named 
“OfficeMaster license group”. For unlimited OfficeMaster versions this item is not accessible. This group is 
deposited within the Active Directory if hybrid installation was chosen

The next step in the installation configures parameters, deciding where the connector configurations are to 
be saved.

Image 4.16: Installation parameters
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 ► Filepath

Traditionally the general configuration of the component msxbcsgate is administrated through MMC con-
figurations SnapIns. With this type of connector, the configuration data is always saved in a configuration 
file. The path for this file can be set here. By default a file is suggested that is located within the OfficeMaster 
clearance FFACCESS.

 ► User Settings Management

The hybrid installation type offers two ways of installation:

• Active Directory – User Object

This is the recommended standard, if the current Active Directory is able to accept user specific data.

• User mailbox

User specific data can also be saved in the user mailbox. This may be useful when the current Active 
Directory doesn’t have an Exchange scheme extension or if you have plans to remove the local Active 
Directory.

◊Note! If you used to run an older version of the Ferrari electronic AG’s Exchange-Gateway, and 
user specific data already exists in the Active Directory, they remain compatible. If you 
then change the mode of user management to user mailbox, the data from the Active 
Directory has to be migrated to the Office 365 mailboxes, by way of special programs. 
Otherwise the Active Directory will not be accessed.

 ► Global User Settings

Global user settings are presets that apply to all users, except when otherwise specified (fax identifier, 
header, cover sheet, etc.). In the pure Office 365 installation type these presets can only be saved in a con- 
figuration file. It is convenient to use the same file here that also contains the connector configuration data. 
The standard setting assumes that the data is saved in the existing Active Directory. This setting exists for 
compatibility reasons with the previous version. It is useful, if such a global configuration node has been 
installed by the previous product.

◊Note! If no global configuration node exists, it is recommended to use a shared configuration file.
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The necessary parameters for the installation of the connector have now been established. The connector 
can be installed in the next steps. After installation the component should start directly and be ready for use.

Image 4.17: Installation finished
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4.4. Local Exchange Server Installation
A special installation type is the local Exchange server installation (On-Premise). This type is similar to the 
installation of the Exchange gateway MSX2KGATE. Saving user settings and determining SMTP addresses 
requires a local Active Directory. The Connector needs nothing but a LAN connection to access the local 
Exchange Server.

The local installation is usually supported by the typical Exchange-gateway MSXBCSGATE. Installing the 
previous version made it necessary on some local environments to use the gateway MSXBCSGATE. The 
reason generally was due to access problems via MAPI (Message Application Programmers Interface) and 
with access authorization to the Active Directory (configuration node couldn’t be created because of missing 
authorization). To remain compatible to those installations, the local Exchange Server installation type is 
supported by the MSXBCSGATE.

The installation wizard automatically carries out all important installation steps. After installation you have 
to adjust it to the Exchange Server. No object in the Exchange Server organization is created automatically.

◊Attention! The installation is based on bidirectional E-Mail transfer. For that reason the installation 
wizard installs a distinctive SMTP-server and opens port 25. This kind of installation 
should therefore not be done on an Exchange server itself. An Exchange server has its 
own connection to the port 25. The installation of an OfficeMaster server with a local 
installation type of msxbcsgate should always run on a dedicated server.

Should this be impossible, you have to configure an alternative port for the component 
smtprx where the Exchange server can send the documents.

4.4.1. Installation Requirements

Service Account to Access Address Books and the Local Active Directory

Operation of the Connector requires a separate service account or mailbox. This mailbox should be creat-
ed manually as any user mailbox beforehand. The mailbox is used to access the global address book of the  
Exchange server and is saved in the Connector.

Local Service Account (Access to the Active Directory)

The Connector needs minimal access to the local Active Directory to authenticate users. Authorize the reading 
access in the organizational units of the domains.

Using a service account has several reasons:

• Reading of the configuration data of the Connector saved in the Active Directory

• Reading of global configuration data

• Resolving domain users and reading of user data

• Writing of user-specific data after configuring voice parameters (unique phone number, voice box pin, etc.)

Such an account should possess the following authorization:

• Member of the group of domain users
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• Local administrator of the computer the installation is running on

• Reading permission to the path that contains the configuration file

• (Installation option) global data: global Active Directory context

In this case that service account needs organization authorizations (Exchange-ViewOnly-Administrator). 
This setting is suggested, when there are other Connectors with this setting. Starting with Exchange 2010 
the Active Directory read authorization of the organization can be done through a membership in the 
group Exchange Public Folder administration.

• (Installation option) global data: Active Directory standard context

In this case the account does not need an additional authorization.

• (Installation option) global data: shared configuration file

In this case the account does not need additional authorization.

• (Installation option) User data: Active Directory -User Object

If the Connector is meant to change voice attributes like Pin or phone numbers of users remotely or with 
the Outlook-Client, the account needs reading access to the user objects of the connected domains. 

4.4.2. Installation

Installing the Connectors is done in the settings of the component administration for Exchange/Online services.

Image 4.18: Create component
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An installation wizard appears. Creating and deleting components should only be done with this wizard.

Image 4.19: Welcome screen

After the welcome screen you can choose the installation type. There are three types available:

1. Microsoft Office 365 as complete Cloud installation

2. Microsoft Office 365 Hybrid installation with a local Active Directory

3. Local Exchange Server installation (On-Premise)

For the local installations, choose the third type.

There is no explicit login to the Exchange Server necessary.

Image 4.20: Select installation type
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The next step allows you to choose the transport type. The transport type usually determines how outgoing 
documents are treated.

Image 4.21: Transport type selection

The local Exchange server installation doesn’t offer an alternative to the SMTP transport. A temporary mailbox 
is unnecessary within the local network.

 ► Messaging Server

You can select the server that will run the connector component in the end. The field shows the main mes-
saging server by default. You can enter here a different messaging sub-server. Should the list be incomplete, 
because the configuration program cannot access some sub-servers, you can enter the favored names 
manually.

 ► Exchange Server

To communicate with an Exchange server, it has to be set as the standard partner of communication. You 
can enter a fully qualified domain name (FQDN) or a NetBIOS name. You should refrain from entering an 
IP address, because this entry is used to generate a display name.

 ► Transfer Mode

You cannot choose another transfer mode. This installation type only supports SMTP transfer. 

 ► Transfer Domains

The transfer domains are reference points for the installation to use when transmitting messages. The 
Connector will register with the OfficeMaster server for those domains.

The sender can send their outgoing documents to faxnumber@domain. By default, domains should be 
specified with the sub-domain prefix “fax” and “sms”.

• E.g. fax.exampledomain.com, sms.exampledomain.com
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◊Note! The domains are separated with a comma or a semicolon. The transfer domains are 
entered here for registration purposes only. Whether emails from the Exchange server 
make it to the OfficeMaster server with this domain setting is dependent from the manual 
administration of the Exchange server.

 ► Address Spaces

Even though the installation supports the use of address spaces, they cannot be defined at this point. During 
installation, you cannot exert influence on address spaces.
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The following step sets the service account to access the Exchange server and the local domain. 

Here you can choose the service account. You may decide on different service accounts to access the Exchange 
server (Exchange Web Services) and the local Active Directory. But this is optional. It is recommended to use 
the same account for both types of access.

Image 4.22: Setting the service account

 ► Enable Service Account for Voicemail Services

This item is not available in this installation type. If you want to use voicemail services, you have to activate 
the account manually for OfficeMaster voicemail services.

◊Note! You can use the Exchange-PowerShell to do this manually:

New-ManagementRoleAssignement OfficeMasterVoiceAccess –Role 

ApplicationImpersonation –User <ServiceAccountEmailAddress>

 ► Local Service Account with Access Authorization to the Local Active Directory

Here you can set a separate account for the access to the Active Directory.

 ► EWS (Exchange Web Services) Service Account to use as Active Directory Access Account

Ticking this box copies the data for the Exchange access account (EWS service account) into the spaces 
for the Active Directory service account.

◊Note! It is generally recommended to use the same service account for the access to the Ex-
change server (Exchange Web Services) and to the Active Directory.
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 ► OfficeMaster License Group

In the small business versions (e.g. OfficeMaster 250 for MS Exchange) the license group, that includes 
the licensed users, is entered here. By default, the license group is created automatically and is named 
“OfficeMaster License Group”. For unlimited OfficeMaster versions, this item is not accessible. 

The next step will deal with the local configuration parameters that are saved within the connector configuration.

Image 4.23: Installation parameters

 ► Filepath

Traditionally the general configuration of the component msxbcsgate is administrated through MMC con-
figurations SnapIns. With this type of connector, the configuration data is always saved in a configuration 
file. The path for this file can be set here. By default a file is suggest that is located within the OfficeMaster 
clearance FFACCESS.

 ► User Settings Management

The local Exchange server installation type offers two alternatives at this point:

 ► Active Directory User Object

This is the recommended default. 

 ► User Mailbox

As an alternative the user data can be saved within the user mailbox. This is not advisable for the local 
installation.
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◊Note! If you used to run an older version of the Ferrari electronic AG’s Exchange-Gateway, and 
user specific data already exists in the Active Directory, they remain compatible. If you 
then change the mode of user management to user mailbox (not recommended), the 
data from the Active Directory has to be migrated to the Office 365 mailboxes, by way 
of special programs. Otherwise the Active Directory will not be accessed.

 ► Global User Settings

Global user settings are presets that apply to all users, except otherwise specified (fax identifier, header, 
cover sheet, etc.). In the pure Office 365 installation type these presets can only be saved in a configura-
tion file. It is recommended to use the same file here that also contains the Connector configuration data. 
The standard setting assumes that the data is saved in the existing Active Directory. This setting exists for 
compatibility reasons with the previous version. It is useful, if such a global configuration node has been 
installed by the previous product.

◊Note! If no global configuration node exists, it is recommended to use a shared configuration file.

The necessary parameters for the installation of the connector have now been established. The connector 
can be installed in the next steps. 

After installation the component should start directly and be ready for use.

Image 4.24: Component Overview
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4.4.3. Objects to be Manually Created in a Local Exchange  

Environment

If the connector is to be installed in a local exchange server environment, it has to be made certain  that out-
going emails are routed directly to the messaging server. This is generally achieved using a send connector 
or SMTP connector. The following base values can be configured:

 ► Object

SMTP transfer Connector

 ► Type

SMTP Smart host communication

 ► Send server

Exchange Server to be send from (Source server, Local Bridgehead)

 ► Smarthost

IP address, name or FQDN of the OfficeMaster server

This kind of send connector can accept the desired transfer domains into its address spaces. You can also 
configure the FAX and the SMS address space here. We want to show creating a transfer Connector using the 
example of an Exchange server 2016.

Communication with an OfficeMaster server doesn’t require an authentication. (The name “OfficeMasterServer” 
in the Smart host field is an example. Please use the correct name or IP address of the server you are using!)

Image 4.25: Create transfer Connector Image 4.26: Add Smarthost
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Image 4.27: Add authentication Image 4.28: Configure address spaces / Transfer domains

As the last step the source server is added. The Exchange Server is now able to send documents to the Of-
ficeMaster.

Image 4.29: Add source server

Because the OfficeMaster sends its own documents to the Exchange server, a receiving connector is necessary. 
The component MSXBCSGATE, on standard settings, doesn’t require authentication, which is why the stan-
dard SMTP receiving connector or a separate connector should be made accessible for anonymous reception.
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4.5. Configuration

4.5.1. Messaging Server Configuration

The exclusive connection to a Microsoft Office 365 service does not require a Microsoft Active Directory. The 
Connector only needs a connection to the Internet to access the Office 365 server.

Even though the connectors save all relevant settings in a configuration file to integrate into the Exchange 
server environment, the smooth operation of all components is insured by base settings within the messenger 
configuration.

Basic settings are located in the tab “Exchange-Connector-Parameter”.

Image 4.30: Messaging Server Configuration

Exchange Connector Parameter

These values are filled in by the installation wizard. They contain the name of the connector, the FQDN of the 
target server, the path of the configuration file and more.

◊Note! The basic settings can be configured in expert mode, but manual administration is not 
recommended. The base values should only be set by the installation program. Manual 
changes can have severe consequences for the operation of the components.

 ► MS Exchange Connector

This field shows the name of the connector component. It exists for information purposes only and cannot 
be edited. 
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 ► MS Exchange Server

This field cannot be edited as well and, for information purposes, contains the selected server.

 ► Connector Administration Point

The Connector administration point is the configuration file that should contain the actual configuration 
of the connector. This parameter exists for backup purposes only and should never be changed without 
employing the installation wizard.

 ► Global Administration point

The global administration point is the place to save global user presets. You can only change the general 
access mode.

 ► Microsoft Active Directory

In this mode, the connector searches for the global point within the configured Active Directory

 ► Configuration file

In this case, the connector uses the selected file to read the global user data.

This parameter exists for backup purposes only and should never be changed without using the installation 
wizard.

 ► MS Active Directory – Binding

The fields ‘Active Directory Binding’ can be filled with a username and password that the connector can 
use to access the configured Active Directory. With a pure Office 365 binding the fields are empty.

 ► Replicate Metacache

The configuration includes a button to replicate the metacache outside the usual interval. This feature has 
been implemented solely for testing.

 ► Signature Component

To support digital signatures you can choose a signature component here. This signature component works 
closely with the connector component to provide this feature.

 ► Status Component

A status component is an additional component that is informs about the progress of sent fax documents 
or SMS messages. You could enter an archive gateway here, for example.

 ► Status Options

The status options help optimize and adjust the interaction between components.
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 ► Status Messages for SAP Using the User Address

If the connector msxbcsgate is used by an SAP-Gateway as status component, there are several pos-
sible ways for the SAP connector to store sender information inside the job. The basis for the sender 
information is the internal field UserAddress.

 ► Status Messages for SAP Using the User Name

The criterion for the sender is here the internal field UserName

 ► Suppress Mail Notifications

If the connector msxbcsgate is used with a filegw component (file interface) or an lpd component (printer 
component), the connector can send the document automatically via SMTP, as long as an email address 
is provided. Sending is done using the connected Exchange server. Completing this Exchange relay, the 
connector receives a report, stating whether or not the mail has been accepted by the server. Because 
this report contains no information if the email reached it’s final destination, but only about a step on 
the way, many users like to ignore this report altogether. This can be done by checking this box.

 ► Requeue Interval

If the connector msxbcsgate fails to deliver the message to the target system (because of servicing, prob-
lems converting, print problems), the job is repeated. The delay, in minutes, until resend (requeue) can be 
set here.

 ► Concurrent Jobs

The connector is able to process several jobs at once. You can set here a maximum to the number of jobs 
it will process simultaneously.

◊Note! A value above 20 doesn’t improve performance. 10 is the ideal number for current sys-
tems. This corresponds to the standard setting. To force sequential processing, set the 
value to 1 (this should be limited to testing). We recommend using a value between 8 
and 15.

 ► Transfer Log / Optimize File Format for Spreadsheet Tools

The component msxbcsgate writes one log per day containing every incoming jobs that were processed. This 
file also contains phone numbers written in the format E.164. Spreadsheet tools often change this format (e.g. 
+49332845590) to one with a floating point (+49332845590 is changed to 4,93E+10). These applications 
also tend to omit leading zeros. To mark these entries as text, an inverted comma can be set ahead of them. 
Modern spreadsheet applications will then keep the string as it is.

Tab Receive

The tab “Receive” has direct impact on incoming documents. The called party numbers can set as address 
filters for Fax and SMS. 
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Using the standard setting (.*) all received fax or short messages will be relayed to the Exchange-Connector. 
Change is only necessary if received messages are to be send to different gateways, like SAPCONN or FILEGW.

Image 4.31: Messaging Server Configuration (Receive)
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4.5.2. OfficeMaster Exchange Administration

If you chose “OfficeMaster for Exchange/Exchange Online Connector” during installation of the server, the 
OfficeMaster Exchange administration console is available. This console expands the Exchange Server 2010 
administration console and possibly constitutes its own administration node. The setup changed with the new 
version. After activating the console from the available program symbols, the following screen is displayed.

Image 4.32: OfficeMaster Exchange Administration

Traditionally, OfficeMaster Exchange Connectors are configured using MMC SnapIns, which integrate into Ex-
change server administration tools, if available, or into Active Directory administrations. The Exchange Server 
2010 administration console is expanded into the organization configuration node, the server configuration 
node and the user configuration node, by the OfficeMaster Exchange administration.

Using the OfficeMaster Exchange administration, you can easily configure individual user settings as well as 
connector settings.

The areas highlighted in the above image will now be explained:

1. OfficeMaster Basic Configuration Node

The OfficeMaster basic configuration node is the highest level of the OfficeMaster Exchange administration. 
Clicking this node in the scope pane (left hand side) the result pane (middle) shows the main administration 
dialog to add tenants that can be configured.

2. Configuring a Local Exchange Server Installation

The area of the local Exchange server installation is the traditional view of the local exchange organization 
as set by the current Windows login. You can find the very same area in the extended Exchange 2010 
administration console. From the local tenant area you can turn displaying the local administrations off.
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3. Local Tenant Area

The local tenant area lets you add on-premise Exchange organizations. The console will then establish a 
connection to the latest Active Directory.

4. Cloud/Office 365 Organization Area

The Cloud/Office 365 organization area lets you add pre-installed Cloud/Office 365 organizations. The 
new organizations are shown in the scope pane (left hand side) as new base nodes of equal rank to the 
local Exchange Server administration. Cloud/Office 365 base nodes are not shown in the Exchange 2010 
administration console.

4.5.3. Configuring an Office 365 Installation Without a Local Ac-

tive Directory

Because the pure Office 365 installation doesn’t have a local Active Directory, you should deactivate the local 
administration by checking the box in the local tenant area. The nodes will then be removed from the scope 
pane. For the configuration of Office 365 connectors, add a new organization in the Cloud/Office 365 orga-
nization area.

Image 4.33: Remove local Exchange administration and add Cloud installation

After clicking “Add” a wizard opens showing the parameters of the new organization. Label your new orga-
nization adequately here. Then set the standard username for the access to the Office 365. You could enter 
the password, but it would be saved in a configuration table. For security reasons we don’t recommend this. 
Leave the password field empty. After that, you can enter the connector configuration file.
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Image 4.34: Add a new Cloud organization Image 4.35: Enter the configuration file

After choosing the shared Connector configuration file that has been used during the installation of the con-
nector, a window opens asking for the appropriate connector. Choose carefully, since the file may contain 
more then one connector.

Image 4.36: Choose the connector Image 4.37: Prepopulated configuration parameters

After choosing the connector, the configuration dialog should appear prepopulated. Please check the data 
and check marks carefully.

 ► Connector Configuration File

Enter the same configuration file here, that you set when installing the connector.

 ► Active Directory / Office 365 Cloud Hybrid  Installation

Activate this option to prepare the administration to access an Active Directory. When installing a pure 
Office 365 environment, this option is deactivated.

 ► OfficeMaster Basenode in Active Directory

Enter where the global user data is located at. Activate this function when an Active Directory node contains 
the data. If the data cannot be found there, you have to enter a configuration file that contains the global 
user data.
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 ► Configuration File of the Basenode

Enter the configuration file that contains the global user data here, if you selected the corresponding an-
swer during the connector installation. Usually this field will be filled in automatically after choosing the 
connector configuration file.

 ► Use Local Login for Active Directory Access

Usually, a server and an access account can be used to access an Active Directory. Activating this option 
makes optional user data inapplicable. The Windows login account will then be used to access the Active 
Directory.

This field should fill automatically after choosing the connector configuration file.

 ► User Configuration Based on Active Directory Entries

The administration has to know how the OfficeMaster user settings are saved to correctly deal with the 
settings. Activating this option means, that user data will be read from and saved to the Active Directory. 
Leaving this option inactive, the settings will be read from and saved to the user mailbox.

This field should be filled automatically after choosing the connector configuration file.

Enter login data to an Active Directory in the next step. For a pure Office 365 installation, these fields remain 
empty.

Image 4.38: Active Directory login data Image 4.39: Extended parameters

The last screen of the wizard asks for extended parameters. They should not be changed. Those parameters 
are the basis for the connection to the Office 365.

After the wizard closed, a “New Office 365 Organization” appears in the scope pane (left hand side). By clicking 
the node “Authentication”, you can connect to Office 365.

Image 4.40: A new organization has been added
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The new organization can be edited or removed in the Cloud/Office 365 organization area.

Image 4.41: List of Office 365 organizations

Each added organization requires an interactive authentication.

Image 4.42: Connecting to an Office 365

After completing the login, the area nodes for organization configuration, connector configuration and recipient 
configuration become available.

Image 4.43: Overview - configurations

You can now configure the connector and the user. The new configuration is visible for all user logins on the 
local computer.
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4.5.4. Configuring an Office 365-On-Premise-Hybrid Installation

Even though the Office 365-On-Premise-Hybrid installation uses a local Active Directory, logging in to Office 
365 may become necessary. This depends on where user specific settings are saved. The local administration 
should therefore be deactivated by checking the box in the local tenant area. The nodes will then be removed 
from the scope pane. For the configuration of Office 365 connectors, add a new organization in the Cloud/
Office 365 organization area.

Image 4.44: Remove local Exchange administration and add Cloud installation

After clicking “Add”, a wizard opens, showing the parameters of the new organization. Set an adequate name 
for your new organization here. Then set the standard username for the access to Office 365. You could enter 
the password here, but it would be saved in a configuration table. For security reasons we don’t recommend 
this. Leave the password field empty. After that, you can enter the connector configuration file.
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Image 4.45: Add a new Cloud organization Image 4.46: Enter the configuration file

After choosing the shared Connector configuration file that had been used during the installation of the con-
nector, a window opens asking for the appropriate Connector. Choose carefully, since the file may contain 
more then one Connector.

Image 4.47: Choose the connector Image 4.48: Prepopulated configuration parameters

After choosing the Connector, the configuration dialog should appear automatically filled in. Please check the 
data and marks carefully.

 ► Connector Configuration File

Enter the same configuration file here, that you set when installing the connector.

 ► Active Directory / Office 365 Cloud Hybrid Installation

Activate this option to prepare the administration to access an Active Directory. When installing a pure 
Office 365 environment, this option is deactivated. For hybrid installations this is the default.

 ► OfficeMaster Basenode in Active Directory

Enter where the global user data is. Activate this function when an Active Directory node contains the data. 
If the data cannot be found there, you have to enter a configuration file that contains the global user data.
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 ► Configuration File of the Basenode

Enter the configuration file that contains the global user data here, if you selected the corresponding an-
swer during the Connector installation. Usually this field will be filled in automatically after choosing the 
connector configuration file.

 ► Use Local Login for Active Directory Access

Usually to access an Active Directory you can use a server and an access account. Activating this option 
makes optional user data inapplicable. The Windows login account will then be used to access the Active 
Directory.

This field should fill automatically after choosing the Connector configuration file.

 ► User Configuration Based on Active Directory Entries

The administration has to know how the OfficeMaster user settings are saved to correctly deal with the 
settings. Activating this option means that user data will be read from and saved to the Active Directory. 
Leaving this option inactive, the settings will be read from and saved to the user mailbox.

This field should fill automatically after choosing the Connector configuration file.

Image 4.49: Active Directory login data

 ► Domain Controller List

You can provide a list of domain controllers (AD service providers) for the connection to the Active Direc-
tory. You can enter fully qualified domain names, NetBIOS names or IP addresses. If you leave this field 
empty, the ADSI (Active Directory Service Interface) will attempt to automatically find the closest domain 
controller of the current Windows login.

 ► Username and Password

The login data defines which account is going to be used. Enter the username as DOMAIN\Username.

 ► Port

Communication with the Active Directory is usually done through secure RPCs (Remote Procedure Calls). 
You can also use a dedicated communication port for LDAP (Lightweight Directory Access Protocol Port 
389). Communication via LDAP is slower than the standard connection. To use the standard connection, 
leave the field empty or enter a zero.
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The last screen of the wizard asks for extended parameters. They should not be changed. Those parameters 
are the basis for the connection to Office 365.

Image 4.50: Extended parameter

After the wizard closed, a “New Office 365 Organization” appears in the scope pane (left hand side). By clicking 
the node “Authentication”, you can connect to Office 365.

Image 4.51: A new organization has been added

The new organization can be edited or removed in the Cloud/Office 365 organization area.
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Each added organization requires an interactive authentication.

Image 4.52: Connecting to Office 365 and an Active Directory

After completing the login, the area nodes for organization configuration, Connector configuration and  
recipient configuration become available.

Image 4.53: Overview - configurations

You can now configure the Connector and the users. The new configuration is visible for all user logins on the 
local computer.
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4.5.5. Configuring a Local Exchange Server Installation

Supporting a local Exchange server installation with the component msxbcsgate is a special case, because 
the functionality is included in msx2kgate. Should you encounter this special case, use the local Exchange 
administration for configuration. The local Exchange administration should remain active.

Image 4.54: Use local Exchange administration

The next steps are dependent on the kind of installation. During the installation of the Connector, you provided 
a place to save global user data. Should this place be an Active Directory, you don’t have to add anything to the 
organization configuration. The basenodes in the local Active Directory will be shown automatically. Should 
your data be stored in a configuration file, you have to add this file to the configuration.

Image 4.55: Add local basenode (file)
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After adding this file, you can configure the global user data.

To configure the Connector’s settings (msxbcsgate component, „Connector for BCS“), you have to add the 
configuration file to the connector configuration.

Image 4.56: Add connector configuration file

The Connector will appear in the list of Exchange Connectors after you added its configuration. You can now 
adjust its settings.

Configuration files that were added in the local Exchange configuration are only visible for the current user.

You don’t have to become active in the node “User Settings”. The user objects will be shown automatically 
and can be configured right away.

4.5.6. Configuring Global User Data

The global user data are managed in the organization configuration in the settings of the basenode.

Image 4.57: Configuration of base node (global user data)
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General Settings

Here you can adjust general settings that receive attention globally. All OfficeMaster Exchange Connectors of 
the organization will be based on these settings.

Image 4.58: Tab Global Connector Settings

 ► Global Directory (for Front Pages etc.)

To store front pages, signature files, stationery 
and caller images you have to set a global direc-
tory as UNC path that matches the structure of 
the FFACCESS clearance. This means, that the 
connectors expect sub-directories with the names 
of COVER (front pages), LETTER (stationary files), 
SIGN (signature files) and PICTURE (caller imag-
es). Administrating these folders is only useful, if 
there are several OfficeMaster Connectors in one 
organization. During installation this folder might 
be subject to change. The administrator can, in 
agreement with the operators of the other con-
nectors, set a root directory. Choosing “save global 
settings in local domain” during installation creates 
a global directory at every site.

 ► Language

You can choose between German, English, French, Italian and Spanish as the language the Connector dis-
plays notifications to users. You can change this setting for each recipient in the corresponding settings.

 ► Notifications

The OfficeMaster-Connectors are able to send notifications as well as incoming documents in different 
layouts. You can choose between the following internal options:

 ► Text Only

Documents will be created as emails with an entire text content. This setting creates the highest com-
patibility to all user applications the Exchange server can be connected with.

 ► HTML-Layout Neutral, OfficeMaster and Outlook

HTML-Layouts add design to the message. The message is created in HTML format and the first page 
of the attachment of the fax document is a preview. 

Feedback includes the converted attachment files individually, therefore the first page of each attachment 
file is displayed in the message. The format of the included preview file (PNG) is independent from the actual 
attachment file format. The three internal layouts you can choose from contain different color designs. The 
administrator can choose the layout. The standard layout is OfficeMaster.
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 ► HTML Template

In addition to the HTML templates included, you can load external templates for more specific designs. They 
are created using a special HTML/XML variant and can be saved with the normal RTF cover pages in the 
global cover directory. These special template files (*.HTL) save entire language sets to HTML templates 
and can positively transform the appearance of incoming documents and ,if applicable, adjust them to 
your corporate design. The HTL editor and a documentation of the HTL script language can be found in 
the directory <SERVER>\FFACCESS\Redist\Tools.

 ► Identifying Sender and Recipient

The connectors can resolve incoming and outgoing telephone numbers. You can set in which directories 
contact information can be searched for by default.

 ► Global Address Book / Microsoft Active Directory

When choosing this option, incoming caller identification and outgoing cover page information are taken 
from Active Directory user data or Active Directory contact data. This option ensures that only internal 
calls are resolved, because contact data is usually not stored in the Active Directory.

 ► Private Contacts (User- Mail- Profile)

Private Contacts are contact information stored to the E-Mail profile of the sender or for incoming docu-
ments of the recipient. They do not refer to private folder files (PST file) embedded in the email profile, 
but rather to the contacts folder of the email profile. Note that you can only use this function if the 
service account of the connector component has sufficient reading rights to the mailbox storage of the 
corresponding user.

 ► Public Folder

The connectors usually resolve cover page fields and information from senders of incoming and outgoing 
documents and messages from the address book. As most of this sender information is not saved as 
an Active Directory contact, but as an element in global folders, this setting allows the connectors to 
use this as data source. It essentially uses the first contact element. Although duplicates are narrowed 
down by their display name, they are not recognized as errors because no other information is used to 
find the data.

◊Note! The search within private contacts and global folders are processed in real time for each 
of the settings. Such processes can take a considerable amount of time. As an alterna-
tive, the connectors can use the meta-cache database which works independently of 
this setting.

 ► Fax Send Defaults

 ► Business Cards (VCARDS) as Additional Page

In Microsoft® Outlook you can choose to attach the electronic business card of Outlook to the message. 
This option, common to emails, can also be activated for sending faxes. The business card is then con-
verted into an additional page of the fax.
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 ► Use 64k Connection by Default

The OfficeMaster card supports the standard fax protocol G3C that, within fax group 3, allows transmis-
sion with a speed of 64 kBit/s on ISDN lines. In this case, with using the OfficeMaster Gate, it attempts 
to both establish and transmit the fax or the file with this speed. If the connection is successful, the time 
and money saved is of considerable importance. Should the connection fail, because the recipient is 
incapable of accepting the data stream, a new connection has to be attempted. The second attempt 
uses the default speed. Please bear in mind that trying to establish a connection twice takes up more 
time. Should this option be active, the individual user can deactivate it for their task in the transmission 
options.

 ► ECM (Error Correction Mode)

This option activates the error correction mode when sending faxes or files. Should the recipient sup-
port this function, faulty data packages will be identified and resent. This allows files to be transmitted 
faultlessly even through poor lines. We recommended leaving this option at its default. Should the need 
arise, the individual user can deactivate it later for each task.

 ► Enhanced Resolution (200 x 200 dpi)

By deactivating this option, all faxes will be sent using the standard resolution of 200 dpi horizontally, 
100 dpi vertically. This saves considerable time and financial resources compared to the enhanced 
resolution (200x200 dpi). The individual user may set a custom resolution for each task.

 ► Coverpage Mode

A cover page can be incorporated into a fax message that is sent with Microsoft Exchange. This box lets 
you customize the cover page.

 ► Never Suppress Cover Page 

If a cover page exists, it will always be sent. 

 ► Suppress on Empty Body Text 

Should the message contain no text but attachments only, this option will suppress the cover page. 
Any data entered into the Subject input field will be ignored. You may use this option if the attached files 
contain this information, e.g. a cover page created with a word processor.

 ► Suppress on Empty Body Text and Subject line

This option suppresses the cover page only if there is no text in both the message itself as well as in the 
Subject input field. You should select this option if you want a cover page to be created for each mes-
sage that contains a value in the Subject input field, since the subject is usually part of the cover page.

 ► Priority Controlled Send Time

Use this option to set the transmission periods of fax and SMS documents according the E-Mail priority. The 
check box urgent assigns a higher prioritization to the queued messages within the Messaging Server. Use 
this option for high priority E-Mails only as it interferes with the placing of documents within the server queue.
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User Defaults (Fax)

The settings apply to every user of the organization, unless they had been administrated individually.

Image 4.59: User defaults for fax

 ► CSID

You can set the global fax identifier for all users of 
the organization. It will appear in the header of each 
outgoing fax. Please use the international norm: 
(+) (country area code) (no leading 0) (calling 
number) (forwarding number).

Example:  +49 3328 455 960

Thanks to the individual setting of the identifier, the 
fax number of the sender, including the in-dialing 
number, is being transmitted correctly. Answering 
faxes can therefore go directly back. If you leave 
this field empty, data entered during installation 
of the messaging server will be used.

 ► Headline

You can globally set a headline for the users of the organization. This may be your company name and the 
department.

 ► Coverpage Template

Here, you can activate a cover page. Enter the name of the RTF file in the corresponding field. Cover pages 
are saved to the sub folder “COVER” that is created automatically upon setup. The default is set to Inactive. 
Should you activate cover pages, all faxes sent through connectors of this organization receive a cover page 
unless the respective user was given authorization to turn off or replace the preset cover pages.

◊Note! If you created the cover page using Microsoft® Word, we strongly recommend to use 
it again for central conversion of the message. Microsoft® Word creates RTF files that 
aren’t interpreted by the internal RTF converter of Microsoft® Exchange or Quick View 
Plus, particularly if you used more complex formats like tables or frames.

 ► Signature

You can choose the name of a signature file here. It is turned off by default. All signature files from the 
sub-folder SIGN are shown. You may also enter an alternative name; In this case save a cover page file to 
the sub-folder SIGN before using the system.

◊Note! It is the responsibility of the administrator to assign the correct signature files to each 
user. The signature file has to be an RTF file so it can be correctly integrated into the 
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Microsoft® Exchange message. You can create such a file by scanning a signature and 
saving it as an image file such as a PCX and import this image into an RTF file as an object 
afterwards. The internal converter cannot convert objects into RTF files which is why 
you need to employ Microsoft® Word or some alternative as the converter.

 ► Billing Code

The billing code refers to an entry in the log file, created by the messaging server. This is only useful if users 
do not possess a billing code entry, thus the value that is set here is supposed to be applied. A billing code 
is a code with a maximum of 12 digits that identifies the user in the log file.

 ► Letterhead Attachment

The default setting for this field is ‘standard’, meaning that the letterhead set for the fax connector for 
attachments is used for the user.However, they can individually set a different set of letterhead if needed. 
You can choose any one of the letterhead files saved in the sub folder LETTER or type a new filename, if 
you make sure that an appropriate file is saved to LETTER before starting the system. How the letterheads 
should be used for documents with more than one page can be adjusted with the check boxes:

• Repeat letterhead (last page)

• Use only first page of letterhead

There are four possible ways to combine these options:

 ► 1. Both Settings off (default)

Every page of the letter paper is associated to the appropriate cover page and message. Should the 
cover page or message have more pages than the letter paper, the other pages receive no letter paper.

 ► 2. Repeat Letterhead (Last Page)

Here again, every page of the letter paper is associated to the appropriate cover page and message. As 
opposed to the previous scenario, remaining pages of the cover page or message receive the last page 
of the letter paper. 

 ► 3. Use Only First Page of Letterhead

Only the first page of the letter paper associated to the appropriate cover page and message. Remaining 
pages of the letter paper are discarded just as well as remaining cover pages or message pages.

 ► 4. Repeat Letterhead (Last page), use Only First Page of Letterhead

Only the first page of the letterhead is used. This page is repeated on all pages of cover page and message. 

 ► Fax- Feedback

Every user sending a fax is eligible to receive a transmission report. This report (called feedback hereafter) 
can be configured depending on the Exchange server. Feedbacks indicate whether the fax transmission 
was successful or not. If a Non-Delivery Report (NDR) is requested, the sender will receive a report that 
includes information about why the fax could not be delivered and allows the user to change the fax number 
and repeat the process. As a NDR is fairly versatile, you may choose your preferred output.
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 ► Positive and Negative Feedbacks as Mail Without Attachment

Positive and negative feedbacks are conveyed via mail to the inbox of the sender, excluding the con-
verted fax.

 ► Positive as Mail, Negative as NDR

Positive feedbacks are conveyed to the sender’s inbox via mail, whereas negative feedbacks generate 
a NDR. NDR’s occupy an option that allows the user to resend the message.

 ► Only Negative as Mail

Only negative feedbacks are conveyed to the sender’s inbox.

 ► Only Negative as NDR

Choosing this option triggers one NDR per transmission error.

 ► Positive and Negative as Mail with Attachment

Here, positive as well as negative feedbacks are conveyed via mail to the inbox of the sender, along with 
the converted fax as attachment.

 ► Positive as Mail with Attachment, Negative as NDR

Positive feedbacks will be sent as mail with the converted fax included, while negative feedbacks are 
sent as NDR to the mailbox of the respective sender.

 ► Only Negative, as Mail with Attachment (Recommended)

Usually the sender receives a message from the fax Connector, informing them of success or failure. 
Especially for serial faxes it doesn’t seem sensible to send messages for each and every successful fax. 
When you choose this option, you will only be informed of unsuccessful attempts at sending a message.

 ► Multistatus feedback of bulk faxes

An additional option is to choose to receive a summary of the feedbacks for bulk faxes (outgoing faxes with 
the same content but different addresses). Instead of receiving one mail for each successful or unsuccessful 
fax transmission, you rather receive one message that confirms the successful delivery of ALL faxes or 
you receive a message indicating which fax transmission job was faulty. Please note that this option is not 
possible for bulk E-Mails, as each job needs to be processed manually.

 ► File format

The standard format for incoming fax documents is TIFF/G4. But you may choose any other format from 
the list. Select the format for attachments with the image viewer in mind that is used to open faxes.

 ► PDF with included OCR- Information

Additionally, if the text recognition is turned on, you may choose to have a searchable document created 
that is then attached to the incoming document.
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 ►  Electron. Fax- Signature

Use this input filed to include a qualified electronic signature with outgoing fax documents. This option re-
quires the respective OfficeMaster Exchange Connectors to possess a corresponding signature component 
(SIGN). Because signatures are usually used by individuals rather than by groups, you should activate this 
option in the user settings and not here.

User Defaults (Voice)

Use this tab to set user defaults for the voice connectors. They will be applied to every user who is not admin-
istered individually.

Image 4.60: Tab for setting up Voice User Defaults

 ► Record Mode

The record mode differentiates between conveying 
pure audio messages including file attachment 
(Voice message only) and conveying an additional 
call notification without attachment (All calls) if the 
caller didn’t leave a message.

 ► Audio Directory

The audio directory is the audio tree of the messag-
ing server. Each messaging server with an installed 
voice-tree includes audio directories, which in turn 
include language-related voice prompts. As of now, 
you can choose between English and German.

 ► Voice Project

Please choose the voice project that you intend to use. The voice project determines the behaviour of the 
voice server for inbound messages.

 ► Voice Picture

The voice picture is a default image, which is shown if the user has no allocated picture or the caller could 
not be identified. It is an image file (PNG or JPG) saved to the global directory PICTURE. The image should 
not exceed 160 x 180 pixel (width x height).

 ► Message Waiting

Depending on its configuration, a Message Waiting Indicator (MWI) can be turned on or off on the telephone 
of the respective user. Turning the MWI light on is determined by the messaging server configuration and 
the appropriate use of the “Message Waiting” functionality of the PBX. Four modes can be selected:

• No Message Waiting Indication

• Indication off by remote inquiry

- 265 -

Connector for Office 365 ®



• Indication off by inquiry of one message at least

• Indication off by inquiry of all messages

 ► Voice File Appearance

Use this input field to choose whether the voice files (WAV or MP3) are shown within the message or not. 
Suppressing them will let you to listen to them by remote request only and not through your computer’s 
speakers.

 ► Caller Number Reading

Use this input field to determine whether the telephone number of the caller is read out during listening to 
the respective audio message. It may be read out prior or after the message.

 ► Availability Check

If needed, the voice connector employs a functionality that evaluates the private schedule of the user and 
determines whether he is available or not.

 ► Initial PIN

Every user who has not been administrated individually uses this PIN entry. This PIN is also used to adjust 
the functional sequence in accordance to the actual behavior. In conjunction with other connectors, the 
voice server is given the option of utilizing an initial PIN as well. To generate a dynamic PIN, utilize the voice 
server. Should the voice server configuration apply to the Exchange Server as well, leave the input field 
blank. (Hence, delete the default value ‘0000’).

 ► Encrpyt PIN of user objects

To amplify the safety, the Messaging Server is giving you the possibility to encrypt the PIN by a PBKDF2- 
Hash standard

 ► Query Permission 1-3

If the voice box receives calls from the telephone numbers entered into this box, it immediately enters the 
configuration mode. We recommend leaving these input fields blank, as they cannot be integrated into a 
useful global operation.

User Permissions

Each user of the OfficeMaster Exchange Connectors can receive a multitude of permissions from the admin-
istrator.

The permissions shown are set for all users by default, unless users possess an individual administration. 
The tab User Permissions (see image below) incorporates all permissions a user can obtain. Activate them by 
ticking the respective box.
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Image 4.61: User Permissions

 ► Change send time

This permission enables the user to set a date and 
time for messages to be broadcast. These entries 
have priority to the urgency settings low, normal 
and high.  If a time is given without a specific date, 
the current date is taken. Has the time already 
passed, the next day will be taken.

 ► Change resolution

The resolution can be set to high or standard. We 
recommend having these settings set to standard 
resolution. This will essentially keep the costs as 
well as the transmission time at a minimum. For 
special cases, the resolution can be changed for 
the individual task.

 ► Turn off cover page

Within the global administration, a cover page for all users or a cover page for an individual user can be 
set. This option enables the user to suppress the selected cover page. This is useful whenever an outgoing 
document already contains a cover page. Please note that the use of cover pages add additional transmis-
sion time and costs.

 ► Turn off letterhead for cover page

A default letterhead for cover pages can be set within the global administration. With this option, the user 
can suppress the use of letterheads/ letter paper for cover pages.

 ► Turn off letterhead for attachment

The same can be done for attachments. It also lets users suppress the use of letterheads for attachments.

 ► Binary file transfer

The actual message as well as possible attachments are conveyed to the counterpart station via file transfer 
through the fax connection. We recommend choosing this option only if the counterpart station inherits the 
respective option for the fax protocol using the ITU guideline T.434. This will give the recipient the possibility 
to further process the files or execute the programs within the files. Please note that the binary file transfer 
might not be supported by the utilized fax hardware.

 ► Fax polling

The user has the ability to use fax polling as offered by OfficeMaster. The number entered as fax address 
is being called and the fax protocol signals that a document is to be send. The user receives the document 
just like a normal fax. 
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 ► Turn off ECM

Here, the user is given the possibility to suppress the default setting Sending with error correction. 
OfficeMaster Gate supports transmission with ECM (Error Correction Mode) and we highly recommend 
utilizing it.

Should the addressee use devices that do not support ECM, the ECM suppression is applied automatically. 
ECM repeats the transmission of all faulty data blocks and thus regulates the errorless conveyance of faxes. 
If the line quality is poor, it may cause a minor transmission delay. Suppressing ECM is only recommended 
if the line is very poor and essentially causes the transmission time to soar up immensely. Furthermore, 
errors need to be tolerated.

 ► Force feedback with fax document

When sending faxes users may opt to receive feedbacks stating whether the fax has been transmitted 
successfully. In addition to the status information, they also receive the actual fax as image file attachment. 
Utilizing this option is of particular significance for users who triggered multiple jobs but cannot allocate 
the transmission feedbacks to the respective faxes.

 ► Specify cover page and letterhead per document

The user will be authorized to choose their own cover pages and letterheads. They can set a name of a cover 
page file or letterhead, as long as the corresponding file exists in the installation clearance <Messaging 
Server>\FFACCESS\Cover.

 ► Turn off signature template

The global administration can set a signature for each user, saved in the directory <Messaging Server>\
FFACCESS\Sign. This option lets the user suppress the use of the signature for their messages.

 ► Prohibit print of outgoing fax

The administrator can select a default printer, which automatically prints all outbound faxes. Turning on 
this option suppresses this functionality.

◊Note! The internal mechanisms for Microsoft Exchange prevents the display of any rights that 
had been enabled for the user. Thus, they see all settings and essentially rely on the 
administrator to tell them which settings they may take influence on. This functionality 
is applied regardless on the configuration of any printing interfaces (printgw).

◊Note! Although the following settings affect the user permissions, they do not appear in the 
OfficeMaster transmission settings for Outlook.

 ► Send with high priority

An important feature of transmitting faxes is to set the priority for a message. As a message with high 
priority is sent immediately, significant transmission costs may arise for long faxes. To avoid this, we rec-
ommend assigning only priority levels that are low in costs. Enabling this option will allow the user to make 
use of the highest priority level.
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 ► Send with normal priority

Normal priority faxes are not necessarily send at the most opportune time, so the administrator can force 
users to always use low priority. Checking this box allows the user to send messages with normal priority.

 ► Send fax documents

Here you give permission to Microsoft Exchange users to send faxes.

 ► Receive fax documents

Use this checkbox to block the reception of faxes for the respective user. If activated, inbound faxes are 
forwarded to the inbox of the default user who then decides whether he himself forwards the fax document 
to the blocked user.

 ► Suppress electronic signature

The user is allowed to suppress the electronic signature through the send options.

 ► Send SMS

If an SMS connector is installed, this option allows the sending of SMSs. Users who send messages without 
permission receive an error message.

 ► Receive SMS

The SMS connector can also receive messages. This feature can be toggled on or off with this checkbox. 
All inbound messages addressed to the blocked user are forwarded to the default recipient, who will then 
decide whether to forward the SMS message to the intended user or not.

 ► Sending split SMS

If the user has been authorized to transmit SMSs, any text message that exceeds the maximal character 
count of 160 will be split up and transmitted individually. As this option might be quite costly, it is turned 
off by default.

 ► Activate CTI

CTI (Computer Telephony Integration) is an outdated feature and therefore not supported since OfficeMaster 
Server version 5 and higher.

 ► Voice administration

CTI includes a call monitor, making it possible to see the telephone status of other participants. The autho-
rization to see this can be configured here.

 ► Maximum Of Partially Split SMS

When sending long SMSs the maximum number of SMS the message is allowed to be split into can be set 
here. Messages that are longer still, will be cut off after the maximum split. The largest value possible is 99.
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4.5.7. Connector Configuration

The Connector configuration is in the node ‘Connectorkonfiguration’. A list of servers appears that you can 
choose from. If a server has a connector installed, it will be shown in the connector list.

Image 4.62: Connector configuration
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General Settings

Every Connector has its own specific settings. These are administrated in the preferences section of the 
appropriate object.

Image 4.63: General settings

 ► Default recipient

As default recipient you set a recipient or a global 
folder that will receive all documents (fax or SMS 
messages) that cannot be distributed automatical-
ly. Automatic distribution of fax messages requires 
ISDN hardware that allows every Exchange user to 
have an individual call-in number. On analog hard-
ware, that don’t support call-in numbers, all faxes 
are send to the default recepient. It is the respon-
sibility of the default recipient to forward incoming 
faxes as messages to the correct recipient. 

Mailing lists cannot be used as default recipients.

◊Note! It is required to set a default recipient. Should this entry be missing, it may be possible 
that undelivered documents are not send to anyone’s email and remain stranded in the 
queue of the OfficeMaster server.

 ► Copy incoming to / copy outgoing to

This section can be used to forward a copy of all inbound and outbound documents to a preset public folder 
or inbox. Resorting to this option will allow the archiving of all fax communication straight to these folders. 
Furthermore, archived messages can be browsed through using various processes and copies can be 
resent. The folder Microsoft Exchange System Objects folder contains these public folders.

 ► Print incoming / Print outgoing (UNC path for fax documents only) 

These fields let you choose a printer from the network that is to print all incoming documents for the user. 
Should the favored printer be hidden, you can enter it manually using the UNC standard (Universal Naming 
Convention). This setting is inactive by default. 

For the connector to be able to actually print incoming and outgoing faxes with the selected printer, the 
computer running the connector component has to have the appropriate driver installed.

◊Note! The Messaging Server configuration also lets you set a print gateway that offers similar 
features. The two differ in the fact, that the configuration of print gateways cannot be 
user-specific. To test printing, you can use the tool MsxPrinterTest.exe. You may find it 
on the OfficeMaster server in the directory <SERVER>\FFACCESS\Redist\Tools.
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 ► Additional send options

 ► Country dial prefix

Most ISDN ports fail to establish a connection if the country code is used as prefix. To avoid this issue, 
enter the country code prefix here. The Exchange connector will then convert this code into a zero (0). As 
the Messaging Server allows the setup of central system with OfficeMaster Gates distributed throughout 
multiple countries, the connector could also be used for processing documents in foreign countries. Having 
such an environment requires an adjustment of the Messaging Server, thus, this input field must bear the 
value <empty>. 

 ► Address prefix

This setting puts a prefix in front of incoming call numbers. This used to be done to avoid duplicate tele-
phone numbers. This functionality has since been taken up by ISDN hardware and this field can only be 
configured for compatibility reasons.

 ► Per-unit fees

Some systems still relay calling costs as per-unit fees with the call. This is not common anymore and is 
almost never supported. 

 ► Currency

Corresponding to per-unit fees an arbitrary alphanumeric value is set that represents the currency of the 
fees. This is not common anymore and is almost never supported. 

 ► Embedded images

Image files included in email text is usually deleted from cover pages. The function “Support embedded 
pictures” allows images from the text to remain in the text and be integrated in the cover page to be send 
unchanged as a fax. This way, signatures added as images can be supported.
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Server Connection

To configure the SMTP client of the OfficeMaster Exchange connector, use the Server Connection tab. To 
configure the SMTP client of the OfficeMaster Exchange connector, use the Server Connection tab. Here, 
properties of the Messaging Server for transmitting SMTP mails to the Exchange server can be set.

Image 4.64: Server Connection

 ► Exchange Server

The Exchange server shown here receives E-Mails 
from the component. This input field is not edit-
able.

 ► Alternative Mail Server

Here you can enter the IP address of an alter-
native Exchange server that receives the docu-
ments. Usually, all E-Mails are sent to the one set 
in Exchange Server. This can be overthrown here.

 ► SMTP send port

In this input field, nominate the SMTP port that is used for receiving E-Mails via the Exchange server de-
posited above. This functionality essentially defines the transmission direction between Messaging Server 
and Exchange server.

 ► Target server type

The target server type controls the creation of emails that may differ from Exchange servers individually.

 ► Authentication

The authentication determines the level of security for mail traveling from messaging server to Exchange 
server. You cannot set this arbitrarily. A service account entered here has to appear at least once during 
installation while verifying data, because a special adjustment is made. There are three different options:

 ► No Authentication (default)

Choosing this option, no SMTP authentication is carried out. This requires that the Exchange Server 
allows anonymous access to the SMTP service. This is the default setting for the connection to Office 365.

 ► NTLM Authentication

This kind of authentication (NTLM, WindowsNT Challenge/Response, WindowsNT Lan Manager Authen-
tication, internal Windows authentication) uses a WindowsNT domain account to login and send SMTP 
email. Because this account has to meet certain criteria, it is not used with an Office 365 installation.
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 ► Plain Authentication

This kind of authentication (plain text password SMTP) uses a special login account for the related 
server. Because this account has to meet certain criteria, it is not used with an Office 365 installation.

 ► Service Account, Password

This section is used to deposit a service account and password. Once a service account is deposited, please 
do not change it here but rather take the installation wizard of the Messaging Server for these kinds of edits.

 ► Connection Security

This parameter determines how the communication to the server is encrypted. It essentially increases 
the communication security. This option is turned off for Office 365 installation, but may be turned on for 
encrypted connections.

There are different levels of security:

 ► Enable Transport Layer Security (TLS)

This activates the general encryption via TLS. The encryption protocols are mediated between systems 
automatically and no certificate is used for authentication.

◊Note! From October 2018, Microsoft Office 365 Cloud will switch to using TLS Version 1.2 for 
their access connectors. The Exchange BCS connector that handles the UM services 
within the Messaging Server of the Office 365 Cloud generally routes feedbacks and 
inbound messages (e.g. Voicemails, Fax and SMS messages) through the Internet via 
SMTP. By default, no transmission encryption is used, which is why the TLS encryption 
should be enabled for the BCS connector. Despite previous claims, the connector used 
by the OfficeMaster Suite version 6.2.2 does NOT support TLS encryption. Support for 
TLS version 2.1, including downward compatibility, only came about with the introduction 
of the OfficeMaster Suite version 6.2.3. Previously, the Connector offered support for 
TLS version 1.0 only.

 ► Establish only secure connections

This option prevents communications with server that do not use TLS. Connections will be terminated 
immediately, should the recipient request a TLS-free communication.

 ► Verify server certificate

If this checkbox is activated, the certificate provided by the server and the certificate stored within the 
local Windows certificate storage are compared. The connection will be dropped immediately should 
both certificates not match up.

 ► Use Global OfficeMaster Certificate Folder

As outlined above, the system checks whether the certificates provided by the server match up to any 
certificates stored to the Windows certificate storage. In addition to this general validation, the global 
OfficeMaster certificate directory (\\Server\FFACCESS\CERT) may also be browsed through to check 
for explicit certificates. Activate this box to enable this functionality.
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User Data

The tab User Data incorporates options that help increase the processing speed of inbound and outbound 
documents for fax and SMS, as well as increase the user resolution for voice calls.

Image 4.65: Tab User Data

 ► Metacache File

The metacache database is a proprietary database 
that can be created while the connector compo-
nent is running. Unlike the global catalog, this da-
tabase contains all relevant address data of the 
domain. It is created by choosing a file with the 
file extension .mcss. The files, which are ready for 
access almost immediately, are used for the reso-
lution of users if cover pages are being generated. 
Thus, the database is speed-optimized and can be 
run without additional database systems. More-
over, it can be extended with interfaces that allow 
the connection of databases to CRM systems via 
third party plugins.

 ► Replicate MS Active Directory Data to Metacache

Activating this option copies the Active Directory Forest of the user data to the database. This may take 
some time.

 ► Replicate Public Folders Items to the Metacache

Additional global contact folders can be copied to the meta cache with this option. This requires the exis-
tence of global folders and may take some time to process.

 ► Replicate only the following Public Folder with subfolders

To optimize access time when accessing the global folder database, you can enter or create a global contact 
folder here that limits the search.

 ► Internal Phone Numbers

As the metacache saves all calling number data, internal calling numbers that contain ambiguous data may 
cause doublets. To avoid doublets, use this input field and specify how internal calling numbers are treated 
according to their length and whether they ought to be assigned to certain domains.

 ► Replication Schedule

The replication schedule determines the point of time, at which data are being copied. To trigger replication 
immediately, select Replicate Now.

- 275 -

Connector for Office 365 ®



Address Space

In this tab, address spaces or address types can be selected that utilize all functionalities provided by the 
connector (for outbound communication).

Image 4.66: Defining address space

The domain entered here is not used to automatically 
create objects in the target system but to register this 
domain with the OfficeMaster server. This setting is 
only necessary for the Internet connection mode.

For the service transfer mode, this setting is irrelevant.
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Address Resolution

The tab Address Resolution incorporates settings that help optimize the connector’s performance. Upon 
every inbound/outbound processing of a document, the appropriate sender/recipient is being resolved in 
the Active Directory to gather and transmit information about permissions. All Active Directory domains are 
being browsed through on a worldwide organization. As this generally takes some time to process, you may 
set a domain selection and domain order explicitly or add a domain position of trust.

Image 4.67: Address resolution

 ► Add trusted domain

For comprehensive domain networks, you can add 
a trusted domain. In this case, the service account 
of the component is additionally used to contact 
this domain.

 ► Resolve users by using the Global Catalog

This option potentially increases the processing 
speed in networks that incorporate multiple do-
mains. Whenever possible, the global catalog is 
requested.

◊Note! Administrating user resolution is only useful for hybrid and on-premise installations. 
For a pure Office 365 installation you do not need a domain inquiry. In this case these 
settings are irrelevant.
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4.5.8. User Configuration

For the professional user administration the OfficeMaster Exchange offers a corresponding node. Local Ac-
tive Directory connections offer an additional structural view, that correlates with the Active Directory user 
console and the computer console. This is not shown in pure Office 365 connections. The tab Recipient shows 
a list of available users. It is possible to administrate a number of settings (phone numbers, alias, etc.) that 
correspond to a standard user administration, however this console is not meant primarily for this purpose.

Image 4.68: User administration

Fax, SMS and VOX Addresses

The OfficeMaster Exchange administration lets you administrate many different kinds of recipient addresses, 
just like through the web based Exchange Server administration (ECP – Exchange Control Panel).

Image 4.69: User email addresses

The address field is filled with a call-in fax or SMS number 
of the user. This number should be unambiguous. 

◊Note! It is not recommended to create FAX, 
VOX or SMS addresses through recip-
ient policies! Addresses needed here 
cannot be created using recipient pol-
icies.
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Tab “OfficeMaster”

User specific parameters can be set in the tab OfficeMaster.

Image 4.70: Address resolution

 ► Defaults

You can choose a user default profile here. If the user is 
not administrated individually, after installation all glob-
al user defaults are entered automatically. If you enter a 
user group as default that is not administrated, the global 
OfficeMaster settings apply.

In a pure Office 365 installation, user groups cannot be 
set as defaults, because data is being saved directly to the 
mailbox and user groups do not own a discrete mail box.

 ► Fax

 ► CSID

Use the CSID input field to set a fax identifier that appears in the headline of an outbound fax. Please 
use the international norm: 

<+> <Country area code (no leading 0)> < calling number> < extension number>

Example 4.1. +49 3328 455 960 

»End  of  examp »

Setting an identifier ensures that both, the fax number of the sender and the call extension number are 
transmitted correctly. Hence, return faxes can be directly addressed to the sender. If this input field is left 
blank, data that have been globally set for the connector will be utilized. However, if no entry had been 
made there as well, data set for setting up the ISDN hardware will be used. It is generally recommend 
setting an individual identifier for each user. Only by doing this, valid addresses for return faxes can be 
transmitted even if users send data from various locations.

 ► Headline 

Enter an individual header text for each user (or user group) into this input field. This could be their 
company name and the department the user is working in.
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 ► Cover Page 

Here you can choose a user-specific cover page file. The file names of all cover pages are listed here, 
which are saved to the sub-folder COVER. The folder itself is created automatically on the computer 
that was used to carry out the setup of the fax connector. By default, this option is inactive. 

Additionally, you may enter a new file name. However, ensure the file is located in the sub-folder COVER 
before running the system and the file extension .rtf has been stated.

 ► Signature 

If your fax document is required to show a signature, choose the appropriate signature file here. All 
.rtf files that have been saved to the subfolder SIGN will be shown in this dropdown list. Again, this 
option is deactivated by default.

Similar to the Cover Page dropdown list, you may also enter a new file name. Before running the system, 
ensure the appropriate .rtf file has been saved to the sub-folder SIGN. 

 ► Billing Code

For the billing code, choose any alphanumerical identifier with up to 12 digits. This identifier will appear 
in the log file of the Messaging Server for all outbound jobs. Having a billing code allows the assignment 
of jobs and the corresponding costs to an individual user.

 ► PBX ID 

Some organizations use their PBX to keep record of accumulating costs for telecommunication pro-
cesses. On a trunk that is used by multiple users (e.g. fax line), each user has to type in a set of numbers 
(code) before providing the actual calling number. Thus, each cost can be traced back to an individual 
user. As the PBX interprets the code, the Messaging Server cannot establish a connection itself because 
the code would appear in front of the PBX ID. One possibility to counteract this issue is to integrate the 
dial prefix into the PBX ID.

 ► SMS 

 ► Number

This number specifies the main send and receive address for SMS messages. It only applies to SMS 
Large Accounts. In all other instances, users are identified by their SMS address.

 ► Voice

 ► Record Mode

When choosing which messages to record, there are two options:

• All calls

If you choose All calls, the recipient will additionally receive a message on the Exchange Client should 
no recording be made on the voice inbox. Hence, the recipient is notified that an inbound call has 
been received along with the details of the caller.
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• Only voice messages

Similar to All calls, with the exception that the recipient only gets a call notification, if the caller has 
left a voice message.

 ► Script

This is the initial script that manages the behavior of the mailbox. The default project is eVoice_ProjectStart.

 ► PIN

Enter a PIN for the voice box here. It will be requested when switching to the configuration mode or if you 
attempt to listen to voice recordings.

Details - General

Select Details to access further configuration settings for the respective user.

Image 4.71: General OfficeMaster settings

 ► Language

Set the language for text outputs and prompts here. As of 
December 2017, four languages are being offered (German, 
English, French and Spanish). The default setting is based 
on the language that has been set for the global connector 
settings.

 ► Message Format

In order to display the documents more flexibly, four display 
modes can be set here. You can choose between:

• Plain Text

• HTML Layout: Neutral

• HTML Layout: OfficeMaster

• HTML Layout: Outlook

 ► HTML Template

Apart from the HTML templates provided, you can load external templates for more specific design choices. 
Commonly, a special version of HTML/XML is used to generate them. In order for them to appear in this 
dropdown list, deposit them to the global COVER subfolder, which also contains the .rtf Cover Page files. 
As these template files (*.HTL) save entire language sets to HTML templates, they can essentially alter the 
appearance of an inbound document to match the corporate design. Find the HTL editor and a manual for 
the HTL script language in the directory <SERVER>\FFACCESS\Redist\Tools.

 ► Subject Mode

To meet individual demands for the subject line of a fax document or a short message, the subject mode 
can be changed here. These modes do not affect voice messages. Choose between four modes:
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 ► Transfer status

This is the classic form of a subject feedback.

Example 4.2. Sending fax to <Fax number> 1 page ok

»End  of  examp »

 ► Original Subject

The output is similar to the one given for Transmission Subject. However, the subject line is also added 
to the feedback. Business programs are capable of processing such feedbacks, which brings in a great 
advantage. Furthermore, stating the subject line provides an additional way to keep fax documents 
apart from each other.

 ► User Defined

Here, the subject line of the feedback can be arranged manually. See Table 4.1 for a list of placeholders 
than can be used according to the language setting.

Table 4.1: Placeholders for Feedbacks

Character Feedback

%S original subject line

%T Transmission type (Fax or SMS)

%F to/from (depending on transmission type and language set)

%E Status (“OK” or “Error”)

%P Number of pages (e.g. “1 page”, “2 pages”)

%A Recipient (if it can be resolved in plaintext, or else recipient number or fax 
CSID if it cannot)

%N Called number that has been transmitted via ISDN

%R Exchange recipient number (fax address of the recipient)

%M Short message (the word “short message” will be displayed in the respec-
tive language)

%% percentage sign

Example 4.3. %S - %T %F %A %E

Supposedly, a fax with the subject line Offer No. 0000145 is sent to the fax number +49 3328 455 960, the 
feedback line would display as follows: 

Offer No. 0000145 – Fax transmission to +49 3328 455 960 OK

»End  of  examp »
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FAX

This tab contains options that are specific to the fax service.

Image 4.72: Options for the fax service

 ► Copy Incoming to / Copy Outgoing to

Use this option to specify preconfigured folders or inboxes 
that are used for storing copies of all inbound and out-
bound documents (fax and SMS). Keeping copies of these 
documents have many benefits: It allows for a gapless ar-
chiving of fax/SMS communication, browsing for certain 
processes and resending faxes. Find public folders in the 
dropdown list of the folder Microsoft Exchange System 
Objects. Groups cannot be selected.

 ► Print Incoming to (UNC)

Here you can select a network printer that prints all in-
bound and outbound documents for the respective user. 
Instead of searching for a printer, you may enter the printer 
name in a  UNC (Universal Naming Convention) format. This 
option is inactive (<empy>) by default.

 ► Print Outgoing to

Select a network printer that shall be used to print all outbound fax messages of the respective user. Instead 
of searching for a printer, you may enter the printer name in a  UNC (Universal Naming Convention) format. 
This option is inactive (<empy>) by default. 

◊Note! For the connector to be able to print incoming and outgoing faxes with the selected 
printer, the computer running the connector component has to have the appropriate 
driver installed

◊Note! Print gateways added to the Messaging Server Configuration may already employ these 
functionalities. However, these settings will not be user specific. To test the printing func-
tionality, use the tool MsxPrinterTest.exe. It is located on the server that also contains the 
OfficeMaster software, more specifically in the <SERVER>\FFACCESS\Redist\Tools.

 ► Attachment Letterhead

The default for this field is standard, meaning that the letterhead set for the fax connector for attachments 
is used for the user. But they may set a different letterhead if needed. You can choose any one of the let-
terhead files saved in the sub folder LETTER or type a new filename, if you make sure that an appropriate 
file is saved to LETTER before starting the system.
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The following checkboxes control in what manner documents with multiple pages utilize the letter paper file. 

• Repeat the last page (of letterhead)

• Use only the first page from the letterhead

There are four possible ways to combine these options:

 ► 1. Both Settings off (default)

Every page of the letterhead is put behind the appropriate page of cover page and message. Should the 
cover page or message have more pages then the letterhead, the other pages receive no letterhead.

 ► 2. Repeat Letterhead (Last Page)

Every page of the letterhead is put behind the appropriate page of cover page and message. Should the 
cover page or message have more pages then the letterhead, the other pages are send using the last 
page of the letterhead. 

 ► 3. Use Only First Page of Letterhead

Only the first page of the letterhead is used; it is put behind the first page of cover page or message. All 
following pages of letterhead are not used and the remaining pages of cover page and message receive 
no letterhead.

 ► 4. Repeat Letterhead (Last Page), use Only First Page of Letterhead

Only the first page of the letterhead is used. This page is repeated on all pages of cover page and message. 

 ► Message Letterhead

The options and their functions are equivalent to Attachment Letterhead.

 ► Feedback 

Here you can define, for each user individually, how feedback is send to the mailbox. You can choose from 
the following options:

• Positive and negative as mail

• Positive as mail, negative as NDR (Non Delivery Report)

• Only negative cases as mail

• Only negative cases as NDR

• Positive and negative as mail with attachment

• Positive as mail with attachment, negative as NDR

• Only negative cases as mail with attachment (recommended)
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 ► Collected Feedback for Serial Documents

You may choose to combine feedback for bulk faxes (outgoing faxes with the same content and different 
addressees) into one single report for successful and unsuccessful transfers. For documents with a single 
recipient the settings under Feedback apply.

 ► File Format

Incoming faxes can be delivered in different file formats. The TIFF format (usually TIFF/G3) or the PDF 
format is the most useful option.

 ► PDF- Format with OCR- Information

In addition to the file formats, you can choose to create a searchable PDF file, if a OCR software is installed.

 ► Electronic fax Signature 

Here you can set that the use of an electronic signature for the user’s fax documents is applied. Is the signa-
ture turned on, it can be turned off through the OfficeMaster send settings for Outlook (assuming sufficient 
authorization). Note that the Messaging server has to support electronic fax signatures.

Voice

Use this tab to configure the personalized voicemail feature.

Image 4.73: User details Voice

 ► Audio Directory

The audio directory, which is essentially the voice tree of 
the Messaging Server, defines the language that the voice-
mail feature utilizes to play back commands and requests 
(output language). Every Messaging Server contains an 
audio directory where all voice feedbacks are stored. You 
may choose between English (EN) and German (DE).

 ► User Image

The user image is a standard image shown if the user 
has no picture or the caller couldn’t be identified. This is 
an image file (PNG or JPG) saved in the global directory 
PICTURE. The image should not exceed 160 x 180 pixel 
(width x height).

 ► Message Waiting

In this section, you may configure how the Message Waiting Indicator (MWI) resets. The MWI is a visual 
feature that notifies users on any new voice messages. It is triggered autonomously and its behavior pri-
marily depends on the Messaging Server configuration and the respective MWI configuration on the PBX.

Choose between three reset modes:

• Reset by general remote request
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• Reset by listening to one message at least

• Reset by listening to all messages

 ► Message Behavior

Specify whether you prefer receiving voicemails in the classic E-Mail format used by the OfficeMaster Suite 
or the Exchange UM voicemail format.

 ► IP Phone

In many cases, the number of the voice box is not identical to the telephone that has been assigned to the 
voice box. To reset the Message Waiting Indicator (MWI) nonetheless, specify the calling number that shall 
have the MWI deactivated once its voice box had been accessed. This number essentially represents the 
telephone on the respective work desk.

 ► “To my Phone” Number

The integration to Outlook facilitates the forwarding of messages to a dedicated telephone, commonly the 
telephone on the work desk. In cases where the work desk regularly shifts its position or the mail client is 
run from various computers, you may specify an alternative telephone that is in close proximity. Enter its 
number into this input field.

 ► Representative Number

Specify a number that receives the redirected call in case the caller has no intention of speaking to the 
voicemail.

 ► Query Permission 1/2/3

If the voice box receives calls from these telephone numbers, it immediately enters the configuration mode. 
You may provide up to three numbers.

 ► Voice Attachment

Here you can determine whether the voice files (WAV or MP3) are incorporated into the message or not. 
If the files are suppressed, you may no longer play them via the computer speaker. Play them via remote 
request instead.

 ► Caller Number Reading

Use this input field to determine whether the telephone number of the caller is read out during listening to 
the respective audio message. It may be read out before or after.

 ► Callback via Inquiry

Activating this option allows the user to directly call back the user who left a voicemail message.

 ► Availability Check

If needed, the voice connector employs a functionality that evaluates the private schedule of the user and 
thus determines whether he is available or not.
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Tab User Permissions

The tab User Permissions administrates user specific rights. The individual checkboxes have been described 
in chapter 3.3.4. User Permissions on page 160

Image 4.74: User Permissions

 ► User Permissions, Blacklist and Short Message Split Parts 
by Default

Activating this option sets the user rights to the default 
rights. The configuration as set in the profile chosen in 
“default” applies. Activating this function blocks the pos-
sibility of changing any option.

 ► SMS- Maximum Split Parts

When sending long SMS, the maximum number of SMS the 
message is allowed to be split into can be set here. Messag-
es that are longer still, will be cut off after the maximum of 
split parts was reached. The largest value possible is 99.

4.5.9. OfficeMaster Folder Administration Wizard

For larger companies it might not be possible to use the same global settings of the connectors for all user 
groups or recipients in certain locations. The global settings might not be in line with the companies guidelines 
for those users.

Image 4.75: Starting Directory Wizard
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The wizard can make the required changes to the user settings without the administrator having to open 
every object. Individual settings can be ignored selectively during the automatic administration to keep the 
original value.

To reach the wizard, view the settings of the directory, the organization or the group. The item “Recipient 
structure view” under recipient settings leads to the wizard. This view also shows the folders and organization 
units to start the folder administration wizard.

This object also has its own OfficeMaster tab. For containers and organization units you can start the admin-
istration wizard. For groups this is the member administration.
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Image 4.76: File wizard

Editor Settings

 ► Edit Only Objects in This Folder

This option limits changes made by the wizard to the users 
contained in one folder. Should the folder contain further 
folders that contain user objects, they will not be admin-
istrated. This function is only available in the OfficeMaster 
file administration window.

 ► Edit all Objects in This Folder and its sub-Folders

This option lets the wizard make changes to the users con-
tained in sub-folders of the main folder. This function is only 
available in the OfficeMaster file administration window.

 ► Include Group Objects

Activating this option applies the settings to mailing lists and security groups. Note that those group 
objects are not treated as senders by the OfficeMaster connectors, but as property defaults.

General Settings

The page General in the wizard mirrors the main settings in the “User” tab OfficeMaster. The individual 
items have been described in the last chapter.

Image 4.77: General settings
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To further optimize the setting of the fax identification, it can be extended in this dialog. In addition to the 
value entered manually, a preselected value of the user can be supplemented. Pressing the tool-button […] 
opens a help dialog.

Image 4.78: Identifier Extension

You can assemble the fax identification with the combination of preset data. The following preferences can 
be added to the fax identification automatically:

• Private number (first number from Active Directory field “call numbers” - Private)

• Pager number (first number from Active Directory field “call numbers” - Pager)

• Cellphone number (first number from Active Directory field “call numbers” - Mobile)

• Fax number (first number from Active Directory field “call numbers” - Fax)

• IP-Telephone (first number from Active Directory field “call numbers” - IP-Telephone)

• FAX Address (default return address of type FAX, if it is numeric)

Because the specified call numbers can’t always be used for the sender identification, you can make changes 
concerning the figures of the call numbers under “Apply extensions in extracts”.

Details Fax & Voice

The wizard pages “Details (FAX)” and “Details 
(Voice)” are the same as the button “Details” under 
the tab “OfficeMaster” of the users. The individual 
items have been described in the last chapter.
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Image 4.79: Details - Fax Image 4.80: Details - Voice

Details - User Permissions

The dialog “User permissions” are the same as the button “User permissions” under the tab “OfficeMaster” 
of the users. The individual items have been explained in the last chapter.

Details (General)

The general user settings (language, message format, etc.) can also be administrated. With the button “Finish”, 
all changeable objects in the focus of the configuration are changed in accordance to the values set.

Image 4.81: Finish

◊Note! At the time this document was created, 
the folder wizard was not available for 
pure Office 365 installations.
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